
R.Ramesh – Computer science Department – Trinity Academy 
 
 

+2  

 

 

IMPORTANT ONE MARK QUESTIONS 

 

 

 

COMPUTER SCIENCE 

 

 

 

 

 

 

 

R.Ramesh B.A(Eng).,M.Com.,B.Ed.,M.Phil.,PGDCA., 

Department of Computer Science 

Trinity Academy Mat.Hr.Sec.School, 

Trinity Nagar, Mohanur Road, 

Namakkal-637 001. 

Cell: 97860-08115 

  

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VOLUME – I 

(TOOLS)

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

AN INTRODUCTION TO STAROFFICE WRITER 

 

Class: XII-Std               

 

I. Choose the Correct Answers :-      

1. ______ is an application that is designed to work on different operating systems. 

 a) MsOffice     b) StarOffice 

 c) Office Suite   d) Linux Office 

2. _______ is a full-featured office productivity suite with powerful stand alone application. 

 a) StarOffice b) Office 

 c) Office Suite d) Office Manager 

3. _______ consists of several applications. 

 a) StarOffice Writer b) StarOffice Calc 

 c) StarOffice d) StarOffice Draw 

4. StarOffice applications are grouped together into a/an ______ environment. 

 a) joint b) combined 

 c) forum d) integrated 

5. ______ writer is a word processor. 

 a) StarOffice b) Windows 

 c) MsOffice d) WordPro 

6. A _____ may contain text, tables, graphs, etc. 

 a) text b) document 

 c) spreadsheet d) presentation 

7. The File New _______ command can be used to open a new document. 

 a) Database b) Untitled1 

 c) Text document d) Document1 

8. The ______ of the document can be typed in big blank area of the screen. 

 a) text b) value 

 c) data d) draft 

9. ______ always indicates where the new text will appear. 

 a) Vertical bar b) Insertion point 

 c) Flashing bar d) Vertical point 

10. StarOffice _______ will automatically wrap the text to the next line. 

 a) Calc b) Impress 

 c) Writer d) Draw 

11. The ____ key need not be pressed at the end of the each line. 

 a) escape b) pause 

 c) F5 d) enter 

12. The _____ key should be pressed only at the end of a paragraph. 

 a) enter b) escape 

 c) pause/break d) scroll 

13. StarOffice _______ automatically creates a new page. 

 a) Calc b) Writer 

 c) Impress d) Database 

14. ______ the file enables the user to find and open that file again. 

 a) Prompting b) Saving 

 c) Naming d) Entering 

15. When the file is saved for the first time StarOffice writer _____ for a name. 

 a) save b) prompts 

 c) says d) suggests 

16. While saving a file for the first time-----dialog box appears. 

 a) Save As b)Save 

 c)Open d)Edit 

17.  To save a file, a double click is made on the required folder and the file name is given in  

  the- - - -list box. 

 a)Search for b)List 

 c)File name d)Type 

18.  While saving a file, we can select the drive by clicking on the - - - icon. 

 a) back b)up one level 

 c) new folder d)save 
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19. While working with StarOffice Writer, it is possible to have- - -documents open at the  

 same time. 

 a) one b)two 

 c)three d)several 

20. We can switch between documents using - - -  menu. 

 a)File b)Edit 

 c)Windows d)Insert 

21.  To work on a particular document, click on the document- - -  visible on the taskbar. 

 a)button  b)icon 

 c)symbol d)graphic 

22. To- - -  the insertion point to anywhere in the document either the mouse or keyboard 

 can be used. 

 a)delete b)move 

 c)remove d)none 

23. The thick horizontal line in the - - - is called end-of-document marker. 

 a)paragraph b)document 

 c)page area d)format 

24. The - - -  cannot go beyond the page area. 

 a)indicating point b)insertion point 

 c)intimating point d)interesecting point 

25. To move the insertion point with the keyboard the - - - combination can be used. 

 a)arrows+other key b)ctrl+other key 

 c)alt+other key d)function+other key 

26. The - - -  pointer is different from Insertion point. 

 a)Insertion b)Mouse 

 c)Indicating d)Key 

27. If the key combination is joined with a plus sign, the first key must be pressed and- - - 

 the second key is to be - - - - 

 a)held down, clicked b)clicked, held down 

 c)pressed, held down d)held down, pressed 

28. Mistakes can be corrected wither usin the - - - key or the - - -  key. 

 a)Backspace, delete b)Up, down 

 c)Left,right d)Ctrl,function 

29. - - -  key deletes the characters to the left of the insertion point. 

 a)Delete b)Backspace 

 c)Ctrl d)Alt 

30. - - -  key deletes the characters to the right of the insertion point. 

 a)Ctrl b)Backspace 

 c)Delete d)Alt 

31. In which mode the existing text disappears to the right of the Insertion point- ----- 

 a)copy b)cut 

 c)insert d)type-over 

32. Which bar gives the information about the current mode? 

 a)status b)menu 

 c)formula d)tool 

33. Which is moved to the start of the text to be selected? 

 a)cursor b)insertion point 

 c)flashing line d)flash bar 

34. Which button of the mouse should be clicked to select the text? 

 a)right b)middle  

 c)left d)pointer 

35. How can we unselect the selected text? 

 a)Ctrl+click b)Click and drag 

 c)Double click d)click 

36. Which key is pressed down with the movement keys to select the text? 

 a)Shit b)Ctrl 

 c)Alt d)Funtion 

37. How will we select a word? 

 a)click a word b)double click a word 

 c)click once d)ctrl+click 
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38. What is the use of cut option? 

 a)move b)copy 

 c)change d)shift 

39. What is the hot key combination for moving a text? 

 a)Ctrl+C b)Ctrl+V 

 c)Ctrl+X d)Ctrl+P 

40. What is the shortcut key for copying the text? 

 a)Ctrl+C b)Ctrl+V 

 c)Ctrl+X d)Ctrl+P 

41. In which menu, do you find the Find & Replace option? 

 a)Format b)Insert 

 c)Edit d)File 

42. In which box, do we type the text to be found? 

 a)Find for b)Search for 

 c)Locate for d)Edit for 

43. Which button should be pressed to enter the changed text? 

 a)Replace b)Replace all 

 c)Find d)Find all 

44. Which button should be pressed to continue the search again? 

 a)Search b)Find all 

 c)Find d)Replace 

45. How can one find the word or phrase? 

 a)Search b)Copy 

 c)Select d)Close 

46. When the text is selected, how is it entered in the search for box? 

 a)automatically  b)functionally 

 c)clearly d)delebrately 

47. A- - -without any special formatting can have a monotonous appearance. 

 a)font b)type 

 c)text d)format 

48. StarOffice Writer offers a number of choices for- - -  

 a)focus b)graphic 

 c)format d)formatting 

49. Bold, Italic or Underlined are the most-- - -types of text formatting. 

 a)common b)general 

 c)important d)conveneient 

50. The formatting options are available under - - - menu. 

 a)File b)Format 

 c)Edit d)Modify 

51. A- - - is a set of characters and numbers in a certain style. 

 a)Symbol b)Style 

 c)Format d)Font 

52. Part of Word processing- - - is to choose an appropriate font for the document 

 a)skill b)technique 

 c)model d)style 

53. Text can be selected and any of the ------available in the system can be used. 

 a)format b)text 

 c)font d)style 

54. - - -  packages can also be purchased to add other font choices to the system. 

 a)Format b)Text 

 c)Font d)Style 

55. To choose a font type click down arrow in the fonts----- box of font tab in character 

    dialog box. 

 a)text b)list 

 c)list combo d)combo 

56. - - -  is used to open the character dialog box. 

 a)format--   character b) Font     character 

 c)Insert     character d) Edit   Character 

57. - - -  key combination is used to make a text bold. 

 a)CTRL+V b)CTRL+B 

 c)CTRL+I d)CTRL+A 
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58. ---- key combination is used to make the text Italics. 

 a)CTRL+V b)CTRL+B 

 c)CTRL+I d)CTRL+A 

59. --- key combination is used to make the text underlined. 

 a)CTRL+U b)CTRL+B 

 c)CTRL+I d)CTRL+A 

60. ----font style look professional and are suited for business documents. 

 a)Arial b)Times New Roman 

 c)Wingding d)Arial Narrow 

61. --- font style look decorative. 

 a)Fajita b)Arial 

 c)Coruier d)Comic Sans ms 

62. ---- font style are like symbols. 

 a)Arial b)Fajita 

 c)Wingding d)Symbols 

63. The----size of text document cannot be used in legal document 

 a)monotonous b)equal 

 c)regular d)same 

64. The size of the letters used in the main text and ---- cannot be the same. 

 a)bottom b)footer 

 c)top d)header 

65. The----of a font is measured in points. 

 a)size b)symbol 

 c)shape d)style 

66. There are ------points to an inch. 

 a)73 b)71 

 c)72 d)74 

67. The size of the font is measured in---- 

 a)points b)inches 

 c)dots d)size 

68. The larger the point size, the ------the type 

 a)smaller b)bigger 

 c)taller d)larger 

69. A----colour for selected text can be used. 

 a)same b)different 

 c)combination d)combine 

70. When color shades are taken in black and white, it looks----- 

 a)black b)white 

 c)gray d)grayish 

71. To use a different text color, select the text and click the arrow in the ----icon 

 a)Font color b)Font style 

 c)Font d)Font type 

72. ----- can be used to call attention to key ideas or pointers in a document 

 a)Bold b)Highlighting 

 c)Shade d)Background 

73. Highlighting sections are used to review----points in a document. 

 a)key b)standard 

 c)real d)clea 

74. To highlight the selected text, the ---icon is selected. 

 a)format b)font 

 c)highlighting d)character 

75. To remove the highlighting, select the text and select the----option from the colour 

   palette. 

 a)Fill b)No fill 

 c)No colour d)Colour 

76. The----option is under the Format menu. 

 a)character b)file 

 c)picture d)font 

77. Clicking on----displays the character dialog box. 

 a)Format---font b)Format---character 

 c)Format ---page d)Format ---effects 
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78. Formatting applied through menu allows us to make several------ 

 a)presentation b)modification 

 c)application d)changes 

79. Format----character option allows us to ----the changers before applying them. 

 a)preview b)verify 

 c)select d)check 

80. A---is any text followed by a hard return. 

 a)page b)sentences 

 c)block d)escape 

81. A hard return is inserted every time when----key is pressed. 

 a)Soft returns b)Hard return 

 c)Enter d)Escape 

82. Soft returns are inserted in the text are---- when text is added or deleted. 

 a)applied b)adjusted 

 c)selected d)placed 

83. When----key is pressed, the paragraph options for that paragraph are carried down  

 to the next paragraph. 

 a)enter b)escape 

 c)space bar d)backspace 

84. If a-----marker is deleted the paragraph takes on the formatting of the following 

 paragraph. 

 a)page b)line 

 c)paragraph d)block 

85. The----marker is the storehouse for all formatting options for that paragraph. 

 a)page b)paragraph 

 c)block  d)line 

86. When typing the StarOffice wirter, all text is---and right margin is ragged or uneven. 

 a)left aligned b)right aligned 

 c)centre aligned  d)justified 

87. The hot key for enter alignment is ----- 

 a)CTRL+L b)CTRL+R 

 c)CTRL+C d)CTRL+E 

88. The shortcut key to justify the text is –--- - - 

 a)CTRL+E b)CTRL+J 

 c)CTRL+C d)CTRL+V 

89. There are----types of paragraph alignment. 

 a)4 b)3  

 c)2 d)1 

90. What changes are most appropriate for heading or other special paragraph in the 

document? 

 a)Indent  b)Alignment 

 c)Paragraph d)Formatting 

91. What helps the reader to see how the document is divided into paragraph? 

 a)Visual Aid b)Visual indent 

 c)Visual Clue d)Visual Design 

92. What is the special kind of indent available for numbered list? 

 a)Negative indent b)Hanging indent 

 c)Increase indent d)Decrease indent 

93. One can make a change in the amount of indent requirement using---- 

 a)Paragraph dialog box b)Character dialog box 

 c)format menu d)Eid tmenu 

94. Increase indent, indents the paragrph-----from the left margin. 

 a)1/4 inch b)1 inch 

 c)1/2 inch d)1.25 inch 

95. Which icon should be pressed to undo indents? 

 a)Increase indent  b)Spacing 

 c)Indent d)Decrease indent 

96. To indent from the left the value should be specified in----spin box. 

 a)before text b)after text 

 c)on the text d)indent 
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97. To indent from the right the value should be specified in--- spin box. 

 a) before text b)after text 

 c)on the text d) indent 

98. If a/an----- value is specified, the first line will be indented. 

 a)additional  b)negative 

 c)positive d)first 

99. A----value will result in hanging indent. 

 a)additional  b)negative 

 c)positive d)first 

100. In Hanging indent, the first line will----outside the paragraph. 

 a)hang b)place 

 c)indent d)locate 

101. StarOffice Writer------spaces the text in the documents by default. 

 a)atleast b)1.5 line 

 c)double d)single 

102. There are ----- ways of line spacing available in StarOffice Writer. 

 a)4 b)5 

 c)6 d)7 

103. A----precedes each item in the list, and the text is indented. 

 a)Bullet b)Symbol 

 c)Numbered d)Icon 

104. -----list work well for directions or other points one want to present in sequences. 

 a)Bullet b)Symbol 

 c)Numbered d)Icon 

105. ----automatically numbers all the items in a list, and the text is indented 

 a)StarOffice Calc b)StarOffice Impress 

 c)StarDraw d)StarOffice Writer 

106. In a numbered list if one adds or deletes an item, if automatically---- 

 a)renumbers b)arranges 

 c)sorts d)aligns 

107. StarOffice Writer provides various styles for the bullets and numbers, which can be 

selected using---- 

 a)Insert =--- Bullets and Numbering b)Format--- Bullets and Numbering 

 c)Edit ---- Bullets and Numbering d)Character--- Bullets and Numbering 

108. A----is a named set of defaults for formatting text. 

 a)Font b)Format 

 c)Style d)Stylist 

109. ---require more advanced planning 

 a)Type  b)Type Face list 

 c)Stylist d)Style 

110. ----- is the shortcut key to choose StarOffice help. 

 a)F1 b)Shift+F1 

 c)Ctrl+F1 d)Alt+F1 

111. The----opens the help topic for the task. 

 a)Help Button  b)Help Agent 

 c)Help Tip d)Help assistant 

112. Rest the mouse pointer over a menu command or ever any icon to display a----- 

 a)Help Button b)Help Agent 

 c)Help Tip d)Help Assistant 

113. To view a brief description of what the command or icon does, press----to display 

 an extended up. 

 a)F1 b)Shift+F1 

 c)Ctrl+F1 d)Alt+F1 

114. The-----of Help Agent window changes according to the activity on the main window 

 a)Heading b)Index 

 c)Text d)Content 

115. The documents prepared using Word Processing software should be without 

any......mistake. 

 a)spelling b)typing 

 c) grammar d) word 
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116. Which includes a dictionary and spell-check program? 

 a)Star Office Calc b)StarOffice Writer 

 c)Star Office Impress d) Star Office Base 

117. StarOffice writer can....... the spelling mistakes as the document is being typed. 

 a) check                    b )find  

 c) identify d) access 

118. StarOffice Writer can....... the spelling mistakes after the entire document is typed. 

 a) check b) find 

 c) identify d) access 

119.  StarOffice Writer has an ....... spell-check feature that can check for possible spelling 

mistake. 

 a) constant b) general 

 c) regularr d) automatic 

120. The Auto-spell check feature can be ON or OFF using ........... icon. 

 a)                         b)                    c)  d)   

 

121. When Auto-spell chedck is in, StarOffice Writer......each word types with the words in 

the dictionary. 

 a) combines b) compares 

 c) verify d) checks 

122. StarOffice Writer..........the words that do not match with the dictionary. 

 a) underlines b) bold 

 c) strike d) both (a) and (b) 

123. Star OfficeWriter underlines with............red line the words that do not match. 

 a) wavey b) squiggly 

 c) curly d) straight 

124. Star Office writer underlines the misspelled with squiggly....line. 

 a) black             b) blue         

 c) red             d) green 

125. When we type in the StarOffice Writer the red lines......ignored. 

 a)must be b) should be 

 c)cannot be d) can be 

126. When Auto-spell check feature is  ........the typing work may be continued. 

 a) ON          b) OFF        c) OPEN             d) C LOSE 

127. The .....................can be made after the document is created. 

 a)checking correction 

 c) revision d) comparing 

128. Which key is pressed to delete a misspelled word and the word is retyped?..... 

 a) Ctrl +X b) Erase 

 c)Delete d) Backspace 

129. If right spelling is not known, StarOffice writer can help tghe user with some..... 

 a) options b)choices 

 c) variety d) lists 

130. To check  a document ............              ..........           ...........is clicked. 

 a) Tools, Spelling, Check b) Spelling, Tools, Check 

 c) Tools, Check, Spelling d) Spelling, Check, Tools 

131. The ...................key may also be pressed to select the spelling command. 

 a) F2         b) F5             c) F7           d) F8 

132. In the Spellcheck dialog box.the.............text area displays the misspelled word. 

 a)Not in dictionary b) Dictionary 

 c) Not in d) Suggestion 

133. In the Spell check dialog box ..................list displays any alternative spellings. 

 a) Add b) Suggestions 

 c) Choices d) Change 

134. .............button is  clicked is skip that particular occurrence of the word and stop on the 

next one. 

 a) Skip         b) Ignore         c) Ignore Once           d) Skip Once 

135. .....................button is clicked to skip all occurrence of the word . 

 a) skip b) Skip Once 

 c) Ignore Once d) Ignore All 
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136. To replace the word with one of the selected spelling click on...... button. 

 a) Change b) Change all 

 c) Choice D) Replace 

137. Which button is clicked to add a word to the dictionary? 

 a) Choice        b) Add       

 c) Change        d) replace 

138. StarOffice Writer recognises some common misspelling and ..........mistakes. 

 a) Writing b) typing 

 c) typographical d) typist 

139. Which option can add a word for replacement in a document? 

 a) Auto spell-check b) Automatic spelling 

 c) Auto list d) Autoformat 

140. An error and its correction is added to .............. option . 

 a) Auto correct b) Auto display 

 c) Auto format d) Auto list 

141. How can mistakes be corrected both while  typing as well as after the entire document is 

typed? 

 a) Editing b) spelling 

 c) Autocorrect d) Correcting 

142. How will we create simple, default style border?....... 

 a. Table Insert Table b) Insert Table Table 

 c) Insert Table Rows d) Insert  Table  Column 

143. Which dialog box is selected from the Table menu bar?..................... 

 a) Table Insert b)  Insert Table 

 c) Table Name d) Insert Rows 

144. How is a table identified by?............... 

 a) Row b) Column 

 c) Name d) Cell 

145. StarOffice Writer displays the table as a ................... 

 a) Cell b) Square 

 c) Border d) Grid 

146. By default each cell includes a ................ 

 a) border b) name 

 c) row d) column 

147. The table border can be.............. 

 a)  included b) deleted or changed 

 c) displayed d) used 

148. Which toolbar appears when View  Insert is selected from the menu bar?......... 

 a) Standard b) formatting 

 c) floating d) table 

149. ..............the mouse over the grid to specify the number of rows and columns. 

 a)  Move b) Cut 

 c) Place d) Drag 

150. Where is the Insertion point placed, when a table is created?.......... 

 a) last cell b) first cell 

 c) first row d) last column 

151. Which is the intersection of a row and a column?.................. 

 a) Table b) Border 

 c) Cell d) Entire Table 

152. Which key is used to move forward in a Table?................... 

 a) Shift b) Arrow 

 c) Enter d) Tab 

153. Which key is used to move backward through the cells in a table?................... 

 a) Shift+Tab b) Tab 

 c)_ Ctrl + Tab d) Alt + Tab 

154. In a table, when the Tab key is pressed the insertion point moves............... 

 a) upward b) downward 

 c) forward d) backward 

155. In a table, when the shift +tab key is pressed the insertion point moves........... 

 a)upward b)downward 

 c) forward d) backward 
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156.  When the text is more than the cell size, the text is ................. 

 a) wrapped b) fitted 

 c) fixed d) placed 

157. In a table, when the text is wrapped in a cell, it grows................ 

 a) smaller b) wider 

 c) taller d) expanded 

158. what can be formatted and edited in a cell?................ 

 a) contents b) text 

 c) data d) border 

159. After creating a table the required number of rows and columns can either be.........very 

easily. 

 a) added b) deleted 

 c) created d) added or deleted 

160. Which is the simples way to add a row to a table, when placing our insertion point in the 

last row?................ 

 a) press shift + tab key b) press tab key 

 c) press enter key d) press Ctrl + home key 

161. How can we insert more than one row or column ?................ 

 a) Table  Insert  Row b) Insert  Row Cell 

 c) Insert  Row and Column d) Insert  Column and Row 

162. How can we delete Row / Column............. 

 a) Table  Delete Rows/Column b) Table Delete Table 

 c) Table  Row Table d)Table Select  Table 

163. How can we change rows/column width?............... 

 a) hold down Ctrl + left/right arrow b) hold down Alt + left / right arrow 

 c) hold down Ctrl +up / down arrow d) hold down Alt + up /down arrow 

164. Which dialog box helps in changing dialog box?............. 

 a) File Formatting b) Format Table 

 c) Table Format d)Format 

165. How can we make the columns even?................ 

 a) Line  Space equally b) Table Space equally 

 c) Column   Space equally d) Row Space equally 

166. How can we make the rows even?.............. 

 a) Line  Space equally b) Table Space equally 

 c) Column   Space equally d) Row Space equally 

167. Once a click is made inside a table a ..... tool bar for table appears at the top of the screen. 

 a) Floating b) Hanging 

 c) Placing d) Standard 

168. Which can be easily inserted at any point in the document?......... 

 a) Row b) Table 

 c) Column d) Function 

169. Which indicates StarOffice Writer, how close to print to the edge of the page?---- 

  a) Margins control b) Margin guide 

 c)Rulers d)Margin 
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Text Formatting 

 

I. Choose the Correct Answers :-       

1. Which icon is to be clicking to utilize different colours in a text? 

 a) File icon   b) Open file icon 

 c) Font colour icon   d) Colour icon 

2. To remove the highlighting, select the text and select the _____ from the colour palette. 

 a) no fill b) white 

 c) black d) red 

3. ______ fonts are suitable for business document. 

 a) Arial b) Fajita 

 c) Times New Roman d) Windings 

4. The size of a font is measured in _______ 

 a) Lines b) Points 

 c) Characters d) All the above 

5. _____ will periodically save when the application is working on. 

 a) Auto save b) Save 

 c) Save as d) None of the above 

6. A negative indenting value will result in a ______ 

 a) Hanging indent b) Left indent 

 c) Right indent d) None of the above 

7. Alignment changes are most appropriate for ______ in the document. 

 a) Headings and Special paragraphs b) Heading and New lines 

 c) Paragraphs only d) None of these 

8. With the help of the colour printer, some splash can be added to the document by 

changing the ______ of the text. 

 a) Alignment b) Size 

 c) background d) font 

9. ______ key is used to make the selected text bold. 

 a) Ctrl + O b) Ctrl + I 

 c) Ctrl + B d) Ctrl + V 

10. _______ fonts are symbols. 

 a) Wingdings b) Fajita 

 c) times New Roman d) Arial black 

11. The default alignment of starofficewriter is _______ 

 a) Right alignment b) Left alignment 

 c) Center alignment d) Justified 

12. _____ can be used to search for help on other Staroffice elements. 

 a) Help window b) View window 

 c) Edit window d) Menu window 

13. Clicking on ______ displays the character dialog box. 

 a) format character b) format paragraph 

 c) format default d) format page 

14. Soft return are inserted as _______ 

 a) Line breaks  b) Blank space 

 c) Comma d) None of the above 

15. ____ is set of symbols. 

 a) Fajita b) Times New Roman 

 c) Arial d) Windings 

16. To print invitation _____ font is used. 

 a) Symbol b) Wingdings 

 c) Fajita d) All the above 

17. Bold, Italic or underlined are the most common types of _____ formatting. 

 a) Word b) Character 

 c) Text d) All of these 

18. Star Office has an ________ facility. 

 a) Online help b) offline help 

 c) Autoquick info d) Autolist members 

19. The default line spacing for a starofficewriter document is _____ 

 a) Single line b) Double spacing 

 c) 1.5 lines  d) Proportional 
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20. To remove the bullets from the list again click the _______ button. 

 a) Bullet b) Keyboard button 

 c) Mouse button d) Numbered button 

21. A paragraph in any text followed by a _____ 

 a) hard return  b) soft return 

 c) hard and soft return d) full stop 

22. Highlighting can be removed by selecting _______ option from the colour pallette. 

 a) No colour b) Fill 

 c) No Fill d) Remove colour 

23. Indentation helps in providing the documents more ______ 

 a) line space b) readability 

 c) help d) store 

24. By using ____ the styles for the buttons and numbers can be selected. 

 a) Format  Bullet b) Format  Numbering 

 c) Format  Numbering / Bullets d) Format  Style 

25. How many types pf alignment are there in StarWriter ________ 

 a) 2                   b) 4                    c) 3         d) 1 

26. _____ (key combination) is used to make selected text under line. 

 a) Ctrl + S b) Ctrl + J 

 c) Alt + U d) Ctrl + U 

27. ______ is used to select the required colour. 

 a) Colour palette b) Icon 

 c) Font d) Background 

28. Each time the button is clicked, the paragraph is indented another ________ 

 a) inch                 b) 1.5 inch                     c) 2.75 cm                    d) ½ inch 

29. ______ is the keyboard shortcut for justified alignment. 

 a) Ctrl + J b) Ctrl + C 

 c) Ctrl + V d) Ctrl + K 

30. The fastest way to create a bulleted list is to use the _____ on the formatting tool box. 

 a) Bullet buttons b) Keyboard button 

 c) Mouse button d) Numbered button 

31. The process that changes the monotonous appearance of a text is _______ 

 a) decoration b) editing 

 c) formatting d) underlining 

32. StarOffice Writer is used to create _____ 

 a) Presentation b) Database 

 c) Document d) Spreadsheet 

33. A ______ is a named set of defaults for formatting text. 

 a) font                       b) tab c) page                        d) style 

34. _____ icon is clicked to highlighted the selected text. 

 a) Colour b) Highlighting 

 c) View d) File 

35. To view a brief description of what the command or icon does, press ____ to display an 

extended tip. 

 a) F1 b) Shift + F1 

 c) Ctrl + F1 d) Alt + F1 

36. What is the maximum size of fonts? 

 a) 72                      b) 12 c) 96                        d) 100 

37. What is the use of the        key?  

 a) Cut b) Copy 

 c) Undo d) Redo 

38. This icon         is used for ? 

 a) Copy b) Paste 

 c) Move d) Delete 

39. What is the default name of opening a new document in Staroffice writer? 

 a) document b) .doc 

 c) untitled1 d) title 

40. Staroffice writer _____ spaces the text in the documents by default. 

 a) atleast b) 1.5 line 

 c) double d) single 
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CORRECTING SPELLING MISTAKES 

 

I. Choose the Correct Answers :-       

1. _____ recognises some common mistakes and typographical mistakes and makes the 

replacement automatically. 

 a) Auto correct option   b) Auto format option 

 c) StarOffice   d) Spell-check option 

2. Staroffice writer can identify the ____ as the document is typed. 

 a) spelling mistakes b) colour 

 c) language d) fonts 

3. To add the error and its correction to the auto correct list the _____ command is used 

 a) Tools  File b) Tools  correct 

 c) Help  auto correct d) Tools  auto correct / auto format 

4. During spell checking, which button must be clicked to skip all occurrence of the 

misspelled word? 

 a) Ignore all button b) Cancel button 

 c) Skip button d) Dictionary 

5. To add a word to the dictionary ____ button is clicked in the spelling check dialog box. 

 a) Replace b) Add 

 c) Language d) Suggestions 

6. Which of the following keys are to be pressed to move backward through the cell? 

 a) TAB key b) Shift + tab key 

 c) Shift key d) Shift + Insert key 

7. If none of the replacement is correct in the text, correction can be made _____ 

 a) with computer b) manually 

 c) automatically d) none of these 

8. Which of the following keys are to be pressed to move forward through the cells 

 a) shift key b) TAB key 

 c) Shift + Tab key d) Shift + Insert 

9. The ____ can be turned ON or OFF. 

 a) auto spell-check b) spelling check 

 c) auto correct d) auto format 

10. If the word is not in the dictionary, the word will be underlined in _____ colour. 

 a) Green b) Blue 

 c) Red d) Yellow 

11. To skip the current occurrence but stop on the next one ___ button is clicked in spelling 

check dialog box. 

 a) Ignore all b) Replace all 

 c) Ignore d) Replace 

12. The key that is pressed to select the spelling command is ______  

 a) F3 b) F2 

 c) F5 d) F7 

13. StarOffice Writer recognizes some common ____ and changes automatically. 

 a) symbol b) characters 

 c) misspellings d) fonts 

14. The number of tabs in auto correct dialog box is ____ 

 a) 2 b) 3 

 c) 4 d) 5 

15. For spell-check after completing the document click ______ 

 a) Tools  Spell-check b) Tools  Auto spell-check 

 c) Tools  Spelling  Check d) Edit  Spelling  Check 

16. The entire table is selected using the menu _______ 

 a) edit b) file 

 c) Table d) format 

17. The border is dragged to the right to widen the _____ size. 

 a) Column b) Row 

 c) Both (a) and (b) d) None of these 

18. If _____ key is pressed, only the entries are deleted and not the table. 

 a) Tab b) Shift + Tab 

 c) Del d) HOME 
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19. In the  ____ text box, the name of the table is given. 

 a) Columns b) Rows 

 c) Name d) Size 

20. The ____ icon is the Insert table icon in the floating toolbar for insertion function. 

 a) first b) second 

 c) third d) fourth 

21. The icon that combines two or more cells into a single cell is  

 a) merge cell b) split cell 

 c) borders d) line style 

22. The number of icons present in the table formatting tool bar is ____ 

 a) 12 b) 13 

 c) 11 d) 14 

23. The simplest way to add  a row is to press ___ in the last row of the table. 

 a) Backspace b) Home 

 c) Tab d) Shift + tab 

24. Which icon displays a pop-up menu with options like space column equally, row equally? 

 a) Optimize b) Pop-up menu 

 c) Line style d) Column 

25. After creating the table, StarWriter places the insertion point in the ____ of the table. 

 a) first cell b) second cell 

 c) third cell d) fourth cell 

26. To add more number of columns _____ command is used. 

 a) Format  Insert b) Table  Insert  Columns 

 c) Format  Column  Insert d) Format  Delete 

27. Using the _____  in the columns and rows textbox, the number of columns and rows are 

entered. 

 a) up arrow b) spin arrow 

 c) right arrow d) left arrow 

28. The border is dragged to the left to narrow the _____ size. 

 a) column b) width 

 c) row d) none of these 

29. ____ icon is used to split a cell into two (or) more cells. 

 a) Merge cells b) Split cells 

 c) Rows d) Break cells 

30. Borders of the table can be changed using _______ 

 a) table-formatting toolbar b) table toolbar 

 c) toolbar d) taskbar 
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WORKING WITH TABLES 

 

I. Choose the Correct Answers :-      

1. The entire table is selected using the menu _____ 

 a) edit   b) file 

 c) table   d) format 

2. The border is dragged to the right to widen the _______ size. 

 a) column b) row 

 c) both (a) and (b) d) none of these 

3. If ______ key is pressed, only the entries are deleted and not the table. 

 a) tab b) shift + tab 

 c) del d) Home 

4. In the ____ text box, the name of the table is given. 

 a) columns b) rows 

 c) name d) size 

5. The ____ icon is the Insert table icon in the floating toolbar for insertion function. 

 a) first b) second 

 c) third d) fourth 

6. The icon that combines two or more cells into a single cell is ____ 

 a) merge cell b) split cell 

 c) borders d) line style 

7. The number of icons present in the table formatting tool bar is _____ 

 a) 12 b) 13 

 c) 11 d) 14 

8. The simplest way to add a row is to press _____ in the last row of the table. 

 a) backspace b) home 

 c) tab d) shift + tab 

9. Which icon displays a pop-up menu with options like space column equally, row equally? 

 a) optimize b) pop-up menu 

 c) line style d) column 

10. After creating the table, StarWriter places the insertion point in the ____ of the table. 

 a) first cell b) second cell 

 c) third cell d) fourth cell 

11. To add more number of columns _______ command is used. 

 a) Format → Insert b) table → Insert → Columns 

 c) Format → Column → Insert d) Format → Delete 

12. Using the ___ in columns and rows text box, the number of columns an rows are entered. 

 a) up arrow b) spin arrow 

 c) right arrow d) left arrow 

13. The border is dragged to the left to narrow the _____size. 

 a) column b) width 

 c) row d) none of these 

14. _____ icon is used to split a cell into two (or) more cells. 

 a) Merge cells b) Split cells 

 c) Rows d) Break cells 

15. Borders of the table can be changed using _______ 

 a) table-formatting tool bar b) table toolbar 

 c) toolbar d) task bar 

16. The border is dragged to resize the height of ______ 

 a) text b) row 

 c) space d) width 

17. The pointer should like two ___ lines with arrows on either side when the select the row. 

 a) Horizontal b) Parallel\ 

 c) Vertical d) none of the above 

18. Which icon is used to choose the style of the line to be used for the border ? 

 a) borders b) style 

 c) line style d) border style 

19. To make all column even ______ command is used. 

 a) Format → Column → space equally b) Row →  space equally 

 c) Insert → Column → space equally d) none of these 
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20. Once a click is made inside a table, floating toolbar for table appears at the _____ of the 

screen. 

 a) left bottom b) right bottom 

 c) middle d) top 

21. As the mouse is moved over the grid, it specifies the number of ______ 

 a) rows b) columns 

 c) both rows and columns d)none of the above 

22. Which dialog box can be used to set the width of the column to an exact size ? 

 a) Delete dialog box b) Format dialog box 

 c) Table format dialog box d) none of these 

23. The third icon in the floating tool bar for insertion function is ____ 

 a) borders b) insert pictures 

 c) file d) insert column 

24. To delete a row use ______ 

 a) Row → Format → Delete b) Delete → Row → Format 

 c) Format → Delete → Row d) Delete → Row 

25. The ______ is used to specify the number of rows and columns. 

 a) grid b) toolbar 

 c) insert menu d) name 

26. Which of the following command is used to insert a table in star office writer document? 

 a) Insert → Table → Table b) Tools → Insert → table 

 c) Table → insert → table d) Insert → table → Rows & columns 

27. Which command is used to insert more than one row in the table ? 

 a) Table → inert → Rows b) Format → Rows → Insert 

 c) Format → Insert → Rows d) Table → Rows → Insert 

28. Which command is used to insert more than one column in the table ? 

 a) Format → Column → Insert  b) Format → Insert → column 

 c) Table → Insert → columns d) Tools → Table → columns 

29. Which key is pressed to delete only entries in the table? 

 a) Tab b) backspace  

 c) Delete d) Ctrl + Alt 

30. Which key is hold down to resize the column without changing the width of the table ? 

 a) Alt + Ctrl b) Ctrl + Shift 

 c) Shift + Tab d) Alt 

31. Which key is hold down to resize the row ? 

 a) ctrl b) shift 

 c) tab d) Alt 

32. Which command is used to select the column width of the table ? 

 a) Table → Format b) Format → Table 

 c) Table → properties d) Table → Table properties 

33. How to make he selected rows in same size ? 

 a) Row → space equally b) Space equally → Row 

 c) Format → Row → Space d) Space → Row → Equally 

34. By default, each cell include a _____ 

 a) borders b) Rows 

 c) columns d) rows and columns 

35. Which icon is clicked to insert a table in a Star Office Writer document ? 

 a) Table b) Insert table 

 c) Table insert d) Floating table 

36. Which tool bar appears if the mouse button is not released immediately on insert table 

icon? 

 a) Main b) Formatting 

 c) Floating d) Standard 

37. In floating toolbar, pointing to the insert table icon displays a _____ 

 a) Grid b) rows 

 c) columns d) toolbar 

38. Which of the following key is used to move backward through the cells ? 

 a) Tab b) Shift + key 

 c) Ctrl + tab d) Ctrl + home 
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39. Which of the following icon is insertion of a column and a row? 

 a) Grid  b) cell 

 c) table d) data 

40. Which icon is used to combine two or more cells into a single cell ? 

 a) table fixed b) table cell 

 c) merge cell d) combine cells 

41. Which of the following icon have the option space rows equally ? 

 a) borders b) split cells 

 c) inserting row d) optimize 

42. Which dialog box can be used to set the width of the column to an exact size of the Star 

Office Writer Table ? 

 a) Insert table b) Table Format 

 c) Format table d) Table insert 

43. ______ is the intersection of row and column. 

 a) Table b) cell 

 c) field d) record 

44. To insert a table _____ is selected. 

 a) Format → Table b) Table → insert 

 c) Insert → Table d) View → Table 

45. To make all columns even _____ is selected. 

 a) Format → Column → space equally b) Format → Row → space equally 

 c) column → space equally d) none of these 

46. To make all rows even _______ is selected. 

 a) Format → column → space equally b) Format → Row → Space equally 

 c) Column → space equally d) none of these 

47. ____ key is used to move forward through the cells in a table. 

 a) Esc b) Spacebar 

 c) Enter d) Tab 

48. ____ key is used to move backward through the cells in a table. 

 a) Shift + tab b) spacebar 

 c) enter d) tab 

49. In StarWriter, to delete a selected row in a table, click ______ 

 a) Row → Format → Delete b) Format → Row → Delete 

 c) Format → Delete → Row d) Delete → Row 

50. Which icon is used to combine two or more cells into a single cell in Star Writer ? 

 a) Optimise b) Split cell 

 c) Table fixed d) Merge cell 

51. In a table, a cell can contain any amount of _____ 

 a) text b) picture 

 c) variable d) none of these 

52. To insert more than one row in the table, select ________ 

 a) Format → Column → Insert b) Insert → Row 

 c) Format → Row → Insert d) Insert key 

53. To insert more than one column in the table, select ____ 

 a) Format → Column → Insert b) Insert → Row 

 c) Format → Row → Insert d) Insert key 

54. A _____ is a grid with specified number of rows and columns. 

 a) cell b) table 

 c) border d) none of these 

55. _____ dialog box is used to set he width of the column to an exact size. 

 a) page style b) table formatting 

 c) search and replace d) none of these 

56. The _____ toolbar contains a number of icons which are related to table. 

 a) page style b) table formatting 

 c) search and replace d) none of these 

57. The table contents can be deleted by selecting and pressing the ______ key. 

 a) shift + delete b) delete 

 c) ctrl + delete  d) none of these 

58. Every table is identified by a specific_____ 

 a) name b) number 

 c) pass word d) none of these 
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59. By default the all the columns in a table will be of ______ 

 a) different width b) uniform width 

 c) accurate width d) none of these 

60. By default the all the rows in a table will be of _____ 

 a) different height b) uniform height 

 c) accurate height d) none of these 

61. ____ icon is used to split a cell into two or more cells in a table. 

 a) split cells b) divide cells 

 c) merge cells d) none of these 

62. Using the _____ arrows in the columns and rows text box the number of rows and 

columns are entered. 

 a) right b) up 

 c) down d) spin 

63. To delete the entire table ______ is selected. 

 a) Format → Delete b) Edit → Column → Delete 

 c) Format → Column → Delete d) none of these 

64. The intersection of row and column is called ___ 

 a) box b) cell 

 c) point d) table 

65. The number of icons in the table formatting tool bar is _____ 

 a) 9 b) 11 

 c) 13 d) 15 

66. By default each cell includes a _____ 

 a) number ) address 

 c) border d) none of these 

67. The simplest way to ad a row is to press ______ in the last row of the table. 

 a) enter b) tab 

 c) shift d) Alt 

68. A _____ is  grid of cells with specified number of rows and columns. 

 a) cell b) table 

 c) column d) row 

69. ____ dialog box can be used to set the width if the column to an exact size. 

 a) page style b) table format 

 c) insert table d) none of these 

70. Every table is identified by a specific ______ 

 a) id             b) number                  c) label  d) name 

71. To delete the contents of the table _____ key is pressed. 

 a) shift             b) del c) enter d) Alt 

72. _____ tool bar is used to change the border of the table. 

 a) page formatting b) table formatting 

 c) cell formatting d) formatting 

73. _____ command is used to select the entire table. 

 a) Edit → Select all b) Format → Select all 

 c) View → Select all d) View → Table 

74. The menu option ____ is used to delete the selected table. 

 a) Table → Delete → Table b) Table → Delete 

 c) Table → Row → Delete d) none of these 

75. The menu option ____ is used to delete the selected rows. 

 a) Table → Delete → Rows b) Table → Rows → Delete 

 c) Rows → Delete d) none of these 

76. The menu option _____ is used to delete the selected columns. 

 a) Table → Delete → Columns b) Table → Delete 

 c) Table → Columns → Delete d) none of these 

77. Border colour icon is available on the ______ tool bar. 

 a) Formatting      b) table formatting          c) Editing             d) none of these 

78. How will we create simple, default – style borer ? 

 a) Table → Insert → Table b) Insert → table → Table 

 c) Insert → Table → Rows d) Insert → Table → Column 

79. Which dialog box is selected from the table menu bar ? 

 a) Table insert         b) Insert table         c) Table name       d) Insert Rows 
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80. How is a table identified by ? 

 a) Row               b) Column                   c) Name                   d) Cell 

81. StarOffice Writer displays the table as a _____ 

 a) Cell                b) Square                     c) Border                   d) Grid 

82. By default each cell includes a _____ 

 a) border            b) name                        c) row                   d) column 

83. The table border can be ______ 

 a) included         b) deleted or changed          c) displayed       d) used 

84. Which toolbar appears when View → Insert is selected from the menu bar ? 

 a) standard         b) formatting                       c) floating       d) table 

85. _____ the mouse over the grid to specify the number of rows and columns. 

 a) Move             b) Cut                                   c) Place       d) Drag 

86. Where is the insertion point placed, when a table is created ? 

 a) last cell          b) first cell c) first row       d) last column 

87. Which is the intersection of a row and a column ? 

 a) Table              b) Border c) Cell                   d) Entire table 

88. Which key is used to move forward in a Table ? 

 a) Shift               b) Arrow c) Enter       d) Tab 

89. Which key is used to move backward through the cells in a table ? 

 a) Shift + Tab     b) Tab c) Ctrl + Tab       d) Alt + Tab 

90. In a table, when the Tab key is pressed the insertion point moves ______ 

 a) upward           b) downward c) forward       d) backward 

100.      In a table when the shift +tab key is pressed the insertion point moves______  

            a)upward            b)downward                         c)forward       d)backward 

101.     When the text is more than the cell size,the text is ____________ 

 a)Wrapped          b)Fitted c)Fixed       d)Placed 

102. In a table, when the text is wrapped in a cell ,it grows _______ 

 a)Smaller            b) wider c) taller       d) expanded 

103. what can be formatted and edited in a cell ? 

 a) contents          b) text c) data                   d) border 

104. After creating a table the required number of rows and columns can either be _____ 

 Very easily. 

 a)Added             b)Deleted c)Created       d)Added or Deleted 

105. Which is the simplest way to a table,when placing our insertion point in the last row? 

 a)Press shift+tab key b)press tab key 

 c)press enter key d)Press ctrl+home key 

106. How can we insert more than one row or column ?__________ 

 a)Table →Insert → row  b)Insert→Row→Cell 

 c)Insert → row and column c)Insert → column and Row    

107. How can we delete Row / Column ? 

 a) Table → Delete → Rows / column b) Table → Delete → Table 

 c) Table → row → Delete d) Table → Select → Table 

108. How can we change rows / column width ? 

 a) hold down Ctrl + left / right arrow b) hold down Alt + left / right arrow 

 c) hold down Ctrl + up / down arrow d) hold down Alt + up / down arrow 

109. Which dialog box helps in changing dialog box ? 

 a) File Formatting       b) Format Table c) Table Format d) Format 

110. How can we make the column even ? 

 a) Line → Space equally b) Table → Space equally 

 c) Column → space equally d) Row → Space equally 

111. How can we make the rows even ? 

 a) Line → Space equally b) Table → Space equally 

 c) Column → Space equally d) Row → Space equally. 

112. Once a click is made inside a table a ____ tool bar tables appears at the top of the screen. 

 a) Floating b) Hanging 

 c) Placing d) Standard 

113. Which can be easily inserted at any point in the document ? 

 a) Row b) Table 

 c) Column d) Function 
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PAGE FORMATTING 

 

I. Choose the Correct Answers :-      

1. What is the default margin of top and bottom?---- 

  a) 1.25 inches b) 1 inch 

 c)1.50 inches d) 1.20 inches 

2. How many methods are available to change the margins?---- 

  a) 4 b)3 

 c) 2 d)1 

3. What is the default margin of left and right?------ 

  a) 1.25 inches b) 1 inch 

 c) 1.50 inches d) 1.20 inches 

4. Page command is available under -----menu. 

 a) File b)Edit 

 c)Insert d)Format 

5. Which option in File menu is useful to see the visual change affected to the document 

 a) Page preview b)Print preview 

 c)Preview d)Page view 

6. Where can we find the Ruler option?----- 

 a) File b)Edit 

 c)View d)Format 

7. Which area of the ruler indicates the margin‘s top area? 

  a) black b) gray 

 c)white d)black and white 

8. Which is moved between the gray and white area of the ruler? 

 a)Indication pointer b)Insertion pointer 

 c)Mouse d)Mouse pointer 

9. Which is dragged to a new location in the ruler?----- 

 a)margins b)margin guide 

 c)left margin d)right margin 

10. When the length of a document is more than the width, it is called as 

 a) portrait b)landscape 

 c) new page d)header 

11. When the width of a document is more than the length it is called as 

 a) portrait b)landscape 

 c) new page d)header 

12. Which is the default page orientation?----- 

 a) Header b)Landscape 

 c)Portrait d)Footer 

13. Most documents are printed in----inch by----inch paper. 

 a) 8, 11 b) 8, 11, 5 

 c) 8.5, 11.5 d) 8.5, 11 

14. Select the necessary paper format from the format drop-down list in the ---section 

  a) Page format b)Format page 

 c)Insert page d)Edit page 

15. There are ------ types of Page Orientation. 

 a) 4 b) 3 

 c) 2 d) 1 

16. ----- is an area at the top of the page. 

 a) Footer b) Header 

 c) Head d) Foot 

17. ----- check box is clicked, on the Page style dialog box. 

 a) Header on b)Footer on 

 c) Head on d)Foot on 

18. To create a footer,----- tab is clicked. 

 a) Head b)Header 

 c) Footer d) Foot 

19. Which lists a list of options in the Header/Footer tab?----- 

 a) Field b)Submenu 

 c) Page style d)Insert 
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20. The required style can be selected from the list of styles displayed in the---combo box 

 a) Field b) Footer 

 c) Page Style d) Format 

21. How will we create simple, default-style border ? 

 a) Table Insert Table b) Insert Table Table 

 c) Insert Table Rows d) Insert Table Column 

22. Which dialog box is selected from the Table menu bar? 

 a) Table Insert b) Insert Table 

 c) Table Name d) Insert Rows 

23. How is a table identified by ? 

 a) Row b) Column 

 c) Name d) Cell 

24. StarOffice Writer displays the table as a ______ 

 a) Cell b) Square 

 c) Border d) Grid 

25. By default each cell includes a _______ 

 a) Border b) Name 

 c) Row d) Column 

26. The table border can be ______ 

 a) included                  b) deleted or changed     

 c) displayed d) used 

27. Which toolbar appears when View  Insert is selected from the menu bar ? 

 a) standard                 b) formatting             

 c) floating d) table 

28. _____ the mouse over the grid to specify the number of rows and columns. 

 a) Move           b) Cut               

 c) Place d) Drag 

29. Where is the Insertion point placed, when a table is created? 

 a) last cell               b) first cell      

 c) first row d) last column 

30. Which is the intersection of a row and a column? 

 a) Table             b) Border               

 c) Cell d) Entire Table 

31. Which key is used to  move forward in a Table ? 

 a) Shift            b) Arrow             

 c) Enter d) Tab 
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SPREADSHEET 

 

I. Choose the Correct Answers :-      

1. The personal computers appeared in------ 

 a) 1975 b) 1977 

 c) 1979 d) 1976 

2.  PCs became popular in------ 

 a) 1975 b) 1977 

 c) 1979 d) 1976 

3. The PC‘s became more popular when------and-------invented VisiCalc. 

 a) Dan Bricklin, Bob Frankston b) Charles Babbage, Lady Ada 

 c) Von New Ulann, William d) John Ulanchly, Thomas Kurtz 

4. Who invented the APPLE II? 

 a) Dan Bricklin b) Bob Frankston 

 c) Dan Bricklin and BobFrankston d) Charles Babbage 

5. VisiCalc for APPLE II was invented in the year----- 

 a) 1975 b) 1977 

 c) 1979 d) 1976 

6. VisiCalc for APPLE II was invented by------ 

 a) Dan Bricklin and Bob Frankston  b) Charles Babbage, Lady Ada 

 c) Von New Ulann, William d) John Ulanchly, Thomas Kurtz 

7. VisiCalc stands for---- 

 a) Visible Computer b) Quattropro 

 c) Visible Calculator d) Excel 

8. The----- was the first electronic spreadsheet. 

 a) Lotus 1-2-3 b) Quattropro 

 c) Visible calculator d) Excel 

9. An electronic spreadsheet is a worksheet used to ----- and quickly perform ‗what if 

analysis‘ 

 a) manipulate b) delete 

 c) create d) edit 

10. ‗What if‘ analysis is performed by 

 a) Electronic Spreadsheet b) Word 

 c) Visual Basic d) Foxpro 

11. Spreadsheets are made up of--- 

 a) rows b) columns 

 c) cells d) a & b 

12. The intersection of the rows and the columns are----- 

 a) pointer b) address 

 c) cell d) location 

13. Any data like numbers, texts or  formulae can be typed in to a----- 

 a) row b) column 

 c) cell d) page 

14.  Data and formula are entered into the------ 

 a) cells b) worksheet 

 c) spreadsheet d) table 

15. In a spreadsheet, the rows are numbered from 1 upto ----- in the case of StarCalc. 

 a) 30,000 b) 32,000 

 c) 32,500 d) 4,000 

16. Electronic Spreadsheets can be used for presenting the-----data. 

 a) worksheet b) table 

 c) cells d) page 

17. The term Spreadsheet refers to----- 

 a) data sheet b) Software package 

 c) work sheet d) files 

18. The term spreadsheet refers specifically to the---- 

 a) data sheet b) work sheet 

 c) software packages d) files 

19. Worksheet is a -------------------- 

 a) files created with spreadsheet b) StarCalc 

 c) visual forms d) summary 
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20. Worksheet refers to the files that you create with-------------------- 

 a) Packages b) Dbase 

 c) Visual Basic d) Spreadsheet software 

21. The term worksheet refers to the----- 

 a) data sheet b) files created with Spreadsheet 

 c) StarCalc d) visual forms 

22. A data file created using spreadsheet is called---- 

 a) worksheet b) application 

 c) file d) project 

23. Spreadsheet is a-----for working with number 

 a) worksheet b) application  

 c) project d) tool 

24. Which of the following are the common applications of the Spreadsheet 

 a) Pay bills b) Income tax calculations 

 c) Account statements d) All 

25. Which of the following are the advantages of Using Electronic Spreadsheet 

 a) Calculations are automated through the built-in mathematical, financial and statistical 

functions. 

 b) Worksheet can be quit big in size 

 c) Any part of the worksheet can be viewed or edited 

 d) All 

26. ------- of the worksheet can be printed in desired format.  

 a) Any part b) whole 

 c) a or b d) None 

27. Worksheet data can be viewed in the form of---- 

 a) graphs b) charts 

 c) a or b d) None 

28. The first commercial spreadsheet package developed for Microcomputer is---- 

 a) Excel b) VisiCalc 

 c) improve d) quattro pro 

29. VisiCalc contains ---- columns and ---- rows. 

 a) 63,255 b) 64,254 

 c) 63,254 d) 72,256 

30. VisiCalc was essentially a-----program. 

 a) tender evaluation b) cost benefit analysis 

 c) financial analysis d) inventory control 

31. VisiCalc was essentially a---- 

 a) fnancial analysis program b) scientific analysis program 

 c) real analysis program d) result analysis program 

32. Lotus 1-2-3 was introduced by----- 

 a) Micro soft corporation b) lotus development corporation 

 c) Sun micro system d) quattro pro 

33. --------------introduced Lotus 1-2-3 in 1982 

 a) Lotus  b) MS-Excel 

 c) Lotus Development Corporation d) Micro Soft 

34. LOTUS 1-2-3 was invented in the year----- 

 a) 1975 b) 1978  

 c) 1982 d) 1972 

35. ------package is used to combine database management and graphics features with 

    its spreadsheet. 

 a) Lotus 1-2-3 b) Lotus 1-2-2 

 c) Excel d) Spreadsheet 

36. The popular spreadsheet programs from MicroSoft Corporation is----- 

 a) Lotus 1-2-3 b) Excel 

 c) StarCalc d) Dbase 

37. Quattro pro was invented by----- 

 a) Microsoft corporation b) Borland 

 c) Lotus corporation d) Sun Micro system 

38. The spreadsheet program ‗Quattro Pro‘ was introduced by---- 

 a) Microsoft international b) Sun micro systems 

 c) Borland international d) AT XT Corporation 
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39. ‗Improve‘ is a product of------ 

 a) Microsoft corporation b) Borland 

 c) Lotus corporation d) Sun Micro System 

40. The popular spreadsheet program-----is from sun micro system. 

 a) Star Office b) MS-Office 

 c) MS-Excel d) starcalc 

41. StarCalc is  part of----- 

 a) StarWriter b) StarImpress 

 c) StarOffice d) StarBase 

42. StarCalc is a powerful-----program included in StarOffice. 

 a) spreadsheet b) worksheet 

 c) project d) table 

43. Starcalc offers all the function needed for----- 

 a) business use b) financial functions 

 c) statistical functions d) all the above 

44. To work with StarCalc open StarOffice and click on the—-- option on the main menu 

   bar.  

 a) File b) view 

 c) edit d) format 

45. To work with StarCalc open ------- and click on the File option on the main menu bar 

 a) StarOffice b) Office 

 c) MSOffice d) Lotus 1-2-3 

46. New     Spreadsheet command opens------ 

 a) New Document b) New table 

 c) New Worksheet d) new spreadsheet 

47. -------lies at the top of the worksheet window. 

 a) menu bar b) object bar 

 c) formula bar d) status bar 

48. ---- bar is used to display the option in the worksheet window. 

 a) function b) menu 

 c) formula d) status 

49. Function bar and object lies below the ----- in the worksheet window. 

 a) Formula bar b) Status bar 

 c) menu bar d) scroll bar 

50. ------ have short cut icons for frequently done tasks in worksheet window. 

 a) Function bar & Object bar b) Status bar 

 c) menu bar d) scroll bar 

51. The formula appears below the ---- bars.  

 a) function b) object 

 c) function & object d) scroll 

52. Below function bar and object bar lies-------in worksheet window. 

 a) formula bar b) status bar 

 c) tool bar d) scroll bar 

53. ----- bar is used to display the current cell and its contents. 

 a) function b) menu 

 c) formula d) scroll 

54. ------ bar is used to display the current cell and its contents and few more short cut 

 icons. 

 a) function b) menu 

 c) formula d) scroll 

55. Formula bar displays ----- 

 a) column headings of the worksheet b) row heading of the worksheet 

 c) current cell and its contents d) None 

56. In the worksheet window column headings are below the----- 

 a) function                       b) menu      c) formula  d) scroll 

57. ------ is on the left side of the column headings in worksheet window 

 a) toolbox b) row 

 c) column d) main toolbar 

58. ------ are next to the main toolbar in the worksheet window. 

 a) toolbox b) row headings 

 c) column headings d) toolbar 
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59. The ----- is in the middle of the worksheet window. 

 a) cells b) table 

 c) data area d) worksheet 

60. At the extreme bottom of the worksheet window, there are ----- number of bars. 

 a)1 b) 2 

 c) 3 d) 4 

61. At the extreme bottom of the worksheet window are----- 

 a) status bar & scroll bar b) footer bar 

 c) object bar d) function bar 

62. Each cell is identified by a----- 

 a) pointer b) row address 

 c) cell address d) location address 

63. The cell pointer is----- 

 a) mouse pointer b) rectangular box 

 c) yellow triangle d) insertion pointer 

64. The cell which is covered by cell pointer is---- 

 a) mouse pointer b) active cell 

 c) cell d) None 

65. The item used to identify the active cell in StarCalc is ----- 

 a) cell pointer b) active pointer 

 c) cell d) Column 

66. Whenever you open the worksheet the cell pointer is always in cell---- 

 a) B1 b) C1 

 c) D1 d) A1 

67. The first cell is referred to as---- 

 a) 1A b)1 

 c) A d) A1 

68. The position of the cell pointer can be changed by---- 

 a) clicking the mouse on the concerned cell 

 b) using arrows keys on the keyboard 

 c) both a & b d) None 

69. ----- keys on the keyboard allows you to move around the worksheet 

 a) Tab b) Home End 

 c) PgUp & Pg Down d) all the above 

70.  If the data entered in worksheet is a number the program recognizes it as a---- 

 a) text b) number 

 c) label d) integer 

71. If the data entered in worksheet is a text or word the program recognises it as a---- 

 a) text b) number 

 c) label d) integer 

72 Non numerical entries in a table are called------ 

 a) word b) letter 

 c) label d) None 

73. StarCalc allows one to enter dates and time in----- 

 a) spreadsheet b) cells 

 c) rows and columns d) worksheet 

74. The format for entering date is----- 

 a) DD/MM/YY b) MM/DD/YY 

 c) YY/DD/MM d) YY/MM/DD 

75. The format for entering time is ----- 

 a) SS:MM:HH b) MM:SS:HH 

 c) HH:MM:SS d) MM:HH:SS 

76. ------ command is used to save the worksheet. 

 a) File        save b) File       Save as 

 c) a or b d) None 

77. The worksheet is saved by clicking------icon. 

 a) Save b) File 

 c) Store d) None 

78. ------keyboard shortcut is used to save the worksheet. 

 a) Ctrl + S b) Ctrl + Q 

 c) Ctrl + O d) Ctrl + P 
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79. ----- command is used to close the worksheet. 

 a) File      save b) File         Save as 

 c) File     Close d) None 

80. ----- command is used to open an existing worksheet 

 a) File      Open b) File      Open File 

 c) File Open d) None 

81. -------icon is used to open an existing worksheet. 

 a) File Open b) Open File 

 c) Open d) all the above 

82. -----keyboard shortcut is used to open an existing File. 

 a) Ctrl + S b) Ctrl + Q 

 c) Ctrl + O d) Ctrl + P 

83. To quit from StarOffice------ option under File menu can be used. 

 a) End b) Save 

 c) Close d) Exit 

84. -----command is used to quit from StarOffice. 

 a) File       File Close b) File     Exit 

 c) File      Close d) None 

85. ------keyboard shortcut is used to quit from StarOffice. 

 a) Ctrl + S b) Ctrl + Q 

 c) Ctrl + O d) Ctrl + P 

86. If the cell data is not completely displayed, StarCalc indicates this with---- 

 a) red underline b) green asterisks 

 c) small red triangles d) small red circles 

87. In order to edit, data in a worksheet,-------key is used 

 a) F4 b) F2 

 c) F1 d) F7 

88. While editing the data in a worksheet,------appear on the formula bar. 

 a) a vertical cursor b) a horizontal cursor 

 c) mouse pointer d) I beam 

89. The syntax of formula begins with------sign 

 a) a plus b) a slash 

 c) a caret d) an equal 

90. ^ (Caret) is ----- operator is spreadsheet. 

 a) Arithmetic b) Reference 

 c) Text d) Comparative 

91. ----- operator is used for exponentiation process. 

 a) @ b) & 

 c) $ d) ^ 

92. ------ operator is used for negation process 

 a) + b) 
2
 

 c) * d) ^ 

93. -----operator return either true or false. 

 a) Arithmetic  b) Reference 

 c) Text d) Comparative 

94. =A1 > B1 are the example of -----operators. 

 a) Arithmetic b) Reference 

 c) Text d) Comparative 

95. =A1>B1 is an example of-----opeartor? 

 a) arithmetic b) comparative 

 c) text d) None 

96. ----- is not a comparative operator. 

 a) ^= b) < > 

 c) <= d) >= 

97. The-----operator combines two texts as one single text 

 a) = b) + 

 c) / d) & (and) 

98. Which of the following is a text operator? 

 a) = b) + 

 c) / d) & (and) 
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99. -------operator is said to ―AND‖ operator. 

 a) @ b) $ 

 c) & d) ! 

100.  ----- and ---  operators are called reference operators. 

 a) : ! b) :, + 

 c) ! , = d) /, = 

101. When the arithmetic operators are used in formula, the opeators that combines 

 cell areas are  

 a) ;, ! b) ;, +  

 c) !, = d) /, = 

102. -----operators combine cell areas. 

 a) Arithmetic b) Reference 

 c) Text d) Comparative 

103. StarCalc performs first ------- in Mathematics (arithmetic expressions) 

 a) exponentiation  b) negation 

 c) multiplication and division d) addition and subtraction 

104. The automatic fill feature is used to---- 

 a) copy the cell contents b) create a series 

 c) a & b d) fill with default values 

105. -------feature is used to copy the cell contents or create a series. 

 a) Automatic fill b) Copy 

 c) Paste d) None 

106. To enter the same formula or data in various cells we can use-----feature of StarCalc 

 a) Copy & Paste icon b) Automatic Fill 

 c) Fill series d) fill 

107. To copy the contents of a cell, after highlighting the cell the user selects----- 

 a) Edit   Fill    Down b) Edit    Fill   Left 

 c) Edit   Fill    Right d) a or b 

108. A continuous group of cells in a worksheet is called------ 

 a) range b) group 

 c) set of cells d) set of rows 

109. A range is referred to by the----- 

 a) variable name b) cell address 

 c) range address d) worksheet address 

110. A range address is the address of the first cell in the range, followed by a---- 

 followed by the address of  last cell in the range. 

 a) : b) ! 

 c) ; d) , 

111. Cell  A3 B3 C3 D3 E3 and  F3 can be called----- 

 a) A3 : F3 b) A3 – F3 

 c) A3/F3 d) A3 = F3 

112. Cell C4 C5 C6 D4 D5 D6 can be referred to called---- 

 a) C4:D6 b) C4:D4 

 c) D6 : C4 d) C6 : D6 

113. ------command is used to generate a series of data directly from the value of the selected 

cells. 

 a) Fill b) Range Fill 

 c) Auto Fill d) Row Fill 

114. ------command is used to generate a series. 

 a) Edit     Fill      Down b) Edit      Fill   Up 

 c) Edit     Fill      Series d) Edit     Fill 

115. ----- dialog box is used for creating a series. 

 a) Fill b) Fill Command 

 c) Fill series d) Fill Down 

116 There are---- types of cell addressing. 

 a) 2                               b) 3 c) 4  d) 5 

117. Which of the folowing are the types of cell addressing used in StarCalc. 

 a) Absolute cell addressing b) Relative cell addressing 

 c) Data cell addressing d) a & b 

118. The default type of cell addressing in StarCalc is---- 

 a) Absolute cell addressing b) Relative cell addressing 

 c) Data cell addressing d) Function cell addressing 
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119. In StarCalc,--------cell addressing is the default type of cell addressing. 

 a) relative b) absolute  

 c) pointer d) cell 

120. Formulae in StarCalc, are automatically recalculated on account of—cell addressing 

 a) pointer b) absolute 

 c) automatic d) relative 

121. A cell address can be made absolute by using the------sign in front of row and column 

names. 

 a) $ b) # 

 c) * d) & 

122. Which cell address does not change when copied 

 a) pointer b) absolute 

 c) automatic d) relative 

123. StarCalc has a wide variety of---- 

 a) Formulae b) Options 

 c) Buttons d) Functions 

124. ------- are predefined formulae that are available in StarCalc. 

 a) formulae b) options 

 c) buttons d) Functions 

125. The functions in StarCalc are available in---- 

 a) Function dialog box b) Category box 

 c) Function wizard dialog box d) Function box 

126. The functions are available in StarCalc in the pull-down menu of 

 a) function wizard window b) function auto format window 

 c) function auto current window d) function auto pilot query window 

127. To select function go to----- 

 a) file menu b) insert menu 

 c) edit menu d) categories pull-down menu 

128. When Function option is clicked in the Insert Menu------ appears. 

 a) Function dialog box b) Category box 

 c) Function Autopilot dialog box d) Function box 

129. In Function Autopilot dialog box list of functions are displayed in--- 

 a) Function dialog box b) Category box 

 c) Function Autopilot dialog box d) Function box 

130     In Function Autopilot dialog box list of categories are displayed in 

 a) Function dialog box b) Category box 

 c) Function Autopilot dialog box d) Function box 

131. The categories are listed in---- 

 a) file menu b) insert menu 

 c) edit menu d) categories pull-down menu 

132. A list of all functions are displayed in the function box when----is selected in the 

   category box. 

 a) All function b) All 

 c) total d) list all 

133. The ------short cut icon of the formula bar can be used to select and insert functions. 

 a) Fill Series b) Category 

 c) Functional wizard d) None 

134. ------ function is used to find the square root of the given number. 

 a) SQR b) SQRT  

 c) SQRROOT d) None 

135. The function that displays the sum of the given set of numbers is---- 

 a) SUM b) TOTAL 

 c) RESULT d) None 

136. ------icon calculates the sum of a given set of numbers. 

 a) sigma b)  

 c) Avg d) Sum 

137. To insert a function in the worksheet------ 

 a) click insert key b) click shift key 

 c) click enter key d) double click on function 

138. StarCalc suggests a----- of cell for which sum is to be calculated. 

 a) range b) group 

 c) record d) field 
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139. ----- key is pressed to accept the suggested range. 

 a) Backspace b) Shift 

 c) Enter d) CTRL 

140. In StarCalc the difference between two dates is displayed in number of 

 a) Years b) Months  

 c) weeks d) days 

141. To select a complete row click on---- 

 a) the first cell of the row b) row number 

 c) column name d) last cell of the row 

142. To select a complete column click on---- 

 a) the first cell of the row b) row number 

 c) column name d) last cell of the row 

143. To select more than one row or column (group of cells)----- 

 a) click on the first cell b) click on the first cell and drag till the last 

 c) click on the first & last cell d) click on the last cell 

144. ----icon is used to display the contents of highlighted cells in Bold. 

 a) Bold b) Italic 

 c) Underline d) None 

145. ------icon is used to display the contents of highlighted cells in Italic. 

 a) Bold b) Italic 

 c) Underline d) None 

146. ------icon is used to display the contents of highlighted cells in Underline. 

 a) Bold b) Italic 

 c) Underline d) None 

147. -----icon displays list of fonts that can be used 

 a) Change Font b) Font 

 c) Font Colour d) None 

148. ------ is the default font in StarCalc 

 a) Times New Roman b) Arial  

 c) Fajita d) None 

149. ------icon is used to change the font size 

 a) Font size b) font 

 c) Font colour d) size 

150. ----- is the default font size in StarCalc. 

 a) 10 b) 12 

 c) 13 d) 15 

151. ----icon is used to change the font colour. 

 a) Font Size b) Font 

 c) Font Colour d) size 

152. -----icon is used for left alignment process in Spreadsheet. 

 a) Align Left b) Align Horizontal Centre 

 c) Align Right d) Justify 

153. -----icons is used for centre alignment process in Spreadsheet 

 a) Align Left b) Align Horizontal centre 

 c) Align Right d) Justify 

154. -----icon is used for right alignment process in Spreadsheet. 

 a) Align Left b) Align Horizontal Centre 

 c) Align Right d) Justify 

155. ----icon is used for justification process in Spreadsheet. 

 a) Align Left b) Align Horizontal Centre 

 c) Align Right d) Justify 

156. ----icon is used to display the contents of the selected cells in the currency format, that is 

with a $ in front and with two decimal digits. 

 a) Number Format : Dollar b) Number Format : Currency 

 c) Number Format : Percent d) $ 

157. ---- icon is used to display the content of the selected cells in percentage format that is 

 multiplies the contents of the ------and displays the result with 2 decimals. 

 a) Number Format : Percent b) Number Format : Currency 

 c) Number Format : Pound d) Number Format : Standard 

158. -------icon is used to display the contents of the selected cell in default format 

 a) Number Format : Percent b) Number Format : Currency 

 c) Number Format : Pound d) Number Format : Standard 
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159. ------ icon is used to increase the number of decimal digits that are to be displayed in the 

selected cells. 

 a) Number Format : Add Decimal b) Number Format : Delete Decimal 

 c) Number Format : Pound d) Number Format : Standard 

160. ------- icon is used to decrease the number of decimal digits that are to be displayed 

 in the selected cells. 

 a) Number Format : Add Decimal b) Number Format : Delete Decimal 

 c) Number Format : Pound d) Number Format : Standard 

161. Which of the following icons is used to increase or decrease the number of decimal digits 

that are to be displayed the selected cells? 

 a) Number Format : Add Decimal  b) Number Format : Delete Decimal 

 c) Number Format : Pound d) both a & b 

162. -----menu is used to format cells. 

 a) File b) Format 

 c) Function d) Edit 

163. ------command is used to format cells.  

 a) Format    Cells b) Format     Rows 

 c) Format     Column d) Format     Worksheet 

164. Selecting the command Format     Cells opens the ------dialog box. 

 a) Auto Format dialog box b) Format Caracter 

 c) Format cells d) Fill series 

165. ------- at the top of Format cells dialog box can be used to choose the type of cell attribute 

 a) Tabs b) options 

 c) buttons d) menus 

166. ----- tab in the Format cells dialog box is used to change the format of numbers. 

 a) Data b) Text 

 c) Document d) Numbers 

167. ------ tab in the Format cells dialog box is used to change the alignment of data in cells. 

 a) Font b) Alignment 

 c) Document d) Numbers 

168. Which facility of StarCalc helps to format the worksheet with different predefined  

 styles and colours? 

 a) Autoformat sheet b) Auto correct 

 c) Format d) Auto Styles / Auto colors 

169. The ----- facility of StarCalc helps to format the worksheet with different predefined 

styles and colours. 

 a) Automatic fill b) Autoformat sheet 

 c) Function d) Autopilot window 

170. Autoformat option is available on the----- menu. 

 a) File b) Edit 

 c) Format d) Style 

171 ------command is used for achieve auto format sheet. 

 a) Format   Auto Format b) Format    Auto style 

 c) Edit    Auto Format d) None 

172. On clicking Autoformat option ---------dialog box appears. 

 a) Autoformat b) Format 

 c) Auto correct d) Auto style 

173. --------dialog box is used for formatting cells. 

 a) Autoformat b) Format 

 c) Auto correct  d) Format cells 

174. StarCalc provides you with formatting options for formatting------ 

 a) text b) document 

 c) numbers d) application 

175. Column width and row height can be changed using-----menu. 

 a) Format          b) Edit               c) Tools d) File 

176. -------command is used to change the column width of the cell. 

 a) Format    Change width b) Format    Column     Width 

 c) Format    Width   Column d) None 

177. The default column width of a cell is------ 

 a) 0.89‖ b) 0.90‖ 

 c) 1.00‖ d) None 
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178. ------command is used to change the row height of the cell. 

 a) Format     Change height b) Format     Row    Height 

 c) Format     Row      Width d) None 

179. The default row height of a cell is ---- 

 a) 0.20 ― b) 0.19‖ 

 c) 0.18‖ d) None 

180. To insert cells click on------icon. 

 a) Insert picture b) Insert Row 

 c) Insert Column d) Insert Cells 

181. On clicking Insert cells icon, a floating toolbar with------icons appears. 

 a) 4 b) 2 

 c) 3 d) 6 

182. Clicking insert cell from View   Toolbar displays a floating tool bar with-----icons. 

 a) 4 b) 2 

 c) 3 d) 6 

183. Which icon is to be clicked to insert an empty cell in a column and move the existing 

 cells down? 

 a) Insert cells Right b) Insert Cells Left 

 c) Insert Cells Down d) Insert Columns 

184. Which icon is to be clicked to shift the content of a cell to the right and create an empty 

cell? 

 a) Insert cells Right b) Insert cells Left 

 c) Insert Cells Down  d) Insert Columns 

185. Which icon is used to insert an empty row in a worksheet? 

 a) Insert Rows b) Insert Row 

 c) Row Insert d) Insert Columns 

186. Which icon is used to insert a Column in a worksheet? 

 a) Insert Rows b) Insert coloumn 

 c) Column Insert d) Insert Columns 

187. --------dialog box is used to delete the cells, row or a column. 

 a) Delete Rows b) Delete Cells 

 c) Delete contents d) Delete columns 

188. To delete the contents of selected cell(s) select------ 

 a) Delete rows b) Delete cell 

 c) Delete contents d) Delete columns 

189. -------is selected from the checkbox to delete the contents. 

 a) Delete all b) Notes 

 c) Formats d) Objects 

190. ------ is selected to delete the selected cells 

 a) Delete all b) Delete cells 

 c) Formats d) Objects 

191. ----command is used to insert a picture. 

 a) Show    Picture b) View   Picture 

 c) View    Picture    From file d) none 

192. ------icon is clicked to insert a picture. 

 a) Insert Photo b) Insert diagram 

 c) Insert picture d) all the above 

193. The file containing picture can also be inserted from the----- 

 a) Gallary directory b) main directory 

 c) root directory d) sub director 

194. -----icon is clicked to insert special characters? 

 a) Characters b) Special Characters 

 c) Insert Special Characters d) String 

195. ------command is used to insert special characters. 

 a) Insert      Special characters b) Insert   Special character 

 c) Insert      character d) none 

196. Which of the following icons are available in Insert icon Floating Tool bar 

 a) Insert pictures b) Special characters 

 c) Insert Special Characters d) a & c 

 

 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

197. ------icon in the standard provides the facility for drawing lines, circles ellipse, square 

 rectangle, etc. 

 a) Insert picture icon b) Show Draw Function 

 c) Draw icon d) Show Draw Functions 

198. -----appears when the Show Draw Function icon is clicked.  

 a) Insert picture icon b) Draw Function 

 c) Draw Function Tool bar d) Show Draw Function icon 

199. ------icon is used to insert objects like charts, images, formula etc in a worksheet 

 a) Insert picture icon b) Draw Function 

 c) Draw Function Toolbar d) Insert Object 

200. -------command is used insert objects like charts, images , formula etc in a worksheet. 

 a) View    Tool bar      Insert Object    b) Insert   Object 

 c) Show   Toolbar        Insert Object d) none 

201. When you click Insert Object icon, a floating tool bar appears with----- icons. 

 a) 4 b) 6 

 c) 7 d) None 

202. -------icon is used to present the data in the worksheet in the form of charts of different 

kinds such as Bar chart, pic cl Lines, X-Y plot etc. 

 a) Insert chart Icon b) Insert Formula Icon 

 c) Insert OLE Object Icon d) Insert from Image Editor Icon 

203. Electronic spreadsheets can display----- 

 a) only barcharts b) only pie chart   

 c) only line graphs d) all the above 

204. -----icon is used for inserting a formula in the work sheet for performing calculations. 

 a) Insert Floating Frame Icon b) Insert Formula Icon 

 c) Insert OLE Object  Icon d) Insert from Image Editor Icon 

205. ------icon provides to generate a scrolling screen within a worksheet. 

 a) Insert Floating Frame Icon b) Insert Formula Icon 

 c) Insert OLE Object Icon d) Insert from Image Editor Icon 

206. ------icon is used to import objects from other application into a worksheet 

 a) Insert Floating Frame Icon b) Insert Plug-in Icon 

 c) Insert OLE Object Icon d) Insert from Image Editor Icon 

207. -------icon is used to insert sound or video files into the current worksheet 

 a) Insert sound or Movie Icon b) Insert Movie and sound Icon 

 c) Insert sound Icon d) Insert Movie or Sound Icon 

208. -----icon is used to import applets into a worksheet. 

 a) Insert OLE object Icon b) Insert chart Icon 

 c) Insert Plut-in Icon d) Insert Applet Icon 

209. StarCalc generates charts on the basis of ---- 

 a) numeric data b) text 

 c) document d) application 

210. ------- command is used to create a chart. 

 a) Insert    Chart     b) Create    Chart 

 c) Chart d) None 

211. To create chart---------icon is clicked. 

 a) Show Draw Function b) Insert picture 

 c) Insert Chart d) Insert Special Characters 

212. After clicking Insert Chart, the cursor becomes------ 

 a) circle                           b) cross  c) asterisk d) +sign 

213. In a spreadsheet a list of sheets appears as tabs-------of the window. 

 a) at the top b) at the bottom 

 c) at left d) at right 

214. StarCalc contains tripple sheets in every worksheet in the names----- 

 a) Sheet1, Sheet2, Sheet3 b) SHEET1, SHEET2,SHEET3 

 c) sh1, sh2,sh3 d) sheet1, sheet2, sheet3 

215. To select a different sheet--------the tab with the sheet‘s name. 

 a) click b)Double click 

 c) Move d) None 

216. After selecting the tab of a particular sheet it appears in---- 

 a) grey b) black 

 c) white d) blue 
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217. The formula = SUM (Sheet1:A1 ; Sheet1:A2) is known as 

 a) 3D formula b) 2D formula 

 c) 4D formula d) spreadsheet formula 

218. To separate the cells of same sheet in a formula ------is used. 

 a) semicolon b) colon 

 c) comma d) hyphen 

219. To separate two different sheet in a formula------- is used. 

 a) semicolon b) colon 

 c) comma d) hyphen 

220. -------icon is used to print all the data in all the sheets of the document. 

 a) Format b) Edit 

 c) File d) Print 

221. To print a part of worksheet select the range to be printed by using-----command. 

 a) Format   PrintRanges   Edit b) Format   PrintRanges    Set 

 c) Format   Print Ranges   Add d) Format   Print Ranges   Edit 

222. To remove print range setting select----- 

 a) Format    PrintRange    Remove b)print option under file menu 

 c) Format     Print Range   Delete d) Format   PrintRanges   Set 

223. Which option under the file menu is used to print the worksheet? 

 a) Print worksheet b) Print 

 c) Print file d) All the above 

224. ------ command is used to print the work sheet. 

 a) File   Print b) File   PrintRange 

 c) Format    PrintRange   Delete d) Format      PrintRange    Set 

225. When the Print Icon is clicked-----will appear. 

 a) Print dialog box b) Print Box 

 c) Dialog Box d) None 

226. In Print dialog box, under Print range, choose the option-------to print all the sheets of the 

document 

  a) All b) Pages  

  c) Selection d) None 

227. In Print dialog box, under Print range, choose the option-----to specify the pages which 

 are to printed 

 a) All b) Pages 

 c) Selection d) None 

228. In Print dialog box, under Print range, choose the option-------allows to print only the 

selected area in the worksheet. 

 a) All b) Pages 

 c) Selection d) None 

229. Which of the File option is used to view a worksheet before printing 

 a) Print preview b) Print View 

 c) Page View d) View 

230. Printing, using Print icon or Print dialog box prints the worksheets without---- 

 a) row b) columns 

 c) grids d) lines 

231. ------option from the Format menu prints the worksheet with the grid lines. 

 a) Page b) columns 

 c) grids d) lines 

232. The Page option for printing is selected from--------menu. 

 a) Format b) Edit 

 c) File d) Tools 

233. -----dialog box is used to prints the worksheet with the grid lines. 

 a) Page Style b) Paragraph 

 c) Character d) Formatting 

234. ------ tab in the page style dialog box is used to prints the worksheet with the grid lines. 

 a) Page b) Sheet 

 c) Grid d) None 

235. In the Page style dialog box-------check box is selected for printing the data with grids 

 a) Page b) Sheet 

 c) Grid d) None 
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236. To view data in the form of charts, use----- 

 a) StarWriter b) Spread sheet 

 c) Table d) Starbase 

237. The first electronic spreadsheet was------------------ 

 a) Starcalc b) Visicalc 

 c) Lotus 1-2-3 d)Excel 

238. The command used to generate a series of data is------ 

 a) Edit Series b) Fill series 

 c) Insert Series d) Edit Fill Series 

239. To display the current cell and its content in Starcalc it is used------ 

 a) Status bar b) Tool bar 

 c) Formula bar d) Menu bar 

240. A continuous group of cells in a Worksheet is called----- 

 a) Range  b) Sequence 

 c) Unit d) Address 

241 In Starcalc spreadsheet rows are numbered from 

 a) 1 to 30000 b) 1 to 32000 

 c) 1 to 3300 d) 1 to 34000 

242. In worksheet dates are entered in the order of 

 a) DD/MM/YY b) YY/DD/MM 

 c) MM/DD/YY d) YY/MM/DD 

243. To format the data in a cell, click----- 

 a) Edit  cell b) Tools  Cell 

 c) Format  Cells d) Insert  Cells 

244. In Starcalc, every formula should begin with---------- 

 a) ! b) + 

 c) = d) > 

245. The command used to print the selected range in Spreadsheet is---- 

 a) Format Print Range Delete b) Format Print Range Set 

 c) Format Print Range Page d) Format Print Range Print 

246. Starcalc, Excel, and Lotus 1-2-3 are------ 

 a) Spreadsheets b) Word processors 

 c) Database d) Computer Languages 

247. The function used to find the square root in Starcalc is----- 

 a) SQR b) SQRT 

 c) SQT d) SQUARE 

248. The text operator in Starcalc is----- 

 a) $ b) * 

 c) ! d) & 

249. Starcalc was introduced by----- 

 a) Lotus Corporation b) Microsoft Corporation 

 c) Sun Microsystems d) IBM 

250. The term that has come to refer specifically to the software packages, while worksheet 

refers to the files that you create that you create with software, is---- 

 a) Worksheet b) Balance sheet 

 c) Spreadsheet d) None of these 

251. In Starcalc which cell address can be made absolute by using the $ (dollar) sign in front 

of row and column names? 

 a) Relative cell addressing b) Cell referencing 

 c) Absolute cell addressing d) Cell addressing 

252. Which icon is used for inserting a formula in the worksheet for performing calculation? 

 a) Insert OLE object         b) Insert Chart c) Insert Formulae d) Insert Applet 

253. Which one of the following is a Spreadsheet? 

 a) Starbase b) StarCalc  

 c) StarOffice d) StarWriter 

254. The spreadsheet developed by Lotus Development Corporation is---- 

 a) Excel b) Starcalc 

 c) Visicalc d) Improve 

255. Which reference operator is used to set the range in a spreadsheet? 

 a) ; b)   

 c) : d) ! 
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256. The command used to generate series in a spreadsheet is---- 

 a) Fill range b) Fill Series 

 c) Range d) Automatic 

257. The icon used to import data from different File/URL into a worksheet is 

 a) Insert from Image Editor b) Insert Plug – in 

 c) Insert Applet d) Insert Chart 

258. To move backward through the cells, press 

 a) Tab b) Shift 

 c) Shift+tab d) Esc 

259. Visicalc was invented by----- 

 a) Sun Microsystems  b) DanBricklin and BobFrankson 

 c) Microsoft d) Charles Babbage 

260. The cell A 1 becomes absolute when we enter---- 

 a) $A$I b) $A1 

 c) A$1 d)*A*1 

261. Insert-----icon provides to generate a scrolling screen with in a worksheet. 

 a) floating frame b) OLE object 

 c) Plug-in d) applet 

262. Insert ------icon is used to import objects from applications into a worksheet. 

 a) floating frame  b) OLE object 

 c) Plug-in d) applet 

263. ------was the first commercial spreadsheet pacakage. 

 a) Exel b) Starcalc 

 c) Visicalc d) Improve 

264. Visicalc was developed by Micro Computers in the year----- 

 a) 1979 b) 1978 

 c) 1977 d) 1976 

265. A Range is referred by the--- 

 a) range address b) range point 

 c) range cell d) default 

266. Cell address is made by absolute by using the-----in front of the row and column 

 a) $ b) & 

 c) # d) = 

267. The intersection of row and column is---- 

 a) Cell                              b) Table                 c) Column  d) Row 

268. -------identifies the active cell. 

 a) Cell pointer b) Mouse pointer 

 c) Cell d) Box 

269. Excel spreadsheet was developed by---- 

 a) Micro computers  b) IBM 

 c) Microsoft Corporation d) Lotus Corporation 

270. Improve spreadsheet was developed by----- 

 a) Micro computers b) IBM 

 c) Microsoft Corporation d) Lotus corporation 

271. Starcalc spreadsheet was developed by---- 

 a) Micro computers b) Sun Microsystems 

 c) Microsoft Corporation d) Lotus corporation 

272. Lotus 1-2-3 spreadsheet was developed by---- 

 a) Micro computers b) IBM 

 c) Microsoft Corporation d) Lotus Corporation 

273. The number of rows in Starcalc is---- 

 a) 24000                        b) 256 c) 32000 d) 12000 

274. Starcalc allows you to store time in the worksheet in the form of ------- 

 a)HH:MM:SS b) MM:SS:HH 

 c) SS:MM:HH d) MM:HH:SS 

275. Cells A1 A2 A3 A4 B1 B2 B3 B4  can be referred as---- 

 a) A1 : B4 b) A 4 : B4 

 c) B4:A1 d) B1:A4 

276. Which Icon is used to present the data in the worksheet in the form of a chart? 

 a) Insert chart b) Insert figure 

 c) Insert picture d) Insert Objective 
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277. -----function calculates the sum of a given set of numbers. 

 a) Total b) Sum 

 c) Find d) Add 

278. To close the worksheet, go to File menu and select the----- 

 a) Close b) Save 

 c) Exit d) Quit 

279. ------cell addresses do not change when copied. 

 a) Absolute b) Relative 

 c) Successive d) None of these 

280. Spreadsheet has come to refer specifically to the------package. 

 a) worksheet b) file 

 c) software d) hardware 

281. Worksheet refers to the ----- 

 a) work area b) file  

 c) software d) hardware 

282. A range is referred by the---- 

 a) range address b) Cell address 

 c) Sheet address d) None of these 

283. -------is an example of spreadsheet program. 

 a) Lotus 1-2-3 b) Star Writer 

 c) MS-Word d) None of these 

284. We can use -----to calculate and analyze sets of numbers. 

 a) Text Document b) Spreadsheet 

 c) Database d) Presentation 

285. Graphic representations of numbers are known as----- 

 a) Pictures b) Charts 

 c) Audio files d) Video files 

286. A------refers to the file you create with spreadsheet software. 

 a) Worksheet b) Chart 

 c) Table d) Picture 

287. Non-numeric entries are called as--- 

 a) Data b) labels 

 c) Charts d) Pictures 

288. The-----is the sequence of characters used in a formula. 

 a) Range address b) Cell address 

 c) Sheet address d) None of  these 

289. We can automatically perform specialized calculations using---- 

 a) calculator b) functions 

 c) tables d) None of these 

290. The command used to generate a fill series is---- 

 a) edit  fill  series b) format fill series 

 c) file fill series d) view fill series 

291. The combined cell column and row headings are known as the cell‘s---- 

 a) address b) addressing 

 c) pointer d) None of these 

292. -----is used to insert objects from other application into a worksheet. 

 a) Insert Chart b) Insert OLE object 

 c) Insert Picture d) None of these 

293. The-----option on the file menu can be used to preview a worksheet before printing. 

 a) view  b) page view 

 c) sheet view d) None of these 

294. The print option under the-----menu can be used to print the worksheet. 

 a) view                          b) file     c) edit   d) format 

295. In order to print with the grids.  Select the------option from the Format menu. 

 a) print b) page 

 c) preview d) None of these 

296. To remove the print range setting click on---- 

 a) Format Print Range Delete b) File Print Range Delete 

 c) File Delete Print Range d) Format Delete Print Range 

297. The personal computer appeared in----- 

 a) 1975 b) 1977 

 c) 1979 d) 1976 
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298. PC‘s became popular in----- 

 a) 1975 b) 1977 

 c) 1979 d) 1976 

299. Visicalc contains-----rows and ----columns. 

 a) 524, 36 b) 254, 56 

 c) 254,  63 d) 254, 63 

300. The Cell pointer is----- 

 a) Mouse pointer b) Rectangular box 

 c) Yellow triangle d) Insertion pointer 

301. A-----is a tool for working with numbers. 

 a) Text document b) Spreadsheet 

 c) Writer d) None of these 

302. A data file created with spreadsheet is called a---- 

 a) Sheet  b) Worksheet 

 c) Document d) None of these 

303. --------follow the hierarchical order of mathematical operations. 

 a) Cells b) Formulae 

 c) Charts d) Functions 

304. -------are built-in formulae. 

 a) Cells b) Formulae 

 c) Charts d) functions 

305. There are ---- types of cell referencing. 

 a) 1                                 b) 2                       c) 3  d) 4 

306. -----are used to make data easier to understand.  

 a) Documents b) Tables 

 c) Charts d) None of these 

307. Non numerical entries are called as---- 

 a) Numbers  b) Labels 

 c) Names d) Characters 

308. The-----option on the file menu can be used to preview a worksheet. 

 a) page view b) format view 

 c) sheet view d)None of these 

309. The graphic representation of numbers are known as----- 

 a) Documents b) Tables 

 c) Charts d) None of these 

310. -------offers a wide variety of functions. 

 a) StarWriter b) StarCalc 

 c) StarBase d) StarImpress 

311. Visicalc was invented for--------- 

 a) IBM b) Microcomputers 

 c) Microsoft d) Infosys 

312. Each cell in the spreadsheet has a-------calculator. 

 a) Standard  b) Scientific 

 c) Programmable d) None of these 

313. Commercial electronic spreadsheet packages are in use since late----- 

 a) 1960s b)1970s 

 c) 1980s d) 1990s 

314. ------was essentially a financial analysis program. 

 a) StarWriter b) Visicalc 

 c) Wordpro d) Wordstar 

315. The ------- bar is used to display the current cell and its contents. 

 a) Menu             b)Object c) Function d) Formula 

316. The------- bar has shortcut icons for the frequently done tasks. 

 a) Object           b) Menu c) Status d) Scroll 

317. The ------option under the File menu is used to quit StarOffice. 

 a) Close         b) Exit 

 c) Quit d) None of these 

318. The exponentiation operator is---- 

 a) *                                  b) ^                          c) %  d) # 

319. The operator used for percentage is----- 

 a) *                                   b) ^                    c) %  d) # 
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320. The operator used for division is---- 

 a) *                                   b) ^ c) %  d) / 

321. The-----operators combine cell areas. 

 a) Text b) Arithmetic 

 c) Reference d) None of these 

322. The operator combines sections of text to the entire text is----- 

 a) Text b) Arithmetic 

 c) Reference d) None of these 

323. The operator used for Inequality is---- 

 a) <> b) != 

 c) # d) None of these 

324. The operator used for Equality is---- 

 a) <> b) !=   

 c) = d) = = 

325. The highest priority is given to ------ operation in Spreadsheet calculation. 

 a) Negation b) Exponentiation 

 c) Multiplication  d) Addition 

326. -------Automatically generates a data series based on a defined pattern. 

 a) Fill b) Autofill 

 c) Fill series d) None of these 

327. There are ----- text boxes available in the Fill series dialog box. 

 a) 2 b) 3 

 c) 4 d) 5 

328. -------shortcut icon is used to insert function. 

 a) Function autopilot b) Function Wizard 

 c) Function d) None of these 

329. ------shortcut icon is used to insert functions. 

 a) Function autopilot b) Function wizard 

 c) Function d) None of these 

330. ------function is used to find the square root of a number. 

 a) SQT b) SQRT 

 c) ST d) Square roo( ) 

331. ------icon on the formula bar is used find the sum. 

 a) Total                                b) +                     c) Sum  d) Addition 

332. By clicking on the -------icon the current content will be displayed in percentage Format. 

 a) @                                    b) &                  c) $  d) % 

333. Autoformat option is available on the----- menu. 

 a) File b) View 

 c) Format d) Window 

334. To change the selected columns‘ width,-------- Column  Width is chosen. 

 a) File b) View 

 c) Format d) Window 

335. To change the selected rows‘ height,------ Height  Width is chosen. 

 a) File b) View 

 c) Format d) Window 

336. The------- button is clicked to create the Chart in the Autoformat chart dialog box. 

 a) Finish b) Ok 

 c) Create d) None of these 
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DATABASE 

 

I. Choose the Correct Answers :-      

1. Which window enables the user to choose the format for the report? 

 a) Style selection window b) Outline window 

 c) Format style window d) Format report window 

2. To customize the report, the user has to select------ 

 a) format and style for the report b) alignment and style for the report 

 c) sort and alignment for the report d) format and create for the report 

3. Payroll and examination processing fall under the category----- 

 a) data processing b) database management 

 c) packages d) application 

4. Which option accepts a numerical value? 

 a) Type b) Entry required 

 c) Length d) Filter 

5. ……limits the information on the screen. 

 a) Filtering b) Sorting 

 c) Arranging d) Viewing 

6. In general, human beings are liable to make computations and ---- errors. 

 a) instrumental  b) parallax 

 c) random d) None of these 

7. On clicking table format, which of the following is displayed on the screen? 

 a) A dialog box to changed font size, colour and style 

 b) A dialog box to changed width of the table 

 c) A dialog box to changed the height of the table 

 d) A dialog box to changed the colour of the table 

8. Merging is a process of joining-----from two or more tables. 

 a) data b) fields 

 c) record d) None 

9. The two types of data processing are manual data processing and -- - -  

 a) long hand method b) computerized data processing 

 c) manual approach data processing d) character processing 

10. To remove the filter, which of the following is used? 

 a) Icon b) Filter 

 c) Remove filter d) Remove Filter/sort icon 

11. Which of the following buttons when clicked displays the records in the field? 

 a) Display b) Records 

 c) View d) Preview 

12. The explorer pane can be hidden by clicking the option- - -  

 a) Hide  Explorer b) Cancel  Explorer 

 c) View  Explorer d) Erase  Explorer 

13. Which option is used to specify the fields, based on which the records can be grouped  

 together? 

a)Group b)Outline 

 c)Selection d)Style 

14. Currency, text and decimal are---- 

 a)fields types b) data types 

 c) variables d) constants 

15. Records are organized in a tree-like structure in 

 a) object oriented database b) Relational database 

 c) Hierarchical database d) Network database 

16. What is displayed in the lower part of the window? 

 a) length b) Entry required 

 c) Default value d) Type 

17. - - -  operators return either true (or) false 

 a) Arithmetic         b) Reference c) Text  d) Comparative 

18. To create a report, the user has to- - - - 

 a) right click on report in explorer pane b) left click on report in explorer pane 

 c) double click on report in explorer pane d) All the above 
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19. Multiple reports can be created and stored for- - - - 

 a) A table b) A query 

 c) Both (a) and (b) d) file 

20. - - - -  is a process of performing corrections. 

 a) Deleting b) Calculating 

 c) Correcting d) Editing 

21. Auto filter icon is present in- - -  

 a) toolbar b) menu bar 

 c) scroll bar d) title bar 

22. To- - - - a record, the new record is entered at the end of the table. 

 a) create b) append 

 c) open d) sort 

23 The-----can be character, number or Boolean 

 a) numeric data  b) data 

 c) data types d)None of these 

24. The efficiency and correctness of data are limited in--- 

 a) manual data processing  b) computerized data processing 

 c) data processing d) database 

25. Field alignment is a part of --- design. 

 a) form b) query 

 c) report d) table 

26. Based on conceptual structures, database can be classified in to----types 

 a) 3 b) 4 

 c) 5 d) 10 

27.  A - - -  refers to the processing of handling that can be associated to a object. 

 a) procedure b) process 

 c) project d) None of these 

28. In the case of single precision values, the decimal values are accurate upto a length of— 

 a) 5 places b) 7 places 

 c) 4 places d) 8 places 

29. A collection of programs that allows any number of users to access data is- - -  

 a) Database system b) Management system 

 c) Starbase d) Database management system 

30. The---- can be integer, float, double precision, date, time, etc. 

 a) primitive data types b) numeric data types 

 c) user – defined data types d) string data types 

31. Which database, one record type can relate to –- - - -database. 

 a) Network database b) Flat-file 

 c) Object oriented d) Relational 

32. - - -  involves data collection, verification and validation of data and report generation 

 a) data processing b) data type 

 c) data collection d) data manipulation 

33. Hierarchical database structures is primarily used on-- - -  

 a) Super computers b) Main Frame computers 

 c) personal computers d) None 

34. The- - - window lets you to choose a format for report. 

 a) style selection b) format style 

 c) outline d) create 

35. Name the window that is displayed next to the format style window. 

 a) Escape window  b) Create window 

 c) Quit window d) Next window 

36. The works carried out by long hand method is known as- - - -  

 a) computerized data processing b) manual data processing 

 c) only data processing d) on line data processing 

37. On right clicking on the record pointer, the option not present is 

 a) table format b) row height 

 c) delete coloumn d) delete row 

38. - - -  function calculates the sum of a given set of numbers. 

 a) Sigma b) $ 

 c) Avg d) Sum 
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39. Data means- - - - 

 a) Fact b) Information 

 c) Set of variables d) Reference 

40. To save a table use a short cut-key- - - - - 

 a) Ctrl + S b) Ctrl + V 

 c) Ctrl + X d) Ctrl + C 

41. - - -  means sorting of more than one filed of table at the same time. 

 a) Sorting b) Single sorting 

 c) Multiple sorting  d) Indexing 

42. Manipulation of database can be done in- - - -  

 a) 10 ways b) 6 ways 

 c) 8 ways d) 7 ways 

43. The term  data comes from the word- - - -  

 a) Data $ b) Datum  

 c) Deformable d) Data 

44. Each table column represents a- - - - 

 a) Record b) Field 

 c) File d) Row 

45. Filter used with condition is called a- - - - 

 a) Default filter  b) Filter 

 c) Forms d) Query 

46. DBMS provides mean to- - -  

 a) Process data b) Store data 

 c) Delete data d) Share data 

47. Data are of- - - -types in Starofficebase 

 a) 5 b) 3 

 c) 10 d) 20 

48.  - - - is used for database related one. 

 a) Staroffice calc b) staroffice base 

 c) staroffice writer d) staroffice impress 

49. The entire collection of related data in one table is referred to as a- - -  

 a) Field b) Record 

 c) File d) Structure 

50. To edit a record first select the record by clicking on the- - -  

 a) Record button b) Record pointer 

 c) Record key d) None of these 

51. A- - -  is a key that uniquely identifies a record in data base tables. 

 a) Primary key b) Secondary key 

 c) Both (a) and (b) d) None of these 

52. Queries are - - - - statements. 

 a) User constructed b) User – defined 

 c) Predefined d) Structured 

53. A screen which displays the fields of record in a well-spaced out manner is called- --  

 a) Record b) Form 

 c) Filter d) File 

54. - - -  is a repository of collections of related data (or) fields. 

 a) Data b) Database  

 c) Table d) Record 

55. Which of the following is used to arrange records in alphabetical or numerical order? 

 a) sort b) Filter 

 c) Search d) Merge 

56. In StarOfficeBase  to view or to modify the design of an existing table the sign is clicked 

 is--- a) – sign b) + sign  

 c) / sign d)  * sign 

57.  Which command is used to box which is to be selected calc cell range into the text 

 document? 

  a)Edit  Paste b) Edit  Paste special 

 c) View  Paste Special d) Edit Inserts Paste special 

58. In the paste special dialog box which is to be selected to copy the cell range in the 

 text document? 

  a)DEE Link b) Paste 

 c)Copy d)DDE Link 
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59. Which of the following is text that uses one or more of the default heading 

 Paragraph styles? 

 a)inline b) heading line 

 c) outline d) present line 

60. Which command contains the outline in the text document? 

 a) File  Send Outline to presentation b) File new Outline to presentation 

 c) File  Outline to presentation send d)File Outline to presentation new 

61. Which command is used to transfer each heading together with its accompanying 

 paragraphs? 

 a)File new Autoabstract b) File send  Autoabstract 

 c)File Autoabstract new d)File Autoabstract send 

62. Which of the following includes text, numeric and logical? 

 a) Field names b) Field types 

 c) Field properties d) Field length 

63. Which database is best suited for small business users? 

 a)Network database b) Flat-file 

 c)Object oriented d) Relational 

64. Which database is very powerful? 

 a) Network database b) Flat-file 

 c)Object oriented d) Relational 

65. Which of the following is used to create table‘s structure? 

 a) Table or fields b) datasheet view or tables 

 c) Records or fields d) Datasheet view or records 

66. The filer without condition is- - - - 

 a) Standard filter b) Default filer 

 c) filter d) none 

67. Meaningful data is called-- - - -  

 a) data b) datum 

 c) information d) database 

68. The term data comes from the word- - - -  

 a) Data‘s  b) Datum 

 c) Deformation d) Data 

69. Information is known as- - - - 

 a) Collection of data b) Processed data 

 c) Raw data d) Unorganized data 

70. Data‘s are of - - -  types.  

 a) 3 b) 5 

 c) 12 d) 10 

71. Hierarchical database structures is primarily used on 

 a) Super computers b) Main frame computers 

 c) micro computers d) None 

72. Network database is similar to- - -  database 

 a) Hiearchical  b)object oriented 

 c) Flat-file d) Relational 

73. Number of filters allowed in Star Base is- - -  

 a) 5 b) 2 

 c) 4 d) 10 

74. Merging is a process of joining-- - - from two or more tables. 

 a) Data b) Fields 

 c) Record d) None 

75. Flat-file database is useful for- - -  

 a) Single user b) Multi user 

 c) Inventories d) None 

76. An example of a flat-file database is 

 a) Spreadsheet b) Basic 

 c) Cobol d) Foxpro 

77. Payroll and examination processing fall under the category 

 a) Data processing b) Database management 

 c) Packages  d) Application 

78. A set of processed data is- - - - 

 a) Program b) Application  

 c) Information d) Database 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

79. - - - - is highly effective for searching, sorting and merging files. 

 a) Manual data processing b) Computerized data processing 

 c) Data processing d) Database 

80. Each table column represents a- - -  

 a) Record b) Field 

 c) File d) Row 

81. -- - - - is a process to select a specific data 

 a) Sorting b) Filtering 

 c) Searching d) Merging 

82. -- - - limits the information on the screen 

 a) Filtering b) Sorting 

 c) Arranging d) Viewing 

83. - - -  is a process of performing corrections.   

 a) Deleting b) Calculating 

 c) Correcting d) Editing 

84. A flat-file database consists of- - -  

 a) One table b) Two tables 

 c) No tables d) Several tables 

85. Hiearchical databases are based on- - - - 

 a) Organized fields b) Parent-child relationship 

 c) One record type to several record types d) Hierarchy 

86. DBMS stands for - - - -  

 a) Database management system b) Database manipulation 

 c) Database management series d) Data type base making systems 

87. Star Base is an integral part of- - -  

 a)Star Office b) Star Writer 

 c) MS office d) DBMS 

88. The column in a form design that can be left blanks is- - - - 

 a) Field properties  b)field name 

 c) Field type d) Description 

89. Currency, text and deciamal are- - -  

 a) Field types b)Data types 

 c) Variables d) Constants 

90. CTRL+S in a database does- - -  

 a) Save b) Open  

 c) Delete d) Cut 

91. SQL stands for- - - - 

 a) Structured question language b) Standard query link 

 c) Standard query language d) Structured query language 

92. Default filter window is similar to- - - design. 

 a) Form b) Query condition 

 c) Report d) Condition 

93. A- - -  is a screen of fields in a well-spaced manner. 

 a) Report b) Query 

 c) Table d) Form 

94. Field alignment is a part of- - - - design. 

 a) Form b) Query 

 c) Report d) Table 

95. A report is a- - - -  

 a) printed information b) Screen of data 

 c) Sorted arrangement of information d) query 

96. A database is a- - - -  of collections of related facts. 

 a) Group b) Repository 

 c) Storehouse d) Related set 

97. Queries are- - - - statements. 

 a) User constructed b) User-defined 

 c) Predefined d) Structural 

98. Manipulation of database can be done in- - -  

 a) 10 ways b) 6 ways 

 c) 8 ways d) 7 ways 
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99. The ------ can be character, number or Boolean. 

 a) Numeric data b) Data 

 c) Data types d) None of these 

100. The----- can be integer, float, double precision date, time, etc. 

 a) Primitive data types b) Numeric data types 

 c) User-defined data type d) Enumerated data types 

101. The two types of data processing are manual data processing and- --  

 a) Long hand method b)Computerized data processing 

 c) Manual approach data processing d) Character processing 

102. A- - - - is a repository of collection of related data or facts. 

 a) Data type b) Data processing 

 c) Database d) Record 

103. Merging is one way of - - -  

 a) Manipulation of database b) Data processing 

 c) Data type d) Collection of data 

104. - - - - is a process of arranging the data. 

 a) Sorting b) Searching 

 c) Merging d) Reporting 

105. The common field or fields are called the- - - -  

 a) Keys b) Data 

 c) Datum d) None of these 

106. The relationship between- - - -  is said to be a parent-child relationship. 

 a) Data types b) Record types 

 c) Field types d) None of these 

107. Star Base allows you to use- - -  different field types. 

 a) One b) Twenty one 

 c) Thirteen d) Ten 

108. Every table in Star base must have a- - - - 

 a) Primary key b) Secondary key 

 c) Both d) None of these 

109. By clicking on the Delete Rows options, the selected record will be - - -  

 a) Edited b) Changed 

 c) Deleted d) Inserted 

110. ------ means sorting of more than one field of table at the same time. 

 a) Sorting b) Single sorting 

 c) Multiple sorting d) Indexing 

111. Data processing involves- - - -  

 a) Data collection b) Data verification 

 c) Validation of data d) All the above 

112. Browsing a selected list of records is known as - - - -  

 a) Merging b) Filtering 

 c) Sorting d) Searching 

113. A screen which displays the fields of a record in a well-spaced out manner is called--- 

 a) Record b) Form 

 c) Filter d) File 

114. Records are organized in a tree-like structure in---- 

 a) Object oriented database  b) Relational database 

 c) Hierarchical database d) Network database 

115. Which option specifies that the user should enter a value for that field? 

 a) Default value b) Entry required 

 c) Length d) Format 

116. How will you save the table? 

 a) By pressing CTRL + S key b) By clicking the save icon 

 c) Both (a) and (b) d) None of the above 

117. Which one of the following is a type of query? 

 a) Form               b) Filter    c) Table d) File 

118. Which of the following icons are to be clicked to arrange the records in a table in 

 Ascending order? 

a)Ascending icon    b)Descending icon    c) Increasing icon   d)Decreasing icon 

119. Which of the following button when clicked displays the records in the field? 

 a) Display b) Records 

 c)View d) Preview 
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120. Printed information that is assembled by gathering data based on user supplied 

 criteria is- - - - - 

a)Form  b)Query 

c)Table d)Report 

121. Which option is used to specify the fields, based on which the records can be grouped 

  together? 

  a)Group b)outline 

 c)Selection d)Style 

122. Which window enables the user to choose the format for the report? 

 a)Style selection window b)Outline window 

 c)Format style window d)Format report window 

123. Multiple reports can be created and stored for 

 a)a table b) a query 

 c)Both (a) and (b) d)file 

124. Star officer window is divided into how many panes? 

 a)2 b) 3 

 c) 4 d) 5 

125. Filter used with a condition is called a----- 

 a)Default filter b) Filter 

 c) Forms d) Query 

126. Which database has limitation over database consisting of multiple tables? 

 a)Relational database b) Network database 

 c) Flat-file database d) Hierarchical database 

127. Which of the following refers to the processing or handling that can be associated 

 to the object? 

  a)Procedure  b)Process 

 c) Project d) Prograss 

128. To---- - a record, the new record is entered at the end on the table. 

 a) Create b) Append 

 c) Open d) Sort 

129.  A---- can be used to view, add, delete or edit the records in the table. 

 a) Form b) File 

 c) Field d) Queries 

130. Which of the following is clicked to create new database? 

 a)View a Database  b) File a New a Database 

 c)Create a New a Database d) New a Database 

131. The term data is derived form the word----- 

 a)fact b) datum 

 c)entities d) value 

132. Each table column represents a----- 

 a) File b) Record 

 c) Cell d) Field 

133. The process of joining data from two or more tables of the same or different database 

 is called---- 

 a)Merging b) Sorting 

 c) Searching d) Filtering 

134. How many types of data are there in StarOffice? 

 a)6 b) 5 

 c)3 d) 2 

135.  A screen of fileds in a well spaced manner is called---- 

 a)report b) query 

 c)table d) form 

136. The process of limiting the information that appears on the screen is--- 

 a)Sorting b) Filtering 

 c)Searching d)Merging 

137. The process of performing corrections on the existing data is---- 

 a)Editing b) Filtering 

 c)Sorting d) Merging 

138. To uniquely identify a record in database, the key used is--- 

 a)secondary key b) third level key 

 c)primary key d) key 
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139. The database in which record are organized in a tree like structure by type is--- 

 a) Relational database  b) Object Oriented database 

 c)Network database d) Hierarchical database 

140. RDBMS is an acronym for---- 

 a)Relational Database b)Relational Database Management System 

 c)Relational Database Manipulation system d)Relational Database merging system 

141. The process used to select a desired and specific data from a database is 

 a)merging b) filtering 

 c)sorting d) searching 

142. A column in a StarOffice base table represents a ----- 

 a)file b) structure 

 c)field d) record 

143. Computerized data processing includes 

 a) correction b) changes 

 c) modifications d) all the above 

144. The entire collection of related data in one table is called— 

 a) filed b) file 

 c) record d) structure. 

145. In StarOffice base the entire collection of related data in one table is referred to as 

 a---a)field b) record 

 c)file d) data 

146. After the structure of the table is created, the table can be saved by pressing 

 a) Ctrl +S key b) Ctrl + K key 

 c) Ctrl + M  key d) Ctrl + N key 

147. The option which appears in the sub menu for editing used to delete a record is 

 a) Table Format b) Row Height 

 c) Delete Rows d) Delete 

148. To sort the records in the descending order, select the field and click on the 

 a) Sort Ascending icon b) Sorting icon 

 c) Sort Descending icon d) Sorting Row icon 

149. Sorting on more than one field of a table at the same time is called---- 

 a) Sorting in Ascending order b) Sorting in Descending order 

 c) Merging d) Multiple sorting 

150. To display the records in the original order, click on the--- 

 a) Remove Filter/Sort icon b) Sort icon 

 c) Sort Ascending icon d) Sort Descending icon 

151. SQL is an acronym for---- 

 a) Structured Query Language b) Structured Quick Language 

 c)Structure Quick Launch d) Sorted Query Language 

152.  The AutoPilot Query window appears when a click is made on--- 

 a) New Query Autopilot b) Open  Query 

 c) Query  AutoPilot d) Update  Query 

153. Which of the following is an example for a flat-file database? 

 a) Starbase b) StarOffice 

 c) Spreadsheet d) Foxpro 

154. Sophisticated data types are called----- data types. 

 a) float b) primitive 

 c) built-in d) user-defined 

155. In which process, the efficiency and correctness of data are limited? 

 a) data processing  b) database 

 c) computerized data processing d) manual data processing 

156. ------ is represented by each table column. 

 a) column b) File 

 c) Field d) Record 

157. Which data base contains only one table? 

 a) Hierarchical database b) Relational database 

 c) Flat-file database d) Object Oriented database 

158. -----are grouped by object oriented database. 

 a) Characteristics, color & size b) Characteristics,attributes&procedures 

 c) Characteristics, attributes & quantitye d)Charactreristic,attributes&graphics 
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159. Database management systems----- data. 

 a) store b) process 

 c) share d) delete 

160. StarOffice Base is an integral part of----- 

 a) MS Office b) Star Writer 

 c) Foxpro d) StarOffice 

161. Which appears on the left side of opening screen of StarOffice Base? 

 a)Pane b) Explorer pane 

 c) Database d) Window 

162. Which command is used to display or hide Explorer pane of StarOffice Base? 

 a)Edit  Explorer b) Open  Explorer 

 c)View  Explorer d) File  Explorer 

163 Which of the following is used to create a DataBase? 

 a) Edit  New Database b) File New Database 

 c) View New Database d)File View Database 

164. The window used to specify the fields and the conditions on which the query should be  

 Based is----a) AutoPilot Query Window b)Field Selection Window 

 c) Filtering Window d) Sort Order Window 

165. Filter used with a condition is called _____ 

 a) AutoFilter b) Query 

 c) Default Filter d) StarOffice base Filter 

166. The records matching the value of the current field will be displayed when a click is 

made on the --- 

 a) AutoFilter Icon b)DefaultFilter Icon 

 c) Query Icon d)Filter Icon 

167. A screen that displays the fields of a record in a well-spaced out manner is a 

 a) Table b) Cell 

 c) Filter d) Form 

168. The window used to select a Page Style for the form is 

 a) Field Assignment Window b)Styles Window 

 c) Create form Window d)Table Selection Window 

169. The window which allows one to choose a format for the report is 

 a) Format Style Window b)Create Window 

 c)Style Selection Window d)Sort Options Window 

170. The entire collection of related data in a place is referred to as a---- 

 a) Column b) Row 

 c)Cell d)Table 

171. Each row in a table represents a 

 a) file b) table 

 c) record d) cell 

172. Sorting is a process---- 

 a) of arranging the data b) to select a desired specific data 

 c) of joining data from two or more tables d) of performing corrections 

173. A database file that consists of a single data table is a— 

 a) Network database b) Relational database 

 c)Flat File database d)Object oriented database 

174. Which are displayed on the right pane of window opening screen? 

 a)Forms b) Queries 

 c)Reports d)All the above 

175. To create a new table— 

 a)Point to Table in the <Database> pane b)Point to Table in the Explorer pane and right click 

 c)a or b d)None of these 

176. A row in a table represents— 

 a)column b)file 

 c)field d)record 

177. A screen that displays data for a single record is called----- 

 a)record b) file 

 c)form d)table 

178. Which of the following uniquely identifies a record in a database table? 

 a)Delete key b)Primary key 

 c)Entry key d)Save key 
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179. Currency, text and decimal are examples for---- types. 

 a)data  b)field 

 c)both d)None of these 

180. ----window appears, when the sort icon is clicked. 

 a)Sort b)Sort again 

 c)Sort order d)Sort options 

181. Which of the following operations can be performed by the key Ctrl + S ? 

 a) Delete b) Cut 

 c) Open d) Save 

182. ----consists of AutoFilter icon. 

 a)Menu bar b) Title bar 

 c)Scroll bar d)Toolbar 

183. Which of the following windows is similar to Defaultfilter? 

 a)Report window b)Form window 

 c)query condition window d)Condition window 

184. Designing a form using the Autopilot option is similar to create a query using— 

 a)Form – New-Autopilot b)New-Form-Autopilot 

 c)Autopilot-New-Create d)New-Create-Autopilot 

185. Which is decided by the page style---of StarOffice Base? 

 a)Orientation  b)Form design 

 c)Alignment d)Font attribute 

186. Which windows helps us to select a format for report? 

 a)outline b)create 

 c)format style d)style collection 

187. Queries are 

 a)Structural statements b) User Defined statements 

 c)User constructed statements d)Predefined statements 

188. DBMS is made use of 

 a)constructing relations b)assembling data 

 c)assembling informations d)destroying data 

189. In how many ways manipulation of data can be performed? 

 a)10 b)8 

 c)7 d)5 

190. Which of the following data types can be integer, float, double precision, data etc 

 a)Primitive b)Numeric 

 c)User-defined d)Enumerated 

191. -----database is similar to hierarchiecal structure. 

 a)Flat File b)Network 

 c)Object Oriented d)DBMS 

192. The method of processing or handling that can be associated to an object is called 

 a)process b)project 

 c)procedure d)program 

193. In StarBase every table must contain--- 

 a)primary key b)secondary key  

 c)both d)end key 

194. In the case of editing a record, the record is first selected by clicking on the 

 a)record key b)record printer 

 c)record button d)primary key 

195. To change the selected record, we have to click on the 

 a)record button b) primary key 

 c)delete rows option d)delete columns options 

196. Which is defined by its characteristics attributes & procedures? 

 a)Form b)Record 

 c)Object d)File 

197. Hierarchical database was primarily used on 

 a)Super Computers b) Personal computers 

 c)Business Computers d)Main frame computers 

198. In which database records are organized in a tree like structure by type 

 a)Network  b)Hiearchical 

 c)Relational d)Flat-file 
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199. The common field or fields of two or more tables is called a 

 a)Cell                       b)Cell pointer     c)Row  d)Key  

200. The key combination used to save the table is 

 a)Ctrl+K b)Ctrl +Z 

 c)Ctrl +S d)Ctrl+B 

201. The filter used to display only the records, which match the value of the current field is 

 a)AutoFilter b)Default Filter 

 c)QueryFilter d)None of these 

202. Which of the following statements is false? 

 a)Sorting arranges records in a table according to specific criteria 

 b)Information consists of usable sets of data 

 c)Star base allows to use three types of Filters 

 d)A filter is also a type of Query 

203. The option used to specify the maximum characters that can be entered in a field is 

 a)Default value b)Length  

 c)Type d)Entry required 

204. If a field type is Number, the option in the Field properties allows to specify the type of 

 the number we wish to store in that field is--- 

 a)Default value b) Length 

 c)Type d)Entry required 

205. StarOffice Base allows the use of 

 a)20 different field types b) 12 different field types 

 c)10 different field types d) 15 different field types 

206. ---- is not a field type in StarBase. 

 a)Data/Time b)Currency 

 c)Float d)Menu 

207. Which one of the following statement is false? 

 a)Every table in StarOffice Base must have a primary key. 
 b)Editing in StarOffice Base allows to change the font type, size and height of  the rows also 

 c)Merging arranges records in a table according to specific criteria 

 d)SQL is a Special Query Language for communicating with a database 

208. StarOffice Base filter is a type of 

 a)Query b) Forms 

 c)Filter d)Default filter 

209. Whichof the following is a component of a database? 

 a)Tabel b) Record 

 c)Field d)All the above 

210. ---- is an example for attributes. 

 a) Colour b)Style 

 c) Size d) Colour on Style or Size 

211. Filter used with a condition is called--- 

 a)AutoFilter  b)Default Filter 

 c)option d)attribute 

212. Sorting of more than one field of  a table at the same time is called— 

 a)indexing  b)single sorting 

 c)sorting d)multiple sorting 

213. Browsing a selecting list of records is called 

 a) sorting b) searching 

 c) merging d) filtering 

214. The relation between-----is called parent-child relationships. 

 a) data types b) filted types 

 c) record types d) forms 

215. DBMS is an acronym for---- 

 a)Database b)Database Management System 

 c)Database Manipulating system d)Database Merging System 

216. -----option in the field properties allow us to specify the types of numbers to be 

 Stored. 

 a)value b) Length  

 c)Type d)Default Value 

217. A filter is also a type of---- 

 a)Form b)Report 

 c)Database d)Query 
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218. Queries are special views of 

 a)forms b) tables 

 c)data d)records 

219. Queries are special views of data in a ---- 

 a)report b)form 

 c)record d)table 

220. Editing the data may include 

 a)changing a value of a field in a record b)deleting a record 

 c)appending record d)all the above 

221. To edit the data that has been entered in a table we have to 

 a)just click on the field value b)retype the new value 

 c)just click on that filed and retype the new value 

 d)None of these 

222. To edit a record first 

 a)key the record b)press the primary key 

 c)press the record pointer d)select the record 

223. A record can be selected by 

 a)clicking in the field menu b)clicking on the record pointer 

 c)clicking on Delete Rows option d)cliking on OK button 

224. If one clicks on-----option, the selected record will be deleted 

 a)Delete Rows b)Colour 

 c)Field d)Record 

225. On clicking on Table Format--- 

 a)Opening Screen appears b)Table Format window appears 

 c)Table appears d)Text box appears 

226. To view or modify the design of an existing table 

 a) click – sign to the right of the table b)click+sign to the left of the table 

 c)click+sign to the right of the table d)click –sign to the left of the table 

227. --window is used to view and modify table 

 a)Format Window b)Table Format Window 

 c)Explorer Window d)Opening Screen Window 

228. With the help of Structured Query Language one can— 

 a)search the database to locate records  b)list a subset of records 

 c)delete obsolete records  d)all the above 

229. By pressing-----key we can move to next column 

 a)Shift b)Insert 

 c)Tab d)Enter 

230. In StarOffice Base-----filed types can be used 

 a)14             b)20  

 c)11 d)12 

231. By pressing which key, one can move to the second field? 

 a)Insert key b) Replace key 

 c)Tab key d)Shift key 

232. In the lower part of the window ---- is displayed 

 a)status bar b)tool bar 

 c)table format pane d)field properties pane 

233. ----option is used to specify a default value to be assigned to that field 

 a)Length b)Type   

 c)Entry required d)Default value 

234. ----option specifies the user should enter a value for that field 

 a)Default value b)Format 

 c)Length d)Entry required 

235. ----option allows the user to specify the number format also aligns the text or number 

 within the column 

 a)Default value b)Length  

 c)Entry required d)Format example 

236. A table can be served by 

 a) clicking the save icon b) pressing CTRL+S key 

 c)clicking the save icon or pressing CTRL+S key d)None of these 

237. On clicking table format, a dialog box-----is displayed on the screen 

 a)to change the colour of the table b)to change font size, colour& style 

 c)to change font size, colour & width d)to change colour of the table 
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238. By using-----filter can be removed 

 a)Filter b)Icon 

 c)Remove filter/Sort icon d)Sort icon 

239. ----- is to be clicked to arrange the records in a table in ascending order 

 a)Decreasing icon b) Increasing icon 

 c)Ascending icon d)Descending icon 

240. Which command displays the outspilot query window? 

 a) Query AutoPilot b)New AutoPilot 

 c)New Query AutoPilot d)Edit  Query  Auto pilot 

241. ____ options are available in the pull-down menu. 

 a) cut & update b) Cut & paste 

 c) Create link & cut d) Cut, update & create link 

242. When----- is clicked, the records are displayed in the field 

 a)View b)Record 

 c)Page d)Preview 

243. A form contains— 

 a)field b)table  

 c)single table d)single table & multiple tables 

244. -----command is used to design a form 

 a)New form b) New Form AutoPilot 

 c)New AutoPilot d)Edit AutoPilot 

245. To create a query in StarOffice Base---- 

 a)left click on queries b)right click on queries 

 c)right click on queries in the Explorer window 

 d)left click on queries in the Explorer window 

246. -----options appear in a pull down menu 

 a)New b)Update 

 c)Cut d)New,Update and Cut 

247. AutoPilot Query window is made to appear---- 

 a)by pressing primary key b)by pressing primary pointer 

 c)by clicking on New Query Autopilot d)by clicking on Edit Query Autopilot 

248. Which window is used to specify the fields&conditions on which query should be 

 Based? 

 A)Opening Screen window b)Filtering Window 

 c)Autopilot Query:Filtering Windows d)Table Format Window 

249. By clicking on----- button, the records containing the field result will be displayed 

 a)Pass b)Preview 

 c)Result d)Field Name 

250. If you do not wish to sort the result of the query which button is to be clicked? 

 a)Enter b)OK 

 c)Next d)Delete 

251. -----button is to be selected for a query to be executed immediately 

 a)Store query button b)Execute query button 

 c)Execute query radio button d)Store query radio button 

252. In order to execute the queries click or the +sign to the _____ 

 a)right of Query b)left of Query in the Explorer window 

 c)right of Query in the Explorer window d)none of the above 

253. By clicking-----button, a filter window will appear. 

 a)defaultfilter b)autofilter 

 c)OK d)delete 

254. Field selection window appears by the 

 a)left click on form b)right click on form 

 c)right click on form in the Explorer window 

 d)left click on form in the Explorer window 

255. Styles window can be used 

 a)to select a page style for the form b)to click on form 

 c)to right click on form d)to select a New Form AutoPilot 

256. ------buttons are used to include the selected field names in the form 

 a)  and  b) > and >> 

 c)  and ^ d) ^ and + 
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257. Once a form is created one can use to 

 a) view b) delete 

 c)edit the records d)view add, delete and /or edit the records 

258. By clicking the right button on Report in the Explorer pane,----is created. 

 a)form                              b)project               

 c)report d)style 

259. A report is printed using 

 a)input b)data 

 c)query d)form 

260. ----- is selected by the user to customize a report 

 a)Format & Create for the report b)Format & Style for the report 

 c)Alignment & Style for the report d)Alignment & Sort for the report 

261. ----window is displayed next to sort options window. 

 a)Format style b) Alignment 

 c)Create d)Style Selection 

262. ----- window is displayed next to the style selection window 

 a)Create b) Sort 

 c)Outline d)Format style 

263. How many panes does a StarOffice window have?-------- 

 a)4 b)3 

 c)2 d)6 

264. Human beings are likely to make----errors in data processing 

 a)instrument & parallax b) computational & parallax 

 c)instrumental & parallax d)random & systematic 

265. The purpose of entering a new record at the end of the table is to 

 a) create a record b) open a record 

 c) oppend a record d) sort a record 

266. Which of the following is used to delete or edit the records in a table? 

 a) File b) Field 

 c) Form d) Filter 

267. The explorer pane can be hidden by clicking 

 a) Hide Explorer b)Erase Explorer 

 c)Cancel Explorer d) View Explorer 

268. -----will design a table 

 a)New Table design b)Query Table Table design 

 c)New Table Table design d)File Table Table design 

269. While executing double precisson values the value will be accurate upto----Places  

 a) 17           b) 12  

 c) 22  d) 14 

270. By selecting----- for a report we can customize the report 

 a)Style b)Alignment 

 c)Alignment to Style d)Alignment & Colour 

271. ------ helps us to choose a format for the report. 

 a)Text box b) Format style window 

 c)Dialog box d) Create Window 

272. Database is highly effective for 

 a) editing  b) merging 

 c)copying d) data manipulation 

273. How many filters are allowed in StarOffice Base? 

 a) 5                   b)4      

 c) 2 d) 3 

274. On which computers, hierarchical database structure is primarily used? 

 a)Micro Computers b) Mainframe computers 

 c) Super Computers d)Personal Computers 

275. The----- is a small triangle on the left most column of the table 

 a) Record pointer b) Record indicator 

 c) Pointer d) Indicator 

276. -----click the record pointer of the selected record to edit the record 

 a) Left b) Right 

 c)Drag and click d) Double 
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277. A Database means the collection of 

 a) records b) information  

 c)outputs d)related data 

278. Which of the following is used for data processing? 

 a) Starwriter b)Starcalc 

 c)StarBase d)None of these 

279. ----- is a repository collection of related data or facts. 

 a)Data b)Information 

 c)Database d)File 

280. How many types of databases are there? 

 a)4 b)3 

 c)5 d)8 

281. ---- a type of query. 

 a)Form b)Report 

 c)Filter d)Table 

282. There are ----- types of filters available 

 a)1 b)2 

 c)3 d)4 

283. The term data comes from the word----- 

 a)Fact b)Information 

 c)Datum d)Entry 

284. SQL stands for 

 a)Standard Query Language b)Structured Query Language 

 c)Specific Query Language d)System Query Language 

285. ---- is fact about people, places or entities. 

 a) Data b)Information 

 c)Database d)DBMS 

286. A small triangle on the left most column of the database table called---- 

 a)Cell pointer b)Record pointer 

 c)Pointer d)Field pointer 

287. How many field types are there in StarBase? 

 a)20 b)10 

 c)8 d)15 

288. Each row in a table represents a---- 

 a)data b)record 

 c)field d)table 

289. Each column in a table represents a---- 

 a)data b)record 

 c)field  d)table 

290. Information is a ---- 

 a)Data b)Entities 

 c)set of processed data d)Facts 

291. which key uniquely identifies record in a Database table? 

 a)Primary key b)Relation key 

 c)Tab key d)Common key 

292. The process of arranging data in a table in some order is--- 

 a)Sorting b)Merging 

 c)Searching d)Filtering 

293. Filter used with a condition is--- 

 a)Auto filter b)Default filter 

 c)Query filter d)Auto-pilot query 

294. Records that are arranged in parent-child relationship is 

 a)Hiearrchical  b)Network 

 c)Flat-file d)Relational 

295. The shortcut key used for saving a table in Starbase is--- 

 a)Ctrl+A b)Ctrl+E 

 c)Ctrl+F d)Ctrl+S 

296. A database is a collection of related---- 

 a)fields b) tables 

 c)columns d)rows 
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297. ------is used to select a desired specific data from a Database 

 a)Merging  b)Filtering 

 c)Sorting d)Searching 

298. Character, Number or Boolean are---- 

 a)Primitive Data types b)User defined data types 

 c)Data types d)Information 

299. A database file that consists of a single data table is called 

 a)Netowrk Database b)Flat-file Database 

 c)Object-oriented Database d)Relational Database 

300. DBMS stands for--- 

 a)Data Base Management System b)Data Base Merge System 

 c)Data Binary Mailing system d)Data Binary Management System 

301. Which one of the following is to be clicked to appear Autopilot Query window in 

Starbase? 

 a)New AutoPilot Query b)File New Query 

 c)New Query Autopilot d)File Query Autopilot 

302. A database table that contains related data tables is 

 a)Network Database b)Flat-file Database 

 c)Object-oreinted Database d)Relational Database 

303. In StarBase to view or modify the design of an existing table, the sign to be clicked is 

 a)- sign b) + sign 

 c)/ sign d) x sign 

304. Which icon is used to be clicked to display only the records matching the value of the  

 Current field in StarBase? 

 a)Autofilter icon b)DefaultFilter icon 

 c)Query icon d)Filter icon 

305. The sub-menu for creating a table in StarBase is 

 a)Table Table Design b)New Table 

 c)New Table Design Table d)New Table Table Design 

306. In Starbase the entire collection of related data in one table is referred to as a 

 a)field b)record 

 c)file or table d)Data 

307. 10.20.04 is which of the following data types? 

 a)Text b)Number 

 c)Currency d)Date 

308. The hierarchical database structures were primarily used on 

 a)Personal computer b)Mini computer 

 c)Micro computer d)Mainframe computer 

309. Sorting on more than one field of a table at a time is called 

 a)Sorting b)Ascending 

 c)Multiple sorting d)Descending 

310. The Language that is used to communicate with a database is 

 a)SQL  b)Pascal 

 c)StarWriter d)StarCalc 

311. A screen that display the fields of a record in a well-spaced out manner is 

 a)Window b)Filter 

 c)Form d)View 

312. ----database can be quite useful for single-user 

 a)Hiearchical  b)Network 

 c)Object oriented d)Flat-file 

313. A-----is printed information that is assembled by gathering data based on a query 

 a)Form b)Report 

 c)Table d)Query 

314. ----logical operators are used in Query Link Box. 

 a)AND and  OR b) AND and NAND 

 c)NOR and NAND d)OR and NOR 

315. The programming languages and packagaes provide their own data type called--- 

 Data type 

 a)primary b)secondary 

 c)primitive d)user defined 
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316. User can define their own sophisticated data types which are known as---data types 

 a)primary  b) secondary 

 c)primitive d)user defined 

317. ---- is a process of joining data from two or more tables of the same or different 

 Database. 

 a)merging b)sorting 

 c)searching d)filtering 

318. Decimal values are accurate upto a length of – places in the case of single precision 

 a)3 b)5 

 c)7 d)9 

319. Decimal values are accurate upto a length of ---- places in the case of double precision 

 a)12 b)14 

 c)16 d)18 

320. Bytes accepts values upto--- 

 a)200 b)250  

 c)300 d)350 

321. In Database, the entire collection of related data in one table is referred as a 

 a)data b)file 

 c)record d)field 

322. DBMS is a ---- tool 

 a)record b)software 

 c)hardware d)primary 

323. ----data type accepts only whole numbers 

 a)Integer b)Real 

 c)Text d)None of these 

324. ____ is a process of performing corrections on the existing data. 

 a) sorting b) editing 

 c) searching d) filtering 

325. -----option allows you to specify the maximum characters that can be entered in a field 

 a)total b)length 

 c)size d)number 

326. To generate any desired report, from the data of the database is called 

 a)output b)result 

 c)report d)printout 

327. ----means to do some operations or computations on the data of different variables 

 a)Editing b)processing 

 c)Filtering d)Sorting 

328. -----is a group of related data conveying some meaning 

 a)information b)data 

 c)record d)none of these 

329. -----database is more powerful than others. 

 a)Flat-file b)Relational  

 c)Hiearchical d)Network 

330. Database is a collection of related--- 

 a)Records b)Field 

 c)Tables d)None of these 

331. Example for a flat-file database is 

 a)Spreadsheet b)File 

 c)Word document d)None of these 

332. --- is a way of limiting the information that appears on screen 

 a)sort  b)edit 

 c)filter d)query 

333. A(n)-------is defined by its characteristics, attributes and procedures. 

 a)Database b)Object 

 c)Table d)None of these 

334. ------ is very similar to hierarchical structure 

 a)Flat-file b)Relational 

 c)Hiearchical d)Network 

335. Press----key to save the table 

 a)Ctrl+A b)Ctrl+S 

 c)Ctrl+L d)Ctrl+D 
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336. ------is an organized collection of related data or facts. 

 a)Database b)File 

 c)Information d)Datum 

337. Data in a databse is mostly viewed in 

 a)Report b)Table 

 c)Form d)Query 

338. Manipulation of data base can be done in ____ ways. 

 a)3 b)5 

 c)7 d)9 

339. Queries are--- statements, 

 a)input b)user constructed 

 c)user d)conditional 

340. ----button is used to create a form 

 a)finish b)open 

 c)create d)done 

341. ---- is the process of performing corrections. 

 a)Editing b)Formatting 

 c)Correcting d)None of these 

342. ----- is a process of selecting a specific desired data from the database 

 a)Editing b)Filtering  

 c)Searching  d)Editing 

343. A flat file database consists of ----table(s) 

 a)only one b)two 

 c)three d)many 

344. ----- key uniquely identifies each record in a database table 

 a)Secondary b)Primary 

 c)Common d)None of these 

345. There are-------types of reports 

 a)2 b)3 

 c)4 d)5 

346. ----are user defined screens. 

 a)Reports b)Queries 

 c)Forms d)Tables 

347. There are -----types of filters 

 a)2 b)3 

 c)4 d)5 

348. A---is used to assemble information from data 

 a)DB b)DBMS 

 c)SQL d)None of these 

349. A---- is a printed, information based on a query 

 a)Report b)Query  

 c)Form d)Table 

350. ---- applications are tightly integrated 

 a)Report b)Starwriter 

 c)StarBase d)StarOffice 

351. -------database is highly effective for searching and sorting 

 a)Manual  b)computerized 

 c)Network d)Object oriented 

352. In the relational data base tables, the common fields are called as 

 a)primary keys b)secondary keys  

 c)keys d)None of these 

353. ----- are a feature for displaying and browsing a selected list or subsets of records from 

 a table 

 a)Sorting b)Filtering 

 c)Searching d)Editing 

354. The ------ database structures were primarily used on Main Frame computers 

 a)Flat file b)Relational 

 c)Hiearachical d)Network 

355. In the ---database the relationship between record types is said to be parent-child 

 Relationship. 

 a)Flat file b)Relational 

 c)Hiearchical d)Network 
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356. In the ------ data type the records are organized in a tree like structure 

 a)Flat file b)Relational 

 c)Hiearchical d)Network 

357. The------database structure is the most prevalent database in today‘s business

 Organizations. 

 a)flat file b)Relational 

 c)Hiearchical d)Network 

358. Handling multiple data tables are not possible in----database 

 c)Flat file b)Relational   

 c)Hiearchical  d)Network 

359. A database file that consists of a single data table is a _____ database. 

 a) Flat file b) Relational 

 c) Hierarchical d) Network 

360. The -----database structure is similar  to hiearachical database 

 a)Flat file b)Relational 

 c)Hieararchical d)Network 

361. Data manipulated in Spreadsheet is an example for----database 

 a)Flat file b)Relational 

 c)Hierarchical d)Network 

362. A(n)-------is defined by its characteristics, attributes and procedures. 

 a)Entity b)Object 

 c)Event d)None of these 

363. An Object‘s ------ can be text, sound, graphics and video 

 a)attributes b)characteristics 

 c)procedure d)None of these 

364. ____ also provide the means for multiple users to access and share data in the same data 

using network. 

 a) DBMS b) Data 

 c) Procedure d) None of these 

365. Examples for -------might be colour, size quantity and price 

 a)attributes b)characteristics 

 c)procedure d)None of these 

366. A----refers to the processing or handling that can be associated to the object 

 a)attributes b)characteristics 

 c)Procedure d)None of these 

367. The biggest asset of ----is its ability to provide extremely quick access and retrieval 

 From large database 

 a)DBMS b)data 

 c)procedure d)None of these 

368. Database is a collection of related--- 

 a)information b)data 

 c)procedures d)None of these 

369. -----data type accepts only whole numbers 

 a)number b)integer 

 c_)float d)real 

370. A small-----key appears to the left of a field as primary key 

 a)red b)green 

 c)yellow d)blue 

371. Press------key to save the table in StarBase 

 a)Ctrl+A b)Ctrl+S  

 c)Alt+S d)Alt+A 

372. Select save from the-----menu option to save the table 

 a)File b)Format 

 c)Edit d)View 

373. Using------dialog box the font type, style, size and colour can be changed in a table 

 a)Formatting b)character 

 c)Table format d)None of these 

374. ------sorting means sorting on more than one filed of a table at the same time 

 a)Single b)Two-way 

 c)Multiple  d)None of these 
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375. ----- is designed specifically for communicating with a database using statements 

 a)C b)SQL 

 c)C ++ d)DBMS 

376. The option------ is used to specify if the user should always enter a value for that field 

 a)length b)entry required 

 c)default value d)None of these 

377. Under------ a brief description can be entered 

 a)Details  b)Description 

 c)Information d)None of these 

378. Data means 

 a) Un processed facts and figures b) Processed facts and figures 

 c) Information d) Group items 

379. Which is a way of limiting the information. 

 a) Limit b) Filter 

 c) Edit d) Sort 

380. The Numeric data refers to a  

 a) Integer b) String 

 c) Variable d) Expression 

381. Collection of related data is a 

 a) Database b) Information 

 c) Field d) Record 

382. Collection of related field is a  

 a) File b) Database 

 c) Record d) Information 

383. Collection of related data item is  

 a) File b) Record 

 c) Information d) Field 

384. Collection of related record is 

 a) Column b) Field 

 c) File d) Database 

385. Each table row in a table is a  

 a) Database b) Information 

 c) Field d) Record 

386. Two dimensional table consists of 

 a) Field and Table b) Row and Record 

 c) Row and Column d) File and Data 

387. Each table column represents a 

 a) Database b) Information 

 c) Record d) Field 

388. Flat-File database is 

 a) Spreadsheet b) Key 

 c) Primary key d) Flat-File 

389. The common field is called  

 a) Key b) Spreadsheet 

 c) Flat-File d) Primary key 

390. StarOffice window is divided into ______ panes. 

 a) 2 b) 3 

 c) 4 d) 7 

391. Star Base allow the use of ____ different field types. 

 a) 11 b) 12 

 c) 13 d) 14 

392. Filter used with a condition is called a 

 a) Filter b) Auto filter 

 c) Default filter d) Forms filter 

393. A report is printed information based on a 

 a) Query b) Database 

 c) Filter d) Sort 

394. Processing and Analysis the data is known as 

 a) Data Processing b) Information 

 c) Data Numeric d) None of these 
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395. Group data items and this associated characteristics, attributes and procedures into 

complex items called   

 a) Filter b) Objects 

 c) Event d) Sort 

396. Byte accepts values upto 

 a) 200 b) 250 

 c) 300 d) 350 

397. Which processing is easy to edit the data including correction, changes and 

modifications? 

 a) Manual data b) Computerised data 

 c) Reported data d) User-Defined data 

398. This key is used to identify the uniquely of every record in the record 

 a) Foreign key b) Hierarchical key 

 c) Primitive key d) Primary key 

399. Drop-down menu shows _____ different data types. 

 a) 4 b) 6 

 c) 5 d) 7 

400. The programming languages and packages provide their own built in data type. It is 

called ____ 

 a) Hierarchical  b) Primitive 

 c) Explorer d) Flat-file 
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MULTIMEDIA 

 

I. Choose the Correct Answers :-      

1. ------- is a computer – based presentation technique 

 a) Media b)Multimedia 

 c)Graphics d)Animation 

2. ------that incorporates text, graphics, sound, animations and video elements. 

 a)Technique b)Technology 

 c)Tech d)Techno text 

3. Multimedia-----of elements grabs the viewers attention and retains it. 

 a)contribution b)control  

 c)combination d)mixture 

4. The----inputs addresses the different learning needs. 

 a)multi-sensory b) multi-facet 

 c)multimedia d)multi-sense 

5. -------enhances the entire experience for the user. 

 a)Animation b)Multi-sensory 

 c)Visual effect d)Multimedia 

6. The------inputs addresses the different styles of different users. 

 a)multi-sensory b)multi-facet 

 c)multimedia d)multi-sense 

7 Multimedia enhances the entire----for the users. 

 a)entertainment b)excitement 

 c)experience d)engagement 

8. Multimedia---------are being used in a variety of different fields 

 a)applications b)programs 

 c)visuals d)graphics 

9. In a vaeity of different fields ----- applications are used 

 a)animation b)graphic 

 c)multimedia d)audio-visual 

10. -------is widely used to add special effects to movies. 

 a)Animation b)Graphics 

 c)Sound d)Multimedia 

11. Multimedia is widely used to add special---------to movies. 

 a)attachments b)effects 

 c)arrangement d)control 

12. -------and animations are frequently used to make computer games thrilling and realistic. 

 a)High-end graphics b)Graphics 

 c)Special effects d)Images 

13. A high – end ------- of the games is a flight simulator. 

 a)variety b)visual 

 c)existence d)extension 

14. ---- is an application that allows you to send and receive messages over cell phone. 

 a)Multimedia b)MMS 

 c)Message service d)Animated service 

15. Multimedia has an------ impact on education. 

 a)enormous  b)effective 

 c)extensive d)elearning 

16. ----- packages are used to train and educate people world over. 

 a)Epublishing b) Etutorial 

 c)Elearning d)Educational 

17. The most common version of e-learning packages are---- 

 a)CBT / WBT b) CAD / CAM 

 c)CBT / CAM d) CAD / WBT 

18. Computer Based Tutorials are------ learning aids. 

 a)Self-learning b) Self-tutor 

 c)Self-paced d)Self – taught 

19. CBT are available on the-------- 

 a) CD – RWT b) CD – ROMs 

 c) CD-RAM d) CD-CAM 
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20.  WBT are available on the --------- 

 a) Internet b)Intranet 

 c)CD – ROMs d)CD-CBT 

21. In ------ learner can learn by himself, at a pace and time he is comfortable with 

 a)CD-ROM b) WBT 

 c)CBT d)CBT/WBT 

22. In CBT / WBT there is no------ 

 a)learner b)trainer 

 c)instructor d)trainee 

23. In CBT / WBT the ----- need not have to travel to a location to attend the classes. 

 a) learner b)trainer 

 c)instructor d)trainee 

24. CBT/WBT eliminates the—----- problems of getting together people from different 

 Parts of the world 

 a)logical b)logistical 

 c)language d)linguistic 

25. ----- trainings are cost-effective 

 a)CBT/WBT b)Tutorial 

 c)Technical d)Computer 

26. Multimedia based training is also being------used to train and educate children 

 a)intensively  b) extensively 

 c)instinctively d)expansively 

27. Multimedia ----- are very effective in explaining difficult concepts and facts 

 a)presentation b)program 

 c)simulations d)slides 

28. The ---- of information presented in multimedia encyclopedia is greater than printed  

  information. 

 a)impact b)effect 

 c)outcome d)result 

29. The use of------ in multimedia material makes it easier to search and view related content 

 a)connection b)link 

 c)hyperlink d)linkage 

30. Multimedia is heavily used in the ------ industry. 

 a)advertisement b)entertainment 

 c)amusement d)diversion 

31. Multimedia games are popular pastime and are software program available either as 

 ----- or ------- 

 a)CD-ROMS online b)CDROM, offline 

 c)Disk, online d)Disk, offline 

32. The act of allowing the users to participate actively are called------ multimedia 

 a)External b)Internal  

 c)Interactive d)Extractive 

33. The simulation is just a / an-------but, it makes the user think that they are playing a real 

   match. 

  a)illusion b)fantasy 

 c)delusion d)chimera 

34. The simulation environment is created by ---- devices. 

 a)Input b)Output 

 c)Both(a) &(b) d)Modem 

35. -----and-----are the input devices used in creating simulation. 

 a)Keyboard, Mouse b)Joystick, Sensors 

 c)Keyboard, Sensors d)Mouse, Joystick 

36. ----and----- are the output devices used  in creating simulation 

 a)Headphone, goggles b)Headphone, Monitor 

 c)Monitor, Goggles d)All the above 

37. The various multimedia components are coordinated with a technique called---- 

 a)Illusion b)MMS 

 c)Simulation d)Virtual reality 

38. Virtual reality provides an/a------which is experienced by users as similar to reality 

 a)environment b)industry 

 c)situation d)location 
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39. Virtual reality is useful in training pilots in flight--------- 

 a)Simulation b)Simulators 

 c)Model d)Imitation 

40. Multimedia is also used for----communications and presentations. 

 a)company b)communal 

 c)corporate d)commercial 

41. In engineering, multimedia tools are used for ----- and----- new components and 

 Products. 

 a)designing, testing b)designing, tasking 

 c)developing, testing d)developing, tasking 

42. In medicine, doctors can get trained by viewing at a------ 

 a)surgical procedure b)virtual surgery 

 c)virtual procedure d)real surgery 

43. In medicine, we can train doctors by simulating a surgical procedure without ----the 

 human life. 

 a)disturbing b)harming 

 c)risking d)endangering 

44. In multimedia, a scientist can look at the molecular model of a compound and---it 

 a)manipulate b)process 

 c)produce d)prepare 

45. The two most common multimedia file formats are----and---- 

 a)Nxview Files,  GIF b)GIF/JPEG 

 c)GIF/JPG d)Vector, Graphics 

46. Both GIF/JPG formats are------static bitmap images. 

 a)enhanced b)compressed 

 c)clear d)pixel 

47. ----are typical examples of static images. 

 a)Messages  b)Jokes 

 c)Photographs d)File 

48. A------file uses a much more complex technique. 

 a)JPG b)JPEG 

 c)GIF d)BMP 

49. In------the color of every pixel is different when compressed. 

 a)JPG b)GIF  

 c)JPEG d)BMP 

50. GIF is limited to an-----palette. 

 a)4 – bit b)6 – bit 

 c)8 – bit d)12 –bit 

51. -------is best suited for simple graphic images with relatively few colors 

 a)GIF b)JPG 

 c)JPEG d)BMP 

52. -------is not well fitted for photographic works. 

 a)GIF b)JPG 

 c)JPEG d)BMP 

53. The great------ of GIF images available and support for animation 

 a)flexibility b)reservoir 

 c)compatibility d)feature 

54. Than JPG, ------ is/are still used extensively  on the Internet and multimedia 

 a)JPEG b)BMP 

 c)GIF d)All the above 

55. The------image files are lossy format 

 a)JPEG b)JPG 

 c)BMP d)GIF 

56. All----- have the option to save images in JPEG format. 

 a)cameras b)digital cameras 

 c)computers d)laptops 

57. The-----format supports full color and producers relatively small file size 

 a)GIF b)JPG 

 c)JPEG d)BMP 

58. In JPEG, the two categories of image file compression are-----and------ 

 a)static, image b)digital, image 

 c)lossy, lossless d)lossy, static 
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59. The-----compression algorithm takes advantage of the limitations of human visual senses. 

 a)lossy b)lossless 

 c)both(a) & (b) d)static 

60. The lossy compression algorithm------ information that would not be sensed by the eye 

 a)rejects b)discareds 

 c)throws-out d)junk 

61. -----is a lossy compression of the image 

 a)JPG b)GIF 

 c)JPEG d)BMP 

62. ------graphics help in rendering the image effectively on the screen 

 a)Image b)Static 

 c)Vector d)Lossy 

63. Vector -----cards to improve the efficiency in the display of images. 

 a)image b)graphics 

 c)display d)screen 

64. The sound that you hear are----wave patterns. 

 a)analog b)digital 

 c)hybrid d)pitch 

65. -------attributes control the characteristics of sound. 

 a)1 b)2 

 c)3 d)4 

66. The volume is the height of each-----in the wave 

 a)crest b)cycle 

 c)time d)pitch 

67. The distance between the crests of the wave are called----- 

 a)crest b)sound 

 c)pitch d)volume 

68. The ------ the distance, the lower is the sound. 

 a)more b)most 

 c)great d)greater 

69. To include sounds, we have to----- the analog sound waves into a digital format 

 a)convert b)change 

 c)alter d)translate 

70. The conversion of analog sound waves to a digital format is called----- 

 a)frequency b)pitch 

 c)sampling d)amplitude 

71. Special effect for sound could be added using sound editing program called---- 

 a)sound forge b)sound task 

 c)sound page d)sound echo 

72. -----are primarily used to illustrate or demonstrate an idea or a concept 

 a)Multimedia b)Animations 

 c)Graphics d)Videos 

73. Animations can be of--- or----- dimensional 

 a)three, two b)one, three 

 c)one, two d)two, three 

74. 2-D animations are broadly classified into-----categories. 

 a)1 b)2 

 c)3 d)4 

75. -----animations consists of multiple drawing, each one a little different from the other. 

 a)Cel-based b)Object-based 

 c)Circuit-based d)Digital –based 

76. ------based animations referred to as slide or path are created by moving an object across 

 a screen. 

 a)Cel b)Object 

 c)Sound d)Digital 

77. Object-based animations are usually seen in ---- games. 

 a)video b)cel 

 c)computer d)all the above 

78. How many step process are there to create a 3-D animation? 

 a)1 b)2 

 c)3 d)4 
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79. First step process of creating 3-D animation is 

 a)modeling b)animating 

 c)rendering d)morphing 

80. Second step process of creating 3-D animation is 

 a)modeling b)animating 

 c)rendering d)morphing 

81. After modeling and animating------should be done on a 3-D object 

 a)morphing b)warping 

 c)imaging d)rendering 

82. In 3-D image, after animation is created adding special effects are called as----and----- 

 a)morphing, warping b)modeling, warping 

 c)rendering, morphing d)modeling, rendering 

83. ----is a technique by which we can blend two or more images to form a new image 

 a)Modeling b)Warping 

 c)Morphing d)Rendering 

84. ----- is the technique of distorting a single image to represent something. 

 a)Modeling b)Warping 

 c)Morphing d)Rendering 

85. ----- is recorded and played back as an analog signal 

 a)Video b)Audio 

 c)Image d)Graphic 

86. Video files tend to be very------ 

 a)light b)heavy 

 c)hard d)soft 

87. Minimum color depth of video files are---- 

 a) 16 color b)16 bit 

 c) 16 bit (true) d)256 colors 

88. Minimum frame count of video files per second is------frames. 

 a)7 b)15 

 c)28 d)30 

89. We can reduce the size of the video files by---- them. 

 a)compressing b)coverting 

 c)zipping d)morphing 

90. ----- is a technique by which a recurring set of information is identified. 

 a)Compression b)Conversion 

 c)Zip d)Morphing 

91. There are------types of video compressions. 

 a)1 b)2 

 c)3 d)4 

92. ----- compression retains the exact image throughout the compression. 

 a)Lossless b)Lossy 

 c)Jerky d)Murky 

93. -----compression provides a comparatively higher ratio of compression but results 

 In some loss of quality, 

 a)Lossless b)Lossy 

 c)Jerky d)Murky 

94. ------format is one that is commonly used for transferring music information 

 a)AIFF b)WAVE 

 c)MIDI d)TIFF 

95. MIDI was developed in-----year 

 a)1982 b)1972 

 c)1962 d)1992 

96. ----is a very flexible format that can be used for wide range of musical applications. 

 a)WAVE b)MIDI 

 c)AIFF d)MOVIE 

97. The MIDI format cannot contain sound it contain  only------notes. 

 a)movie b)wave 

 c)digital d)music 

98. A MIDI file that plays for approximately 5 minutes may be only ----- KB. 

 a)25 b)35 

 c)45 d)55 
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99. Sound files in the MIDI format have the extension----- or------ 

 a).rm, .ram b).mid, .midi 

 c).aif, .aiff d).tif, .tiff 

100. The Real Audio format was developed by 

 a)Real Player b)Real Format 

 c)Real Network d)Real File 

101. The Real Network developed Real Audito in the year-------- 

 a)1992 b)1993 

 c)1994 d)1995 

102. The file format extension of Real Audio is----- or ----- 

 a) .rm, .ram b).mid, .midi 

 c).aif, .aiff d) .tif, .tiff 

103. The------ format is another sound format which supports most of the popular software 

 across different platforms. 

 a)AIFF b)AU 

 c)MU d)AVI 

104. The-----format was developed by Apple. 

 a)AIFF b)AU 

 c)MU d)AVI 

105. The-----format files neither cross-platform nor supported by popular web browsers. 

 a)AU b)MPEG 

 c)SND d)AVI 

106. The-----format was developed by IBM and Microsoft. 

 a)WAVE b)MPEG 

 c)AVI d)MIDI 

107. Video files stored in MPEG format have the extension -----or----- 

 a) .wa, .wav b).mpg, .mpeg 

 c).aif, .aiff d).mid, .midi 

108. The Audio Video Interleave was developed by---- 

 a)Apple b)IBM 

 c)Microsoft d)Lotus 

109. The AVI firmat was developed by Microsoft in the year------ 

 a)1992 b)1993 

 c)1994 d)1995 

110. Video files stored in the AVI format have the extension------ 

 a).mpeg b).wav 

 c).avi d).snd 

111. Files in the windows media format have the extension----- 

 a).ram b).au 

 c).wav d).wmv 

112. The Quick Time format have extension------ 

 a).mov b).mpeg 

 c).mpg d).mu 

113. The shockwave format was developed by---- 

 a)Microsoft b)Macromedia 

 c)Apple d)IBM 

114. The shockwave format is used to store multimedia components created using---- 

 a)Media Player b)Mpeg 

 c)Flash d)Dream weaver 

115. Some additional hardware and------monitors would greatly enhance the effectiveness 

 Of using multimedia. 

 a)high resolution b)low resolution 

 c)medium resolution d)resolution 

116. Sound and video in multimedia application can be played------ or by using a----- 

 a)help, online b)inline, helper 

 c)onliner, help d)inline, help 

117. We can add inline sound using-----tag. 

 a)< bgsound> b)<bgobject> 

 c)<sound> d)<bgimage> 

118. A helper application in web page is called----- 

 a)OLE b)OLEDB 

 c)Plug-in d)Applet 
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119. -----applications can be launched using the <embed>, <applet>, or the <object> tags. 

 a)Plug-in b)Helper 

 c)Image d)Sound  

120. A 5-second audio file can be as heavy as-----MB. 

 a)1 b)2 

 c)3 d)4 

121. The major factor to be considered in multimedia file is the----- of the file. 

 a)bandwidth b)width 

 c)length d)size 

122. A heavy video in a WBT may not load because of poor.------ 

 a)Bandwidth b)Presentation 

 c)KBPS d)Signal 

123. During a regular----- transfer the entire file is downloaded to the user‘s computer. 

 a)HTTP b)TIFF 

 c)AIFF d)MIDI 

124. When we stream the file, the user‘s computer is in constant contact with the----with 

    the file. 

 a)Workstation b)PC 

 c)Server d)Node 

125. While downloading on the web-------the multimedia element, particularly videos in 

  Smaller windows. 

 a)show b)present 

 c)exhibit d)display 

126. Which of the following is a computer based presentation technique? 

 a) Multimedia b)Data processing 

 c) Tutorials d)Slides 

127. MMS means- - - -  

 a)Multimedia services b)Multimedia Messaging system 

 c)Multimedia system d)Multimedia Messaging Services 

128. Which of the following is the most common version of e-learning packages? 

 a)CBT / WBT b) WBT/SMSC 

 c)CBT/WBT d)MMS/SMS 

129. How many image formats are most commonly used? 

 a)5 b)4 

 c)3 d)2 

130.  Which file creates a perfect reproduction of the original images? 

 a) JPG b)Nx View 

 c)Shockwave d)GIF 

131. GIF means 

 a)Graphic Interchange Format b)Graphic interchange File 

 c)Graphic information File d)Graphic information Format 

132.  Expand JPEG 

 a)Joint Processor Experts Group b)Joint Photographic Experts Group 

 c)Joint Photographic Expression group d)Joint Photo Experts Group 

133. Which image files are a lossy format? 

 a)JPEG b)GIF 

 c)MPEG d)Nx VIEW 

134. How many categories of image file compressions are there? 

 a)4 b)3 

 c)5 d)2 

135. How many attributes control the characteristics of sound? 

 a)2 b)3 

 c)4 d)5 

136. Which of the following is called frequency? 

 a)amplitude b)resistance 

 c)pitch d)modulation 

137. Conversion of a analog waves to a digital format called----- 

 a)Echo b)Sound forge 

 c)Frequency d)Sampling 

138. Which of the following animations are also referred to as slide or path animations? 

 a)Cel-based animations b)Object –based animations 

 c)3D animations d)2D or 3dD animations 
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139. How many step process for creating a 3D animation? 

 a)2 b)4 

 c)3 d)5 

140. Which of the following is not a step to create a 3D animation? 

 a)Modeling b)Animating 

 c)Rendering d)Accessing 

141. Which of the following is a technique to blend two or more images to form a new image? 

 a)Warping b)Morphing 

 c)Modeling d)Animating 

142. How many frames per second causes the video to look jerky? 

 a)<9 b) < 10 

 c)< 15 d) < 20 

143. How many color depth results in the image looks murky? 

 a) < 225 b) < 16 

 c) < 256 d) < 8 

144. How many types of video compressions? 

 a) 3 b) 2 

 c) 4 d) 6 

145. Which compressions provide some loss of quality? 

 a) Loss less b) Cel-based 

 c) Lossy d) Object-based 

146. MIDI stands for 

 a) Musical instrument Digital Interface b)Musical interface Digital instrument 

 c)Modeling instrument Digital interface d)Modeling interface Digital information 

147. Which year the MIDI format was developed? 

 a)1972 b) 1982 

 c)1984 d) 1974 

148. Which sound format cannot contain sounds? 

 a)wave b) AIFF 

 c)AU d) MIDI 

149. Which format sound files supports both Audio and Videos? 

 a) MIDI b) AIFF 

 c) Real Audio d) AU 

150. The Real Audio format have the extension 

 a) rm or .rf b) .ram or .rf 

 c) .rm or .ram d) .rm or .rad 

151. What is the extension of Au format sound file? 

 a) .AUD                   b) .AU    

 c) .AUD d) .Ado 

152. AIFF stands for- - - - - 

 a) Audio Interface format file b)Audio Interchange file format 

 c) Au Interchange File format d)Audio Information file format 

153. What is the extension of AIFF format files? 

 a) .aif or .af             b) .aiff or .aid            

 c) .aiff or .aif d) .aid or .aif 

154. What is the extension of the SND format sound file? 

 a) .sn                      b) .sdn      

 c) .sou d) .snd 

155. What is the extension of  WAVE format sound files? 

 a) .wva                   b).wav      

 c) .wave d) .dat 

156. MPEG stands for 

 a) Moving Pictures Experts Group b) Model Pictures Expression Group 

 c) Moving pictures Expression Group d) Morphing Pictures Experts Group 

157. What is the extension of video files stored in MPEG format? 

 a) .mp 3 or .mpeg b) .mpeg  or .mpga 

 c) .mpge or .mpg d) .mpg or .mpeg 

158. AVI stands for 

 a) Audio video Interface b) Audio video information 

 c) Audio video interleave d) Audio video interchange 
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159. What is the extension when AVI format files are developed? 

 a) .AV b) .AU 

 c) .AVI d) .AIV 

160. Files in the windows media format have the extension--- 

 a) .wmv b) .wma 

 c) .wmf d) .wam 

161. What is the extension when quick time format files are stored? 

 a) .qtf b) .wmv 

 c) .mov d) .moq 

162. Which of the following is the extension of shokwave format sound files? 

 a) .snd               b) .swf  

 c) .sfw d) .snf 

163. Sounds and video in multimedia applications can be played by using- - -  

 a) inline or helper         b) inline or outline      

 c) helper or outline d) inline only 

164. Which tag is used to add in line sound to a web page? 

 a) < inline >                 b) < bg sound >  

 c) < sound > d) < helper > 

165. Which of the following tag is used to launch helped application? 

 a) < embed > / < applet > b) < applet > / < object> 

 c) < embed> / < applet> / <object d) < embed> / < object> 

166. MMS stands for------ 

 a) Multimedia Movie System b)Multipurpose Messaging System 

 c) Multimedia Messaging system d)Multimedia Manipulate System 

167.  The-------format was developed by the Moving Pictures Expert Group. 

 a)MPEG b)GIF 

 c)JPEG d)BMP 

168. ------ is a computer based presentation technique that incorporates text, sound, animations  

 and video elements. 

  a)Animation b) Multimedia 

 c)Compression d)Modeling 

169. __ is commonly include entertainment, education, research and business communication. 

 a) Animation  b) Multimedia 

 c) Compression d) Modeling 

170. 2 D animations can be broadly classified into-----categories. 

 a)1 b)2 

 c)3 d)4 

171.  ------ is a technique by which you can blend two or more images to form a new image. 

 a)Modeling b)Morphing 

 c)Rendering d)Animating 

172. There are----- types of compressions. 

 a)1 b)2 

 c)3 d)4 

173. -------compression retains the image throughout the compression. 

 a)Lossless b)Lossy 

 c)Standard d)Ordinary 

174. _____ provides a comparatively higher ratio of compression but results in some loss of  

 quality. 

 a)Lossless b)Lossy 

 c)Standard d)Ordinary 

175. ------ is the technique of distorting a single image to represent something else. 

 a)warping b)Morphing 

 c)Rendering d)Animating 

176. ------ is a technique by which a recurring set of information is identified and replaced by  

 a single piece of information. 

a)compression b)Morphing 

c)Rendering d)Animating 

177. ------animations consist of multiple drawings, each one a little different from the others. 

 a)Cel-based b)Object-based 

 c)Image-based d)Movie-based 
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178. -------animations also referred to as slide or path animations, are created by moving 

 an object across a screen. 

 a)Cel-based b)Object-based 

 c)Image-based d)Movie-based 

179. -----applications can be launched using the < embed >, < applet > or the < object > tags. 

 a)Multimedia b)HTML 

 c)Helper d)None of these 

180. -------tags are used to launch Helper applications. 

 a)1 b)2 

 c)3 d)4 

181. How many image formats are commonly used? 

 a)1 b)2 

 c)3 d)4 

182. ------are popularly being used to send and receive jokes, music, ring tones, pictures and  

 sometimes even videos. 

 a)MMS b)MSM 

 c)CMS d)None of these 

183. ------format was developed by Macromedia and is used to store multimedia components 

 created using Flash. 

 a)MIDI b)Shockwave 

 c)GIF d)JPEG 

184. The two most commonly used image formats are----and------ 

 a)JPG and MIDI b)GIF and JPG 

 c)BMP and JPG d).AV and .AU 

185. The Midi format was developed in the year ______ 

 a) 1979 b) 1982 

 c) 1992 d) 2001 

186. GIF (Graphic Interchange Format)is limited to-------- bit palette. 

 a)2 b)4 

 c)6 d)8 

187. ------graphics help in rendering the image effectively on the screen. 

 a)Scalar b) Vector 

 c)Linear d)None of these 

188. The expansion for MIDI is ______ 

 a) Musical Instrument Data Interface b) Musical Instruction Digital Interface 

 c) Musical Instrument Digital Interface d) Musical Information Data Interface 

189. The Expansion for AVI is----- 

 a)Audio Video Interleave  b)Audio Video Information 

 c)Actual Video Information d)Audio Visual Information 

190. The AVI format was developed by Microsoft in the year---- 

 a)1979 b)1982 

 c)1992 d)2001 

191. ------files stored in the MP3 format have the extension .mp3 or .mpga 

 a)Video b)Image 

 c)Sound d)None of these 

192. ------files stored in the AVI format have the extension .avi 

 a)Video b)Image 

 c)Sound d)None of these 

193. Files in the Windows Media Format have the extension _______ 

 a).avi b).gif 

 c).wmv d).mov 

194. Files in the QuickTime Format have the extension----- 

 a).avi b).gif 

 c).wmv d).mov 

195. Video files stored in the AVI format have the extension---- 

 a).avi b).gif 

 c).wmv d).mov 

196. ------ is best suited for storing simple graphic images with relatively few colors. 

 a)GIF b)JPEG 

 c)BMP d)None of these 
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197. The SND or Sound format was developed by---- 

 a) Microsoft b) IBM 

 c)Apple d)None of these 

198. The wave format was developed by------and ------- 

 a)Microsoft and IBM b)IBM and Apple 

 c)Apple and Lotus corporation d)Microsoft and Lotus corporation 

199. The files in the AIFF format have the extension------ 

 a).avif b).avi or .aif 

 c).aif or .aiff d)None  of these 

200. The files in the shockwave format have the extension------ 

 a).avi b).aif 

 c).wmv d).swf 

201. Sound files in the MIDI format have the extension------- 

 a).mid or .midi b).mov 

 c).wmf d).wmv 

202. The files in the AU format have the extension------- 

 a).av b).au 

 c).aud d).wmf 

203. The Real Audio/Real Video, The Real Audio format was developed by RealNetworks in 

 a)1985 b)1995  

 c)2000 d)2005 

204. The files in the Real Audio/Real Video format have the extension---- 

 a).ra or .rr b).rm or .ram 

 c).au or .av d)None of these 

205. The AIFF format was developed by-----and------- 

 a)Microsoft b)IBM 

 c)Apple d)None of these 

206. The Shockwave format was developed by _____ 

 a) Microsoft b) IBM 

 c) Apple d) Macromedia 

207. -------has an enormous impact on education. 

 a)Animation b)Multimedia 

 c)Presentation d)None of these 

208. CBT stands for----- 

 a)Computer Brand Tutorials b)Computer Based Tutorials 

 c)Computer Based Training d)Computer Based Tutors 

209. WBT stands for------ 

 a)Web Brand Tutorials b)Web Based Tutorials 

 c)Web Based Training d)Web Based Tutors 

210. ------- tag is used to add in line sound to a web page. 

 a) < bgsound > b) <inline> 

 c) <helper> d)None of these 

211. MPEG stands for ______ 

 a) Movie Pictures Express Group b) Moving Pictures Experts Group 

 c) Model Pictures Experts Group d) Model Pictures Express Group 

212. ------sound format is more popular for transfer of data over internet. 

 a)AIFF b).midi 

 c).au d)Real Audio 

213. -----sound files offer good compression and high quality. 

 a)wave b)au 

 c)mp3 d)midi 

214. There are------kinds of special effects to enhance the animation created. 

 a)2 b)4 

 c)6 d)8 

215. ------ is the extension of sound files stored in the MP3 format. 

 a).mpeg b).mp3 or .mpga 

 c).mpge d)none of these 

216. AIFF stands for----- 

 a)Audio Information File Format b)Audio Interchange File Format 

 c)Audio Interchange Format File d)Audio Information Format File 
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217. There are ----- types of video compressions. 

 a)1 b)2 

 c)3 d)4 

218. -------sound format is very flexible format that can be used for wide range of musical 

 applications. 

 a).wav b)MIDI 

 c).au d)mp3 

219. -----animations are also referred to as slide or path animations. 

 a)Cel-based b)Object-based 

 c)Image-based d)Movie-based 

220. -----animations are usually seen in Computer Games. 

 a)Cel-based b)Object-based 

 c)Image-based d)Movie-based 

221. -----image file format creates a perfect reproduction of the original, while a JPG does not. 

 a).BMP b).GIF 

 c)MPEG d) Shockwave 

222. ------would be helpful in viewing the multimedia presentations. 

 a)Real Player b)Windows Media Player 

 c)Audio Player d)None of these 

223. The two attributes that control the characteristics of sound are---- 

 a)frequency and clarity b)amplitude and frequency 

 c)base and treble d)frequency and base 

224. ----- are typical examples of static images. 

 a)Photographs b)Screen savers 

 c)Wall papers d)None of theses 

225. ------format was developed by Apple primarily to store videos. 

 a)AVI b)Quick Time 

 c)mp3 d)aiff 

226. Most common personal computers are adequate to work with----- 

 a)animation b)multimedia 

 c)database d)music 

227. --------based training is also being extensively used to train and educate children in 

 Schools and Colleges. 

 a)Multimedia b)Internet 

 c)TV d)None of these 

228. ------is a lossy compression of the image. 

 a)Bmp b)JPG 

 c)GIF d)None of these 

229. ------ of the following is called as frequency. 

 a)pitch b)tone 

 c)modulation d)amplitude 

230. ----- is a video file format. 

 a)SND b)MIDI 

 c)MPEG d)None of these 

231. ----- is a an image file format  

 a)SND b)MIDI 

 c)JPG d)None of these 

232. JPEG stands for------ 

 a)Joint Photographic Experts Group b)Joint Paint Express Group 

 c)Joint Paint Experts Group d)Joint Photographic Experts Group 

233. ------- number of attributes control the characteristics of sound. 

 a)1 b)2 

 c)3 d)4 

234. ------sound formats contains only digital notes. 

 a)SND b)MIDI  

 c)JPG d)None of these 

235. ----- of the following is a commercial multimedia content development software. 

 a)StarImpress b)Flash 

 c)StarDraw d)None of these 

236. Sounds and video in multimedia applications can be played------ 

 a)mp3 b)jpg 

 c)inline d)None of these 
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237. Files in the-------format have the extension .swf. 

 a)mp3 b)au 

 c)mpeg d)shokwave 

238. The-------supports full color and produces relatively small file sizes. 

 a)bmp b)jpeg 

 c)gif d)None of these 

239. Two attributes control the characteristics are------and amplitude 

 a)pitch b)tone 

 c)modulation d)frequency 

240. One of the following is a computer based presentation technique is 

 a)Multimedia  b)Data processing 

 c)tutorials d)Slides 

241. Which of the following is widely used to add special effects to movies? 

 a)software b)Hardware 

 c)multimedia d)processor 

242. MMS means----- 

 a)Multimedia service b)Multimedia messaging system 

 c)Multimedia system d)Multimedia messaging service 

243. How many versions of e-learning packages are most commonly used? 

 a)6 b)4 

 c)5 d)2 

244 ----- is the most common versions of e-learning packages. 

 a)CBT/MMS b)WBT/SMSC 

 c)CBT/WBT d)MMS/SMS 

245. ---- is the self-paced learning aids. 

 a)CBT/MMS b)WBT/SMSC 

 c)CBT/WBT d)MMS/SMS 

246. The number of image most commonly used formats are------ 

 a)5 b)4 

 c)3 d)2 

247. Which of the following are the most common types of image formats? 

 a)MP3/MPEG b)GIF/JPG 

 c)JPG/JPEG d)GIF/Nx.View 

248. ------are typical examples of static images. 

 a)Photographs  b)Shockwave files 

 c)MPEG files d)SWF files 

249.  Which file creates a perfect reproduction of the original image? 

 a)JPG b)Nxview 

 c)Shockwave d)GIF 

250. Conversion of Analog waves to digital format is called------- 

 a)Echo b)sound forge 

 c)frequency d)sampling 

251. The number of 2D animations are----- 

 a)2 b)3 

 c)4 d)5 

252. Which of the following animations are also referred to as slide or path animations? 

 a)cel-based animations b)Object-based animations 

 c)3D animations  d)2D or 3D animations 

253. ------- animations are usually seen in compute games. 

 a)object based animation b)Cel-based animation 

 c)Attributes-based animation d)Procedure-based animation 

254. How many step process for creating a 3D animation? 

 a)2 b)4 

 c)3 d)5 

255. ----- is not a step to create 3D animations. 

 a)Modeling b)Animation  

 c)rendering d)Accessing 

256. Which of the following is a technique to blend two or more images to form a new image? 

 a)Warping b)Morphing 

 c)Modeling d)Animation 
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257. How many special effects to enhance the animation created? 

 a)2 b)3 

 c)4 d)8 

258. -----the technique of distorting a single image to represent to something 

 a)Morphing b)Modeling 

 c)Animation d)Warping 

259. ----- is the special effects are added to enhance the created animation. 

 a)Morphing/warping b)Modeling / Morphing 

 c)Warphing/Modeling d)Rendering /Modeling 

260. How many frames per second causes the video to look jerky? 

 a)< 9 b) < 10 

 c) < 15 d) < 20 

261. GIF means _______ 

 a) Graphic Interchange File b) Graphic Interchange Format 

 c) Graphic Information File d) Graphic Information Format 

262. How many bit palate is limited to GIF format? 

 a)16 b)32 

 c)8 d)64 

263. How many attributes control the characteristics of sound? 

 a)2 b)3 

 c)4 d)5 

264. Which of the following are the attributes control the characteristics of sound? 

 a)Lossy and Lossless b)Amplitude and frequency 

 c)Lossy and Amplitude d)Frequency and Lossless 

265. ----- is also  called frequency. 

 a)amplitude b)resistance 

 c)pitch d)modulation 

266. Which of the following is the distance between the rests of the wave? 

 a)Amplitude b)pitch 

 c)modulation d)vector 

267. How many colour depths results in the image looking murky? 

 a)< 255 b)< 16 

 c)< 256 d)< 8 

268. The number of video compressions are------ 

 a)3 b)2 

 c)4 d)6 

269. Which of the following is a technique by which a recurring set of information replaced by  

 a single piece of information? 

 a)Morphing b)warping 

 c)Modeling d)Compression 

270. ----- compression retains the exact image throughout the compression. 

 a)Lossless b)loosy 

 c)Cel-based d)Object-based 

271. ------compression provides some loss of quality. 

 a)Lossless b)Cel-based 

 c)Lossy d)Object-based 

272. Which of the following sound format is command used for transferring music 

information between electronic music devices? 

 a)Wav b)MP3 

 c)MIDI d)AU 

273. Which sound format is a very flexible format that can be used for wide range of musical  

 Application? 

 a)MIDI b)WAVE  

 c)Real Audio d)AU 

274. ----- sound format cannot contain sound.  

 a)WAVE b)AIFF 

 c)AU d)MIDI 

275. -----sound format contains only digital notes. 

 a)AIFF b)AU 

 c)MIDI d)WAVE 

 

 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

276. Which of the following is the extension of MIDI format sound files?  

 a).mid b).midi 

 c).mid and .midi d).mdi 

277. -----format files support both audio and videos. 

 a)MIDI b)AIFF 

 c)Real Audio d)AU 

278. -----sound format is more popular for transfer of data over the internet.  

 a)AIFF b).MIDI 

 c)AU d)Real Audio 

279. The real audio format have the extension----- 

 a).rm or  .rf b).ram or .rf 

 c).rm or .ram d).rm  or .rad 

280. What is the extension of Au format sound file? 

 a).AUD b).AU 

 c).ADU d).Ado 

281. AIFF stands for------ 

 a)Audio Interface format file b)Audio Interchange file format 

 c)AU interchange file format d)Audio information file format 

282. AIFF format was developed by ______ 

 a) Apple b) Real Networks 

 c) Sun Micro System d) Microsoft 

283. What is the extension of AIFF file format? 

 a).aif or .af b).aiff or .aid 

 c).aiff or .aif d).aid or .aif 

284. Which of the following file format is developed by Apple? 

 a)SND/MIDI b)SND/AIFF 

 c)AIFF/MIDI d)AU/SND 

285. What is the extension of the SND file format? 

 a).Sn b).Sdn 

 c).Sou d).snd 

286. Which sound format file was developed by IBM and Microsoft? 

 a)MIDI b)AV 

 c)Wave d)AIFF 

287. What is the extension the Wave format file has? 

 a).wva b).wav 

 c).wave d).dat 

288. Which sound files offer good compression and high quality ? 

 a) MP3 b) Wave 

 c) AIFF d) MIDI 

289. ----- is the extension of sound files stored in the MP3 format. 

 a).mp or .mag b).mp3 or mpga 

 c).mpga or .mpag d).mpg 

290. What is the extension of video files stored in the MP3 format? 

 a).mp3 or .mpeg b).mpeg or .mpga 

 c).mpge or .mpag d).mpg or .mpeg 

291. What is the extension when AVI format files are stored? 

 a).AV b).AU 

 c).AVI d).AIV 

292. Files in the windows media format have the extension------ 

 a).wmv b).wma 

 c).wmf d).wam 

293. What is the extension when Quick timer format file is stored? 

 a).qtf b).wmv  

 c).mov d).wam 

294. Which sound format was developed by Macromedia? 

 a)quick time b)shock wave 

 c)Wave dAIFF 

295. Which of the following is the extension of shockwave format sound files? 

 a).snd b).swf 

 c).sfw d).snf 
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296. Which of the following is not a commercial multimedia content development software? 

 a)Flash b)Dream viewer 

 c)Mayajal d)All of these 

297. Sounds and video in multimedia applications can be played by using ______ 

 a) inline or helper b) inline or outline 

 c) helper or outline d) inline only 

298. Which tag is used to add inline sound to a web page? 

 a) < inline >  b) < bgsound> 

 c)<sound> d) <helper> 

299. Which of the following tag is used to launch helper applications? 

 a) <embed>/<applet> b)<applet>/<object> 

 c)< embed>/<applet>/<object> d)<embed>/<object> 

300. How many tags are used to launch helper applications? 

 a)2 b)3 

 c)4 d)6 
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PRESENTATION 

 

I. Choose the Correct Answers :-      

1. Which of the following are one of the most powerful and effective ones? 

 a)Documents b)Worksheets 

 c)Presentations d)Databases 

2. Which command is used to create a new Impress from within any Star Officeapplication? 

 a)File Presentations b)File New Presentations 

 c)File New Presentations d)File Presentations New 

3. How many options are displayed in presentation Wizard to create an empty presentation? 

 a)4 b)5 

 c)2 d)3 

4. Which page of the Wizard allows to select a background for all the slides in the  

 Presentation? 

 a)First b)Second 

 c)Third d)Fourth 

5. Which pages of the Wizard allows to specify the transition effect to be used for 

 the presentation? 

 a)First b)Second 

 c)Third d)Fourth 

6. Which key is used to create a new presentation using a template? 

 a)Shift+Alt+N b)Shift+Ctrl+N 

 c)Ctrl+Alt+N d)Shift+Tab+N 

7. Which command is used to create a new presentation using a template? 

 a)File New Templates b)File New Presentation and Templates 

 c)File Templates and Documents d)File New Templates and Documents 

8. Which pane displays the slides in the presentation? 

 a)Left b)Right 

 c)Middle d)Top 

9. How many panes in the middle pane of presentation and Templates pane? 

 a)2 b)3 

 c)4 d)5 

10. Which slides pane displays a thumbnail image of the slide? 

 a)Left b)Right 

 c)Middle d)Bottom 

11. How many tabs are there in the left pane to view the presentation in different formats? 

 a)2 b)3  

 c)4 d)5 

12. Which of the following view allows to create and edit slides? 

 a)Normal b)Outline 

 c)Notes d)Handouts 

13. Which of the following view used by a presenter to add additional information to a slide? 

 a)Normal b)Outline 

 c)Handouts d)Slide sorter 

14. Which view allows to scale the slides so that the slides can fit into a page? 

 a)Normal b)Outline 

 c)Notes d)Handouts 

15. Which view allows to view miniature images of all the slides in the presentation? 

 a)Slide sorter b)Handouts 

 c)Outline d)Normal 

16. Which page can be used to specify basic background information that to be  

 Included in all the slides? 

 a)Master b)Layouts 

 c)Custom animation d)Slide transition 

17. Which key is used to save presentation? 

 a)Ctrl+S b)Alt+S  

 c)Shift+S d)Ctrl+Alt+s 

18. Which command is used to start a presentation? 

 a)File a Slide show b)Slides show a Slideshow 

 c)Slide show a  Show slide d)View a Slide Show  
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19. Which key is used to start a presentation? 

 a)F2 b)F5 

 c)F7 d)F11 

20. Which key is used to end a presentation?    

 a)Esc b)Alt 

 c)Shift d)Tab 

21. Which command is used to insert a picture in slide? 

 a)Insert picture b)Format Picture 

 c)Insert Picture From file d)Insert From file Picture 

22. Which command is used to insert a movie in a slide 

 a)Insert Movie b)File Movie and Sound 

 c)Insert Movie and Sound d)Edit Movie and Sound 

23. Which command is used to open a Media player window? 

 a)File Media player b)Insert Media player 

 c)Tools Media Player d)File Open a Media Player 

24. Which command is used to assign slide transition effects to slides is in slide view? 

 a)View Tool bars  Slide view b)Insert Slide view 

 c)Insert Toolbars Slideview d)View Slide view Tool bars 

25. Which command is used to change the background color of all the slides? 

 a)Format Background b)Format Page Background 

 c)Format Page d)Insert Page Background 

26. Which key is used to open the styles and formatting window? 

 a)F2 b)F5 

 c)F7 d)F11 

27. Which command is used to open custom slide shows? 

 a)Slide show Custom slide shows b)Tools Custom slide shows 

 c)Insert Slide show Custom d)Slide show Custom Slide shows 

28. Which key is used to select a range of slides? 

 a)Ctrl b)Alt 

 c)Shift d)Tab 

29. Which command is used to start a slide show from the current slide? 

 a)File Options Star Office Impress General 

 b)Tools Options Star Office Impress  General 

 c)Inser a Options Star Office Impress General 

 d)View Options Star Office Impress General 

30. Which command is used to hide a slide? 

 a)Tools Hide slide b)Tools Show /Hide slide 

 c)Slideshow Show/Hide slide d)Slideshow Hide slide 

31. Which command is used to show a hidden slide? 

 a)Tools show slide b)Slideshow Show/Hide slide 

 c)Slideshow show slide d)View Slide 

32. Which of the following command settings override the default printer options? 

 a)Tools Print b)Tools Options Print 

 c)File Print d)View Options Print 

33. Which key is used to print in star office? 

 a)Alt+p b)Ctrl+p 

 c)Shift+p d)Shift+Ctrl+p 

34. Which command is used to reduce the size of a slide to be print? 

 a)Insert page b)File Print Page 

 c)Tools Page d)Format Page 

35. Which command is used to open Navigator? 

 a)File Navigator b)Tools Navigator 

 c)Edit Navigator d)Insert Navigator 

36. Which command is used to open HTML Export window? 

 a)File Export b)Tools Export 

 c)Insert Export d)File Open Export 

37. A ----- is a series of pages that are present information on specific topic 

 a)Presentation b)Slide show 

 c)Animation d)Morphing 
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38. ------ is used preview movie or sound file in a slide 

 a)Slide show b)Presentation 

 cMedia player d)none ofhtese 

39. A ----slide determines the text formatting style for the title and outline 

 a)Slave b)Mastere 

 c)New d)Template 

40. By pressing ----key in the keyboard the view of the slide can be enlarge 

 a)F1 b)F3 

 c_)F5 d)F7 

41. -----gives effect to an object in a slide. 

 a)Custom animation effects b)Movies 

 c)Pictures d)Sound & Graphics 

42. A-----can be created from scratch or form using a template. 

 a)Slide show  b)Presentation 

 c)Animation d)None of these 

43. -----window allows us to quickly jump from one slide to other slide or move  

 Between open files 

 a)Desktop b)Navigator 

 c)Preview d)None of these 

44. ---- key is used to select a range of slides.  

 a)Alt b)Shift 

 c)Ctrl d)Del 

45. ----command is used to open the Navigator 

 a)View navigator b)file navigatror 

 c)Insert navigator d)format editor 

46. To insert a new slide, choose-------from the menu bar 

 a)View Slide b)Insert Slide 

 c)File Add slide d)Format Slide 

47. -----show allows you to display important slides during a presentation 

 a)Slide b)Custom slide 

 c)Mater slide d)Slave 

48. ----command is used to reduce the size of a slide to be print 

 a)File page b)Eidt page 

 c)View page d)Format Page 

49. Which key is used to select a range of slides? 

 a)Ctrl b)Alt 

 c)Shift d)Tab 

50. -----command is used to a hide a slide 

 a)Tools Hide Slide b)Slide show Hide 

 c)Slide show Hide/Show d)slide show Hide slide 

51. -----command is used open Media player window 

 a)Insert Media player b)File Media player 

 c)Tools Media player d)File Open Media player 

52. -----Key is used to select multiple slides. 

 a)Ctrl b)Alt 

 c)Shift d)Shift+tab 

53. ------view allows you to create and edit slides. 

 a)Normal b)Outline 

 c)Notes d)Handouts 

54. -----key is used to end the presentation 

 a)Tab b)Esc 

 c)Shift d)Alt 

55. -----key is used to save the presentation 

 a)F1 b)Ctrl+S 

 c)Alt+S d)Shift+S 

56. Insert-----is used to import objects from other applications 

 a)formula b)Chart 

 c)Object d)Graph 

57. Insert-----is used to insert a formula into the presentation 

 a)Formula b)Chart 

 c)object d)Graph 
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58. -----option allows to manually control the transition of slides. 

 a)Automatic b)Optional 

 c)Default d)Manual 

59. In ----veew all the slides show effects can be assigned to the slide 

 a)Normal  b)Outline 

 c)Notes d)Handouts 

60. To apply a new slides design------is selected 

 a)Tools Slide design b)Format Slide design 

 c)File Slide design d)Edit Slide design 

61. To print slide notes -----is chosen 

 a)file print b)Format print 

 c)edit print d)Edit print 

62. To create a new presentation using a template----is selected 

 a)Ctr+N b)Shift+ctrl+N  

 c)Alt+N d)Ctrl+F+N 

63. The----command settings override the default printer options 

 a)file print b)format print 

 c)edit print d)edit print 

64. To insert an object in a slide-----is chosen 

 a)Insert chart b)Insert object 

 c)Tools object d)View object 

65. ----displays various transition effects that can be attached to a slide 

 a)coustom animation b)slide transition 

 c)animal effectual d)slide sorter 

66. Presentaion settings can be adjusted using---- 

 a)show show settings b)slide show slide show setting 

 c)file show setting d)file slide show settings 

67. To insert a slide------is chosen 

 a)File  Slide b)Insert Slide 

 c)Edit New slide d)Tools Slide 

68. To change the background of the slide-------is chosen 

 a)File Slide Background b)Format Pgae Background 

 c)File Page Background d)Format Slide Background 

69. -----command is used to open HTML Export window 

 a)Tools Export b)File Export 

 c)View Export d)Format Export 

70. Using-------we can view preview movie and sound files.  

 a)Movie player b)Media player 

 c)Sound player d)Song player 

71. To rename the slide-------is chosen. 

 a)Slide Rename slide b)File Rename slide 

 c)View Rename slide d)Format Rename slide 

72. ------is used insert applet into the presentation 

 a)Insert applet b)View Applet 

 c)File Insert Applet d)Tools Applet 

73. -----imbedded in StarImpress supports different audio and video files 

 a)Movie player b)Media player 

 c)sound player d)Song player 

74. To start the Slide show-----button is pressed. 

 a)F1 b)F3 

 c)F5 d)F7 

75. To delete the selected slide, right click is made and------is chosen 

 a)Delete b)Delete slide 

 c)Remove d)Remove slide 

76. ------are one of the most effective one‘s to communicate. 

 a)Charts b)Graph 

 c)Presentation d)Text 

77. In a-- we can include variety of items such as text, audio, hand-drawn images and Videos 

 a)tables b)applications 

 c)software d)presentation 
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78. -----is the StarOffice application that allow us to create attractive and professional 

 looking presentation. 

 a)StarOffice impress b)StarOffice Base 

 c)StarOffice Calc d)StarOffice writer 

79. StarOffice Impress allows us to professionally crate-------presentation 

 a)impressive b)attractive 

 c)professional looking d)effective 

80. Staroffice Impress provides various------that allows us to save and modify presentation 

 a)tools b)tool tips 

 c)tool names d)objects 

81. StarOffice Impress allows us to print the presentation as 

 a)hard copy b)charts 

 c)slides d)handouts 

82. StarOffice Impress allows us to modify and view presentation as---- 

 a)slides b)slide pages 

 c)slide shows d)slide sorter 

83. StarOffice Impress allows us to----and modify Microsoft Power Point presentation 

 a)import b)export 

 c)report d)entrepot 

84. In the StarOffice Impress presentation regard there are----options. 

 a)1 b)2 

 c)3 d)4 

85. We can see the options an empty presentation in the-----of the presentation. 

 a)first page b)second page 

 c)third page d)fourth page 

86. Use a-------template to create a presentation from the presentation wizard. 

 a)created  b)pre-created 

 c)post-created d)creates 

87. Which page of the presentation wizard allows us to select a background for all slides? 

 a)first page b)second page 

 c)third page d)fourth page 

88. A drop-down list on the left provides----categories. 

 a)1 b)2 

 c)3 d)4 

89. A----below the background category displays different background in that category 

 a)drop down list b)list box 

 c)combo box d)text box 

90. ----box on the right allows us to view with the selected background 

 a)View b)Large view  

 c)Preview d)Small view 

91. Select an/a----medium to specify the final output medium for the presentation 

 a)paper b)output 

 c)input d)imput/output 

92. The third page of the presentation wizard allows us to specify------effects. 

 a)transition b)slide 

 c)preview d)page 

93. To choose the transmission effect and----for the slides 

 a)duration b)speed 

 c)time d)accuracy 

94. Select a -----transition section at the top of the page 

 a)logo b)page 

 c)slide d)presentation 

95. Select the----type section of the page to specify the type. 

 a)logo b)page 

 c)slide d)presentation 

96. The presentation type section specifies the transition should be----or ------ 

 a)enter, click b)click, manual 

 c)manual, automatic d)automatic, enter 

97. The----option allows us to manually control the transition of slides. 

 a)default b)duration 

 c)key press d)click 
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98. The-----option allows us to specify the duration for each slide. 

 a)manual b)automatic 

 c)default d)click 

99. Automatic option automatically--------through the slides at the specified speed 

 a)flick b)flippant 

 c)flip d)pass 

100. ------ of page spin box allows us to specify the duration of a specified file 

 a)time b)length 

 c)interval d)duration 

101. Checking the-----check box will display the message created with StarOffice 

 a)show logo b)click logo 

 c)crate logo d)paste logo 

102. StarOffice Impress provides several------presentation format 

 a)multiple b)defaulting 

 c)default d)permanent 

103. The easiest way of creating a presentation is to------one and then modifies that 

 a)select b)choose 

 c)use d)pick 

104. The advantage of using the----is that already contains slides with content outlines. 

 a)layout b)design 

 c)system d)format 

105. Using the format available we can populate to quickly------presentation 

 a)build b)construct 

 c)present d)crates 

106. A------is the top of the window 

 a)menu bar b) tool bar 

 c)status bar d)title bar 

107. A----is at the bottom of the screen which displays the information 

 a)menu bar b)tool bar 

 c)status bar d)title bar 

108. In the-------pane displays the slides in the presentation 

 a)left b)middle 

 c)right d)centre 

109. The slides pane on the left displays a-----image of the slide 

 a)large b)small 

 c)filmstrip d)thumbnail 

110. To create an edit slides-----view is used 

 a)master page b)normal 

 c)notes d)outline 

111. -----view allows us to recorder, slide edit ------ slide------ title and heading. 

 a)Normal b)notes 

 c)Handouts d)Outline 

112. ----view are typically used by a presenter to add additional information to a slide 

 a)Notes b)notes 

 c)Outline d)Layouts 

113. To scale the slides to fit into a page------view is used 

 a)master page b)layouts 

 c)handouts d)outline 

114. When the presentation is to be printed and distributed as-----view is typically used 

 a)master page b)handouts 

 c)layouts d)outline 

115. The slides sorter view is also used to----slides 

 a)arragen b)re-arrange 

 c)shuffle d)snap 

116. The----pane on the slide sorter view allows us to specify the object on our slide 

 a)design                  b)work    c)tasks  d)master 

117. The task pane on the right displays------pages on the slide sorter view 

 a)one b)two  

 c)three d)four 
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118. -----page can be used to specify basic background information that needs to be included 

 In all the slides 

 a)Master b)Layouts 

 c)Custom d)Slide transition 

119. We can choose a-------while creating a new slide 

 a)notes b)layouts 

 c)outline d)custom 

120. Which allows us to control the transition of the slides? 

 a)master page b)layouts 

 c)custom animation d)Slide transition 

121. We can have different-------for each slide in the presentation 

 a)animation b)transition 

 c)custom d)layout 

122. The on-screen presentation starts automatically in the------screen mode 

 a)back b)front  

 c)full d)half 

123. The -----slide will be displayed preceded by the defined transition effects. 

 a)first b)second 

 c)third d)fourth 

124. After the last slide, we will see a------slide 

 a)empty b)grey 

 c)white d)balck 

125. End the presentation by pressing the-----key 

 a)Enter b)Space 

 c)Escape d)Win 

126. Select-------if we want to display all the slides as slide show 

 a)all slides b)slide show 

 c)custom slide d)run 

127. Select -------option from which we want to display the slide show 

 a)slide b)from 

 c)show d)all 

128. To insert a slide, click the------button in the presentation toolbar 

 a)slide b)insert 

 c)add d)new 

129. The----slide uses the page layout to the previous slide 

 a)add b)insert 

 c)new d)next option 

130. To change the slide order, click the-----option in the switching presentation view 

 a)custom slide b)slide sorter 

 c)sort slide d)slide 

131. In the slide sorter mode, all slides in the presentation documents are displayed in the 

 -----size 

 a)normal b)usual 

 c)reduced d)regular 

132. A vertical ------indicates the position where the slide will be inserted 

 a)black bar b)line 

 c)pointer d)white bar 

133. To insert a picture click on------from the insert toolbar 

 a)insert slide b)insert object 

 c)insert picture d)insert from file 

134. To play the movie/sound click on------icon for the movie/sound file on the slide 

 a)object b)tool 

 c)slide d)play 

135. The current playback position in the file is indicated on the -----slider 

 a)right b)left 

 c)center d)top 

136. To use the -----slider to adjust the playback volume 

 a)right b)left 

 c)center d)top 
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137. For movie files, the bar contains a list box where we can select the-----factor for the 

 Playback 

 a)slide b)view 

 c)display d)zoom 

138. Pause icon pauses or-----the playback of the current file, in a slide show 

 a)retrieve  b)resume 

 c)recover d)replay 

139. Postion-----moves to different position in thefile 

 a)slider b)marker 

 c)player d)recorder 

140. -----icon turns sound off and on 

 a)Quiet b)Silent 

 c)Mute d)Voiceless 

141. ----adjusts the size of the movie playback 

 a)Slide b)View 

 c)Display d)Zoom 

142. The -----supports many different media formats 

 a)movie player b)media player 

 c)music player d)media playback 

143. To insert an object in a slide, choose an object from 

 a)insert object b)insert OLE 

 c)insert import d)insert formula 

144. Insert------object is used to import objects from other application into a presentation 

 a)ODBC b) OLEDB 

 c)OLE d)DBMS 

145. The easiest way to assign slide transition effect of slides is in------view 

 a)custom b)slide 

 c)slide sorter d)notes 

146. In slide view we can select the number of slides to be listed in----spin box 

 a)slides per row b)slides per line 

 c)slides in row d)slides in line 

147. The objects in our slide can have various 

 a)view b)actions 

 c)zooms d)effects 

148. Before applying the effect in custom animation we must first select the 

 a)picture  b)object 

 c)tool d)control 

149. We can also have our object----the custom animation, on the Entrance tab 

 a)peep in b)peep out 

 c)fade in d)fade out 

150. We can also have the object------in the custom animation on the Exit tab 

 a)peep in b)peep out 

 c)fade in d)fade out 

151. Background fill option is applied to the slide using------dialog box 

 a)background d)page 

 c)page setting d)background fill 

152. A----slide determines the appearance for all of the slides in the presentation 

 a)master b)start 

 c)top d)begin 

153. We can change the appearance of a master slide by applying a -----slide design 

 a)rear b)fresh 

 c)new d)simple 

154. To apply the slide design to all of the slides in our presentation select the--- 

 Background page check box 

 a)change b)exchange 

 c)revert d)new 

155. To apply the slide design to the current slide only,-----the exchange background page 

 Check box--- 

 a)clear                            b)select     c)change d)review 

156. In the slide design window, clicking on load will take us to load----window 

 a)slide style b)style design 

 c) design slide d)slide design 
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157. Along with slide design we can also assign a whole set of-----styles to our slides 

 a)proper b)precise 

 c)pre-defined d)presentation 

158. Open the style list to see a list of the----styles 

 a)proper b)precise 

 c)pre-defined d)presentation 

159. The styles outline----through outline------enables us to give the outlined headings 

 and topics on our slides a uniform look. 

 a)1, 9 b)1, 8 

 c)1, 7 d)1, 6 

160. Open a new, empty presentation with a slide layout that allows----levels 

 a)handout b)outline 

 c)normal d)notes 

161. The slide layout called-----is suitable 

 a)‖Title, Text‖ b)‖Text,Top‖ 

 c)‖Top,Title‖ d)‖Title,Title‖ 

162. The ----- use to choose determines the number of outline levels 

 a)slide show  b)slide style 

 c)slide layout d)slide outline 

163. -------the outline view mode by choosing menu view---- outline view 

 a)Activate b)Applying 

 c)Begin d)Initiate 
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VOLUME – II 

(OBJECT TECHNOLOGY)
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OBJECT ORIENTED CONCEPTS USING C++ 

Class: XII-Std               

 

I. Choose the Correct Answers :-      

1. Which is the tool to solve a wide range of problems? 

 a) Computer b)data 

 c) Variables d) programs 

2.  The solution to the problem are in the form of 

 a)Computer programs b)Application software 

 c)Data items d)both a and b 

3. Which operates on a set of  known input data items? 

 a)Computer programs b)Application software 

 c)Computer d)All of these 

4. In early programming languages the input and output data items were represented as 

 a)variables b)Control statements 

 c)Data d)All of these 

5. Which statement provided a way of instructing the computer, the operations to be  

 Performed on the data item? 

 a)variable b)control  

 c)input d)output 

6. In object oriented programming (OOP) languages the solution to the problem were  

 Viewed in 

 a)Two ways b)Three ways 

 c)Four ways d)Many ways 

7. Which were viewed as a separate segment in OOP? 

 a)Data & variables b)Data & operations 

 c)Data & control d)All 

8. Which OOP language deals with complex aspects of real life? 

 a)PASCAL b)C++ 

 c)BASIC d)SQL 

9. What is the orientation of C++? 

 a)Procedure b)Object 

 c)structured d)All 

10. C++ is an 

 a)Structured programming language b)Modular programming language 

 c)Object oriented programming language d)Procedural programming languages 

11. Which is split into smaller groups such that a set operations can be performed on it  

 without calling function? 

 a)Set of data items b)Set of variables 

 c)Set of control statements d)Subprograms 

12. OOP facilitates the way of problem solving by combining 

 a)Data & variables b)Data & operations 

 c)Data & control d)Data & functions 

13. The group of data and the operations together are termed as 

 a)Object b)Encapsulation 

 c)both a & b  d)state 

14. Which represents the behavior of an object? 

 a)State b)Data 

 c)Operation d)Function 

15. The physical feature of an object is represented as 

 a)State b)Data 

 c)Operation d)Function 

16. The kind of function in an object is called as 

 a)State b)Behaviour 

 c)Operation d)Function 

17. In an object the operation represents the 

 a)State b)Behaviour  

 c)Data d)Function 

18. Which is the group of related function and data that serves the functions? 

 a)Object b)Class 

 c)Behaviour d)State 
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19. A kind of self-sufficient ―subprogram‖ with a specific functional area 

 a)Object b)Class 

 c)Encapsulation  d)state 

20. The process of grouping data and its related function into unit is called as 

 a)an object b)an encapsulation 

 c)an abstraction d)a polymorphism 

21. Objects paves way for 

 a)Object b)encapsulation 

 c)abstraction d)Polymorphism 

22. Which is the mechanism that bound data and function together within an object 

 Definition? 

 a)Inheritance b)encapsulation 

 c)abstraction d)Polymorphism 

23. Which makes it easy to represent real system in software programs? 

 a)Object b)encapsulation 

 c)abstraction d)Polymorphism 

24. The ability of an object to respond differently to different messages is called as 

 a)Inheritance b)encapsulation 

 c)abstraction d)Polymorphism 

25. Which defined function accepts different inputs to draw different shapes 

 a) draw ( ) b)star ( ) 

 c) stop ( ) d)none of these 

26. Which function is defined to draw a square? 

 a)draw(side) b)draw(length, breath) 

 c)draw(radius) d)draw(radius,start_angle,end_angle) 

27. Which function is defined to draw a rectangle? 

 a)draw(side) b)draw(length,breath) 

 c)draw(radius) d)draw(radius,start_angle,end_angle) 

28. Which function is defined to draw a circle? 

 a)draw(side) b)draw(length,breath) 

 c)draw(radius) d)draw(radius,start_angle,end_angle) 

29. Which function is defined to draw an arc? 

 a)draw(side) b)draw(length,breath) 

 c)draw(radius) d)draw(radius,start_angle,end_angle) 

30. The differential response of the function based on different input is called as 

 a)Inheritance b)encapsulation 

 c)abstraction d)Polymorphism 

31. Which data type conventionally represents an object in the real world? 

 a)Object b)Class 

 c)Encapsulation d)polymorphism 

32. Which is the template for entities that have common behavior? 

 a)Object b)Class 

 c)Encapsulation d)inheritance 

33. The process of creating new data types from existing data type is called as 

 a)Object b)Class 

 c)Encapsulation d)inheritance 

34. The process of acquiring the base class properties is called 

 a)Object b)Class 

 c)Encapsulation d)inheritance 

35. The base class commonly represented as 

 a)Derived class b)parent class 

 c)sub class d)all of these 

36. Which of the parent class does the sub group share? 

 a)Data b)variables 

 c)properties d)all of these 

37. The sub group of the base class is called as the 

 a)Derived class b)parent class 

 c)sub class d)all of these 

38. In the examples animals, reptiles, amphibians, which are the derived classes? 

 a)Animals and amphibians  b)Animals and reptiles 

 c)Reptiles and amphibians d)Amphibian only 
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39. Which increases the functionality of a derived class and also promotes reusability of code  

    Of the base class? 

 a)Object b)Class 

 c)Encapsulation d)Inheritance 

40. In the examples  VEHICLE, AUTOMOBILES, PULLED, VEHICLES, which is the 

   Base class? 

 a)Vehicle b)Automobile 

 c)pulled vehicles d)all of these 

41. In OOP, the properties received from an ancestor is called as 

 a)Object b)Class 

 c)Encapsulation d)Inheritance 

42. Which advantage of OOP provides security to the data? 

 a)Data hiding b)Abstraction 

 c)inheritance d)Either a or b 

43. Which feature cannot access the unrelated member function? 

 a)Abstraction  b)class 

 c)Encapsulation d)Inheritance 

44. The act of revealing the essential feature of an object and curtailing the background 

 detail is called as 

 a)Abstraction b)Class 

 c)Encapsulation d)Inheritance 

45. Which advantage of OOP reduces the software complexity? 

 a)Inheritance  b)Class 

 c)Encapsulation d)Polymorphism 

46. Which advantage of OOP allows a class to be derived from an existing class? 

 a)Inheritance  b)Class 

 c)Encapsulation d)Polymorphism 

47. Which promote insertion of updated modules to meet the requirements of the  

 Dynamic world? 

 a)Inheritance b)Class 

 c)Encapsulation d)Polymorphism 

48. Which communicate with one another by sending data as input? 

 a)Objects b)Class 

 c)Encapsulation d)Polymorphism 

49. Which are the key factors of OOP? 

 a)State and behavior b)Function and object behavior 

 c)Function and state d)All of these 

50. Which model entities in the real world? 

 a)Object  b)Class 

 c)Encapsulation d)Polymorphism 

51. ---- is a tool to solve a wide range of problems. 

 a)Computer b)Calculator 

 c)Abacus d)CPU 

52. The solutions to the problems are in the form of computer program or--- 

 a)system software b)application software 

 c)hardware d)humanware 

53. Which one operates on a set of known Input data items? 

 a)Computer program b)Humanware 

 c)system d)output data 

54. The program transforms ----- into a set of expected data items. 

 a)input data b)output data 

 c)variable d)application program 

55. The set of expected data items must be the---------of the computer program. 

 a)input b)output 

 c)processing data d)raw data 

56. The input and output data items are represented as--------- 

 a)constant b)data 

 c)variables d)string 

57. -----statements provide instructions to the computer on the operations that need to be 

 Performed on the data items.  

 a)Control b)Assignment 

 c)Looping d)Unconditional 
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58. Object oriented programming language is 

 a)C++ b)BASIC  

 c)COBOL d)visual BASIC 

59. A group of data and the operations are termed as 

 a)object b)data 

 c)function d)operation 

60. The operations represent the------of the object. 

 a)behavior b)data 

 c)state d)function 

61. In a calculator its state refers to its------features like dimensions, buttons, display screen 

 Operators and the like. 

 a)physical b)behavior 

 c)function d)data 

62. In a calculator, its behavior refers to the kind of ------it can perform like addition,  

subtraction, storing and erasing in memory. 

 a)function b)state 

 c)operation d)object 

63. An object is a kind of self sufficient------with a specified functional area. 

 a)program b)sub-program 

 c)functions d)object 

64. The mechanism by which the data and functions are bound together within an object 

 is called as---- 

 a)overloading b)overriding 

 c)encapsulation d)polymorphism 

65. What are the functions when calculator is an object in Oop‘s language? 

 a)Addition (  ) b)Result 

 c)Operator d)Number 

66. What are the data when calculator is an object Oop‘s lanugagte? 

 a)result, operator b)subtraction  

 c)display result d)erase memory 

67. The function ------- is defined to draw a square. 

 a)Draw(side) b)Draw(radius) 

 c)Draw(length, bredth) d)Draw(angle) 

68. The function------ is defined to draw a rectangle. 

 a)Draw(side) b)Draw(length, breadth) 

 c)Draw(angle) d)Draw(radius) 

69. The function---------is defined to draw a circle. 

 a)Draw(side) b)Draw(radius) 

 c)Draw(angle) d)Draw(length) 

70. The function draw( ) used to draw different objects with different inputs is called---- 

 a)polymorphism b)function 

 c)draw ( ) d)overriding 

71. The ability of an object to respond differently to different messages, is called----- 

 a)function b)polymorphism 

 c)draw( ) d)encapsulation 

72. ----- is a template for entities that have common behavior  

 a)Class b)Polymorphism 

 c)Object d)Data 

73. The process of acquiring Base class properties is called---- 

 a)inheritance b)class 

 c)polymorphism d)encapsulation 

74. The------are power packed, as they include the functionality of the base class along 

 with its own unique feature. 

 a)derived classes b)base class 

 c)class d)object 

75. -----allows a class to be derived from an existing class 

 a)Polymorphism b)Inheritance 

 c)Encapsulation d)Object 

76. ____ is an example for Object oriented language. 

 a)C b)BASIC 

 c)C++ d)None of these 
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77. A(n)------ is a kind of self-sufficient ―subprogram‖ with a specific functional area 

 a)Entity b)Object 

 c)Overloading d)None of these 

78. The process of creating new data types from existing data type is called----- 

 a)Inheritance b)Polymorphism 

 c)Overloading d)Encapsulation 

79.  Binding of data and member functions together is called--- 

 a)Inhertiance b)Polymorphism 

 c)Overloading d)Encapsulation 

80. -----promotes reduces software complexity.  As multiple definitions are permitted to 

 an operator or function. 

 a)Inheritance b)Polymorphism 

 c)Overloading d)Encapsulation 

81. -----allows a class to be derived from an existing class. 

 a)Inheritance b)Polymorphism 

 c)Overloading d)Encapsulation 

82. The mechanism by which the data and functions are bound together within an object 

 definition is called------- 

 a)Inheritance b)Polymorphism 

 c)Overloading d)Encapsulation 

83. ----provides security to data as unrealed member functions can not access its data 

 a)Abstraction b)Inheritance  

 c)Polymorphism d)Encapsulation 

84. ------data type allows programs to organize as objects that contain both data and  

 Functions. 

 a)int b)class 

 c)String d)Object 

85. The ------classes are power packed as they include the functionally of the class of the  

 Base class. 

 a)Super b)derived 

 c)parent d)None of these 

86. The data type------ represents an object I real world. 

 a)int b)class 

 c)string d)object 

87. The process of acquiring base class properties is called----- 

 a)Inheritance b)Polymorphism 

 c)Overloading d)Encapsulation 

88. ----programming facilitates the way of problem solving by combining ‗data‘ and 

‗operations‘ that are to be performed on the data. 

 a)Structured b)Object oriented 

 c)Visual d)None of these 

89. A(n)------attempts to capture a real world object in a program. 

 a)Entity b)Object 

 c)Overloading d)None of these 

90. ----communicate with one and another by sending data as inputs. 

 a)Entities  b)Classes 

 c)Overloading d)objects 

91. In computer, the solutions to the problems are in the form of 

 a)operations b)programs 

 c)entities d)objects 

92. ----- is a group of related functions and data. 

 a)Entity b)Object 

 c)Overloading d)None of these 

93. ----- is template for entities that have common behavior. 

 a)Entity b)class 

 c)String d)Object 

94. ------were used to represent the input and output data items in the early programming 

 Languages. 

 a)Objects                      b)Entities       c)Variables d)None of these 

95. A group of data and operations are terms as------ 

 a)Inheritance b)class 

 c)String d)Object 
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96. ------ is an example for structured programming language. 

 a)C b)BASIC 

 c)C++ d)None of these 

97. C++ is a ------ programming lanugae. 

 a)Structrured b)Object oriented 

 c)Visual  d)None of these 

98. Pascal is a------programming language. 

 a)Structured b)Object oriented 

 c)Visual d)None of these 

99. How many segments were realized that viewing the solution of a problem? 

 a)1 b)2 

 c)3 d)4 

100. ------ was realized that viewing the solution of a problem 

 a)Inheritance b)Encapsulation 

 c)Data and Operations d)None of these 

101. -------represents the behavior of the object. 

 a)Operation b)data 

 c)Entity d)Object 

102. -----programming solves the problem by combining data and operations that are to be 

 Performed on the data 

 a)Structured b)Object oriented 

 c)Visual d)None of these 

103. Data hiding is called as----- 

 a)Abstraction b)Inheritance 

 c)Polymorphism d)Encapsulation 

104. -----group the data and its related functions into units. 

 a)Abstraction b)Objects 

 c)Polymorphism d)Encapsulation 

105. ------ is the key factor of Object oriented programming language 

 a)Objects and classes b)Data and operations 

 c)Functions and object behavior d)None of these 

106. Computer is a tool to solve a wide range of---------- 

 a)problems b)programs 

 c)application d)software 

107. The solutions to the problems are in the form of computer programs or application---- 

 a)hardware b)software 

 c)freeware d)shareware 

108. Software are written in-----language. 

 a)selected b)optional  

 c)any d)free 

109. A computer program operates on a set of known-------data items. 

 a)input b)output 

 c)software d)hardware 

110. The program transforms the----data into a set of expected data items. 

 a)input b)output 

 c)software d)hardware 

111. The set of expected data items must be the ------- of the computer program. 

 a)input b)output 

 c)software d)hardware 

112. In the early programming languages the input and output data items were represented 

 As----a)constant b)variable 

 c)float d)integer 

113. ------statements provided a way of instructing the computer on the operations that need 

 to be performed on the data items. 

 a)arithmetic b)relational 

 c)control d)logical 

114. Programming languages help us in organizing our ideas about the solution of the ---- 

 a)problems  b)programs 

 c)application d)software 

115. The solution of a problem can be viewed as---separate segments. 

 a)1 b)2 

 c)3 d)4 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

116. Object oriented programming languages normally deal with the ----- aspects. 

 a)simple b) complex 

 c)complicated d)easy 

117. The group of data and the operations are termed as---- 

 a)function b)object 

 c)class d)method 

118. The operation represent the------of the object. 

 a) fact b)variable 

 c)behavior d)state 

119. The process of grouping data and its related functions into units is called as 

 a)inheritance b)encapsulation 

 c)class d)polymorphism 

120. Same function name given to more than one function is called----- 

 a)inheritance b)encapsulation 

 c)class d)polymorphism 

121. Class is a template for entities that have common----------- 

 a)fact b)variable 

 c)behavior d)state 

122. The process of acquiring Base class properties from derived class------ 

 a)inheritance b)encapsulation 

 c)abstraction d)polymorphism 

123. -------- increases the functionality of a derived class and also promotes reusability of code 

 a)inheritance b)encapsulation 

 c)data hiding  d)polymorphism 

124. Data hiding or Abstraction of data provides------- to data. 

 a)lock b)security 

 c)application d)usage 

125. ------promotes reduces software complexity. 

 a)inheritance b)encapsulation 

 c)abstraction d)polymorphism 
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OVERVIEW OF C++ 

 

I. Choose the Correct Answers :-      

1. Where was C++ developed? 

 a)AT & T b)Microsoft 

 c)Sun micro system d)Quarto pro 

2. In which year was C++ developed? 

 a)1980‘s b)1970‘s 

 c)1960‘s d)1990‘s 

3. Who invented C++? 

 a)Dennis Ritchie b)Bjarne Stroutstrup 

 c)Dan bricklin d)Bob franskston 

4. Who coined C++? 

 a)Dennis Ritchie b)Bjarne Stroutstrup 

 c)Dan bricklin d)Rick Mascitti 

5. Plus Plus in C++ denote 

 a)increment of C++ b)increment of C 

 c)increment operator of C++ d)increment operator of C 

6. Like which language do C++ contain character set? 

 a)basic b)starbase 

 c)C d)All of these 

7. The character set of C++ constructs 

 a)variables b)tokens 

 c)identifiers d)keywords 

8. Which is the basic set of elements essential for program coding? 

 a)variables b)tokens 

 c)identifiers d)keywords 

9. The character set comprises of 

 a)white space b)horizontal tab 

 c)carriage return d)all of these 

10. The basic types are collectively called as 

 a)variables b)tokens 

 c)identifiers d)keywords 

11. Which is the smallest unit in a C++ program? 

 a)variables b)tokens 

 c)identifiers d)keywords 

12. How many classifications of tokens are there? 

 a)2 b)3 

 c)4 d)5 

13. Which has a special meaning to the language compiler? 

 a)variables b)tokens 

 c)identifiers d)keywords 

14. Which are reserved words for special purpose? 

 a)variables b)tokens  

 c)identifiers d)keywords 

15. Which cannot be used as normal identifiers? 

 a)variables b)tokens 

 c)identifiers d)keywords 

16. Which is not a keyword of C++? 

 a)sighned b)size of 

 c)static d)struct 

17. Which are called as variables? 

 a)variables b)tokens 

 c)identifiers d)keywords 

18. Which are memory boxes? 

 a)variables b)tokens 

 c)identifiers d)keywords 

19. Variables can hold 

 a)value b)constants 

 c)both a & b d)numbers only 
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20. A variable should begin with an 

 a)alphabet b)underscore 

 c)digits d)alphabet or underscore 

21. Which is an invalid identifier?  

 a)1 test b)test 1 

 c)test1 d) example_test 

22. Which are data items whose values cannot be changed? 

 a)identifiers b)constants 

 c)keywords d)variables 

23. A constant is of 

 a)numeric type b)numeric or non_numeric type 

 c)non_numeric type d)only symbols 

24. Which consist of only numbers? 

 a)numeric constant b)character constant 

 c)floating point constant d)integer constant 

25. Which is an example of numeric constant? 

 a)whole numbers  b)integer 

 c)floating point d)all 

26. Which must have at least one digit? 

 a)integer constant b)octal constant 

 c)floating point constant d)hexadecimal constant 

27. Which must not contain any fractional part? 

 a)integer constant b)octal constant 

 c)floating point constant d)hexadecimal constant 

28. An integer constant can be prefixed with 

 a) + or – sign b)+ or * sign 

 c) – or * sign d)- or /sign 

29. Which is an octal constant? 

 a)A sequence of digits starting with zero  

 b)A sequence of digits starting with zero x 

 c)A sequence of digits starting with x zero 

 d)A sequence of digits starting with a digit apart from zero or zero x 

30. The hexadecimal number is a sequence starting with 

 a)0 b)0x 

 c)A d)any digit 

31. An unsigned real number is called as 

 a)integer constant b)octal constant 

 c)floating point constant d)hexadecimal constant 

32. Which is a valid floating point constant? 

 a)58.64 b)5.864E1  

 c)5.0E22 d)0.5864 

33. Which letter represents the exponent form of floating point? 

 a)E b)E or e  

 c)e d)F or f 

34. A character constant is a constant that contains 

 a)Single character enclosed within single quotes 

 b)Single character enclosed within double quotes 

 c)Sequences of characters surrounded by single quotes 

 d)Sequence of characters surrounded by double quotes 

35. Special characters like tab is called as 

 a)character constant b)non-graphic character constant 

 c)string literal d)operator 

36. Escape sequence characters are prefixed using 

 a)\ b)/ 

 c)‖ d) ‗ 

37. A character constant should be a part of 

 a)BCD set b)ASCII set 

 c)Unicode set d)EBCDIC 

38. Which is treated as an array of characters? 

 a)character constant b)non-graphic character constant 

 c)string literal d)operator 
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39. String literal is 

 a)Single character enclosed within single quotes 

 b)Single character enclosed within double quotes 

 c)Sequence of characters surrounded by single quotes 

 d)Sequence of characters surrounded by double quotes 

40. The default special character of string literal is 

 a)/0 b)\0  

 c)|0 d)all of these 

41. ‗\0‘ of string literal marks the 

 a)beginning and end of the string b)end of a string 

 c)beginning of a string d)octal value 

42. Which is an entity on which the operator acts? 

 a)operation b)operand 

 c)identifier d)constant 

43. Which operator helps to store the value of an operation? 

 a)plus plus b)assignment 

 c)single quotes d)double quotes 

44. The non graphic character to produce a bell sound is 

 a)\a b)\b 

 c)\n d)\t 

45. The escape sequence character for a backspace is 

 a)\a b)\b 

 c)\n d)\t 

46. The non graphic character for a new line or line feed 

 a)\a b)\b 

 c)\n d)\t 

47. The escape sequence character for horizontal spacing 

 a)\a b)\b 

 c)\n d)\t 

48. The non graphic character for vertical spacing 

 a)\v b)\\ 

 c)\‘or\‖ d)\o 

49. The escape sequence character to display a \ 

 a)\v b)\\ 

 c)\‘or\‖ d)\o 

50. The non graphic character to display single or double quotes is 

 a) \v b)\\ 

 c)\‘or\‖ d)\o 

51. The escape sequence character for octal number 

 a)\v b)\\ 

 c)\‘or\‖ d)\o 

52. The non graphic character or escape sequence character for hexadecimal number 

 a)\v b)\\ 

 c)\x\ d)\O 

53. The non graphic character or escape sequence character for Null 

 a)\v b)\\ 

 c)\x\ d)\O 

54. Based on operand requirements, operators are also classified as 

 a)Unary b)binary 

 c)ternary d)all of these 

55. Which operator requires one operand? 

 a)Unary b)binary 

 c)ternary d)arithmetic 

56. Which operator requires two operands 

 a)Unary b)binary 

 c)ternary d)relational 

57. Which operator requires three operands? 

 a)Unary  b)binary 

 c)ternary d)all of these 

58. Which operator performs mathematical operations? 

 a)Unary  b)binary 

 c)ternary d)arithmetic 
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59. Operators are executed in the order of 

 a)Precedence b)equivalence 

 c)association d)expression 

60. Grouping of operator and operand is called as 

 a)Precedence b)equivalence 

 c)association d)expression 

61. Which gives the remainder of an integer division 

 a)/ b)% 

 c)* d)+ 

62. The operator used for post increment is 

 a)c++ b)++c 

 c)a =+c d)a+=2 

63. The operator used for post decrement is 

 a)C-- b)—c 

 c)a=-c d)a-=2 

64. Which operators do the preprocessor use? 

 a)# and ## b):: and .* 

 c)  * and && d)?: and & 

65. Which is a bitwise operator? 

 a)~  b) ! 

 c) && d) , 

66. Which is a ternary operator? 

 a)# b): : 

 c)->* d)?: 

67. Which is a dereference pointer to specify class member? 

 a)# b):: 

 c).>* d)?: 

68. Which is a resolution operator? 

 a)# b):: 

 c)->* d)?: 

69. Which operator is used for direct component selection? 

 a)~ b). 

 c)-> d)= 

70. Which operator is used for indirect component selection? 

 a)~ b). 

 c)-> d)= 

71. Which is a unary plus operator? 

 a)+ b)++   

 c)+= d)all of these 

72. Which are additive operators? 

 a)+and - b)++and – 

 c)+= and -= d)+, -, *, / 

73. Which operators are specific to C++? 

 a)all b,c,d b) .::  

 c) ->* d).* 

74. Which are unique in C++? 

 a)increment operators b)decrement operators 

 c)both a and b d)additive operators 

75. The result of (5+6)/3 is 

 a)3 b)3.66 

 c)both a and b d)either a or b 

76. Evaluation of 1+pow(3,2 )results in 

 a)55 b)7 

 c)10 d)9 

77. What will be the value stored in the variable a? 

 a=5 

 b=5 

 a=a+b++ 

 a)11 b)5 

 c)6 d)10 
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78. What will be the value stored in the variable A? 

 A=5 

 B=++A 

 a)6 b)5 

 c)11 d)10 

79. What will be the value stored in the variable F? 

 X=10 

 Y=20 

 F = X++ + ++Y 

 a)31 b)32 

 d)30 d)29 

80. Which are used to compare values and return true or false? 

 a)Assignment operator b)relational operator 

 c)Boolean operator d)conditional operators 

81. The result of a relational operator is returned as 

 a)0 b)1 

 c)true or false d)all of these 

82. Whch operator has lower precedence? 

 a)Assignement operator b)relational operator 

 c)Boolean operator d)conditional operators 

83. What will be the value of the expression:? 

 a)(num1 + num2 – num 3)/5*2<(num 1% 10) where num1 = 99, num2=20, num3=10 

 a)true b)false 

 c)0 d)error 

84. Which combine the result of one or more conditions? 

 a)Boolean operators b)relational operators 

 c)conditional d)all 

85. The logical AND operator is 

 a) && b)|| 

 c) ^ d)~ 

86. The logical OR opearator is 

 a) && b) || 

 c) ^ d) ~ 

87. The logical NOT operator is 

 a) && b) || 

 c) ^ d) ! 

88. The result of the expression R = (a= = d) && (ch!=t) is where a=5,b=6, ch=‘n‘ 

 and t =‘4‘ 

a) True b)false 

  c) 0 or false d)error 

89. Which is the lower precedence operator compared to the relational and arithmetic 

 operator? 

 a)Assignment operator b)logical operator 

 c)punctuators d)conditional opearators 

90. Which is a conditional opearator? 

 a)Unary b)binary  

 c)ternary d)arithmetic 

91. Find out the value assigned to m, where n1=7, n2=8 m=(n1>n2)? N1:n2 

 a)7 b)8 

 c)true d)false 

92. How many ‗shorthand‘ assignment operators are there? 

 a)20 b)5 

 c)10 d)15 

93. What will be the value of X? 

 a =10 

 b =10 

 x=(a<b) ?a*a:b%a 

 a)false b)true 

 c)100 d)0 

94. Which is not an assignment operator? 

 a)a++ b)a+=4 

 c)a%=5 d)a-=2 
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95. Which are characters with specific function? 

 a)Assignment operator b)logical operator 

 c)Punctuators d)conditional operators. 

96. Which terminates a C++ statement? 

 a); b)// 

 c)/**/ d){ } 

97. Which treats statements prefixed with this as comments? 

 a) ; b) // 

 c)/* */ d){ } 

98. Blocks enclosed within these characters are treated as comment 

 a); b) // 

 c)/**/ d){ } 

99. Used to group a set of C++ statements. 

 a); b) // 

 c)/**/ d){ } 

100. Index value of an array is enclosed within this 

 a){ } b)[ ] 

 c)‘ d)‖ ― 

101. Which is used to enclose a single character? 

 a){ } b)[ ] 

 c) ‗ d)‖ ― 

102. Which is used to enclose a set of characters? 

 a){ } b)[ ] 

 c) ‘ d)‖ ― 

103. How many classification of data type exist? 

 a)2 b)3 

 c)4 d)5 

104. What are the classifications of the data type? 

 a)Built-in b)user defined 

 c)derived d)all 

105. Which enables the user to invent own data type? 

 a)Built-in b)user defined 

 c)derived d)all 

106. Which is not a user defined data type? 

 a)Structure b)union 

 c)enumerated d)pointer 

107. Which is the fundamental data type? 

 a)Built-in b)user defined 

 c)derived d)all 

108. Which is a built in data type? 

 a)Integral b)void 

 c)floating d)all 

109. Which is not a derived data type? 

 a)array b)function 

 c)reference d)class 

110. How many types of integral type are there? 

 a)2 b)3 

 c)4 d)5 

111. Which is the integral data type? 

 a)double                     b)char c)float d)void 

112. The floating type of data are defined in 

 a)two ways b)three ways 

 c)four ways d)five ways 

113. Which are floating data type? 

 a)double b)char 

 c)int d)void 

114. The structure can be defined using 

 a)int b)char 

 c)typedef d)enum 

115. The enumerated data type can be defined using 

 a)int b)char 

 c)typedef d)enum 
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116. The list of values of an enumerated data type is called as 

 a)enuermated constants b)numeric constants 

 c)enumerated variables d)a or b 

117. The enumerated constants are assigned with the value 

 a)integer with 0 b)integer with 1 

 c)floating with 1.0 d)double with 1.0 

118. The compiler assigned value of numeric constant can be assigned explicitly as 

 a)0 b)1 

 c)1.0 d)0.0 

119. Storage class is a 

 a)Keyword b)identifier 

 c)constant d)qualifier 

120. How many storage specifiers are there? 

 a)2 b)3 

 c)4 d)5 

121. Which specifiers are automaticvally aasigned with zero? 

 a)auto and static b)static and extern 

 c)extern and register d)static and register 

122. The undefined values of specifiers are called as 

 a)constants b)garbage  

 c)generic d)identifier 

123. Which defines local variable known to the block? 

 a)auto b)static  

 c)extern d)register 

124. Which is defined within a function or  a block? 

 a)auto b)static 

 c)extern d)register 

125. Which allows the variable to exist in memory even if the block looses its scope? 

 a)auto  b)static 

 c)extern  d)register 

126. Which variable retains the last value assigned? 

 a)auto  b)static 

 c)extern  d)register 

127. Which is a global variable? 

 a)auto  b)static 

 c)extern  d)register 

128. Which instruct the compiler to store the variable to optimize access? 

 a)auto  b)static 

 c)extern  d)register 

129. Which register stores the variable to optimize access? 

 a)CPU register b)Memory register 

 c)stack register d)all 

130. Which is predefined in the compiler? 

 a)Built-in b)user defined 

 c)derived d)all 

131. Which can hold both character and data? 

 a)int b)char 

 c)double d)float 

132. Which does not return any value? 

 a)int b)void  

 c)double d)char 

133. Which is used to declare a generic pointer? 

 a)int b)void 

 c)double d)char 

134. Which indicate that it holds nothing? 

 a)int b)void 

 c)double d)char 

135. Derived data type are accessed starting from 

 a)0 b)1 

 c)both a and b d)either a or b 
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136. int n[5] = {3, 5, 9, 2 , 4} ; what is stored in n[2]? 

 a)5 b)9 

 c)2 d)4 

137. The range of character data type is 

 a) -128 to 127 b) 0 to 255 

 c)-128 to 127 d)-32768 to 32767 

138. The range of unsigned char is 

 a) -128 to 127 b) 0 to 255 

 c)-128 to 127 d)-32768 to 32767 

139. The range of signed char is 

 a) -128 to 127 b) 0 to 255 

 c)-128 to 127 d)-32768 to 32767 

140. The range of int is  

 a) -128 to 127 b) 0 to 255 

 c)-128 to 127 d)-32768 to 32767 

141. The range of unsigned int or shor int is 

 a) 0 to 65535 b) 0 to 255 

 c) -128 to 127 d) -32768 to 32767 

142. The range of signed int or short int is 

 a) 0 to 65535 b) 0 to 255 

 c) -128 to 127 d) -32768 to 32767 

143. What is the byte value of a double? 

 a)2 b)4 

 c)8 d)10 

144. What is the byte value of a long double? 

 a)2 b)4 

 c)8 d)10 

145. What is the byte value of a float, signed and unsigned long int? 

 a)2 b)4 

 c)8 d)10 

146. What is the byte value of a int, signed and unsigned short int? 

 a)2 b)4 

 c)8 d)10 

147. What is the byte value of a char? 

 a)2 b)1 

 c)4 d)8 

148. Which is a variable that holds a memory address? 

 a)variable b)pointer 

 c)static d)all 

149. The pointer address starts from 

 a)0 b)1 

 c)null d)1.0 

150. When we work with the pointer data type one should know the operators 

 a)& and * b) & and | 

 c)* and | D) & and ^ 

151. The unary operator to declare a pointer variable is 

 a)&                             b)*      c)~ d)| 

152. Which are named entities of memory locations that can store data? 

 a)pointer b)variable 

 c)qualifier d)identifier 

153. Which is an invalid variable? 

 a)a-b b)1a-b 

 c)-a-b d)ab 

154. Every variable should be separated by a 

 a)comma b)semicolon 

 c)colon d)equal 

155. Which is invalid? 

 a)int s, h,a; b) int s flat h,a; 

 c)int s, float h, a; d)float ha; 

156. How many built-in data types exist? 

 a)8 b)9 

 c)10 d)11 
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157. Which are the modifiers of built-in? 

 a)long b)signed 

 c)unsigned d)all 

158. To represent negative value the number 1 is store in the 

 a) 15
th
 bit b)16

th
 bit 

 c)0
th
 bit d)1

st
 bit 

159. Which qualifier specifies that the value of a variable will not change? 

 a)unsigned  b)long 

 c)const d)void 

160. What is the value of z float  f = 8.5 ; int z =f? 

 a)error b)8 

 c)9 d)5 

161. Which operator returns the value int bytes? 

 a)size of  b)size 

 c)size-of d)sizeof() 

162. What is the size of unsigned it ui;? 

 a)2 b)4 

 c)8 d)10 

163. Which is the invalid of casting? 

 a) (float)7 b)float(7/3) 

 c)int x; x =8% 7.7 d)int x; x = 8%(int)7.7 

164. What is the value  assigned to x? 

 flaot x ; 

 int a = 7, b = 3 

 x =a/(float)b ; 

a) Error b)2.5 

c)  2.0 d)3.0 

165. C++ was developed at …………..laboratories 

 a) Sun micro system b) Micro soft 

 c) AT & T Bell d) Apple 

166.  C++ was developed in early……………… 

 a) 1970 b) 1980 

 c) 1965 d) 1975 

167. The name C++ was coined by ………….. 

 a) Ken thompsom b) Rick Mascitti 

 c) Bjarne Stroustrup d) Charles Babbage 

168. A ……………….is the smallest individual unit in a program. 

 a) variable b) constant 

 c) tokens d)  key words 

169. …………………have special meaning to the language compiler. 

 a) variable b) constant 

 c) tokens d)  key words 

170. Key words are ---------------------words for special purpose. 

 a) reserve b) constant 

 c) tokens d)  key words 

171. Key words cannot be used as normal ------------- 

 a) reserve b) constant 

 c) tokens d) identifiers 

172. The following one is not a keyword------ 

 a)auto b)break 

 c)case d)signs 

173. Identifiers are also called as--------- 

 a)variable b)constant 

 c)tokens d)key words 

174. Variables are memory boxes that hold values or------- 

 a) reserve b) constant 

 c) tokens d)identifiers 

175. A vaiable must begin with an------------ 

 a)alphabet b)underscore 

 c)numbers  d)all the above 
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176. Constants are data items whose value -------be changed 

 a)can b)cannot 

 c)never d)Always 

177. A constant is of-------- or------type. 

 a)numeric, non numeric b)numeric, alphabet 

 c)Alphabet, non numeric d)alphabet, character 

178. Numeric constant consists of only-------- 

 a)alphabet b)underscore 

 c)numbers d)all the above 

179. Integer constant may be prefixed with-------sign. 

 a)+ b)- 

 c)* d)a or b 

180. A sequence of digits starting with 0 (zero) is treated as ------constant. 

 a)binary b)decimal  

 c)octal d)hexa decimal 

181. A sequence of digits starting with 0x is treated as ----constant 

 a)binary b)decimal  

 c)octal d)hexa decimal 

182. Floating Point Constant is a signed -------- number. 

 a)real b)integer 

 c)binary d)octal 

183. Floating point constant includes 

 a)integer b)fractional portion 

 c)exponent d)All the above 

184. The letter-------is used to represent the floating –point constant exponent form. 

 a)E b)e 

 c)a or b d)a and b 

185. Character costant is a constant that contains a single--------- 

 a)character  b)integer 

 c)float d)string 

186. Character constant is enclosed within -----quotes. 

 a)single b)double 

 c)Three d)four 

187. Escape sequences are represented using characters prefixed with a ------- 

 a)+ b) * 

 c)/ d) \ 

188. Escape sequence for bell is-------- 

 a) \a  b)\b 

 c)\n d)\t 

189. String Literal is a sequence of characters surrounded by----quotes. 

 a)single b)double 

 c)Three d)four 

190. String literals are treated as --------- of characters. 

 a)float b)integer  

 c)array d)null 

191. Each string literal is by default added with a special character 

 a)\a b)\b 

 c)\0 d)\t 

192. ‗\O‘ character marks the---of a string. 

 a)top b)end 

 c)middle d)beginning 

193. Operator specifies an operation to be performed that yields a--------- 

 a)float b) integer 

 c)value d)null 

194. An operand is an--------on which an operator acts. 

 a)entity b)integer  

 c)float d)character 

195. --------- is the additional operator, that performs the additions of the numbers 

 a)+ b)*  

 c)/ d) \ 
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196. The operators ----are used only by the preprocessor. 

 a)# b) ## 

 c)both (a) and (b) d)### 

197. Based on operand requirements, opearators are also classified as----operators. 

 a)unary b)binary 

 c)ternary d)All the above 

198. Arithmetic Operators are used to perform------operations. 

 a)Scientific  b)arithmetic 

 c)mathematical  d)Logical 

199. Which one of the following is not an arithmetic operator? 

 a)+ b) # 

 c) * d) / 

200. The operands and the operators are grouped in a specific -----way for evaluation. 

 a)scientific b)arithmetic  

 c)mathematical d)logical 

201. The logical grouping is called as-------- 

 a)scientific b)arithmetic 

 c)mathematical d)association 

202. What is the output of the expressions 9 + 6/3? 

 a)7 b) 5 

 c) 11 d) 12 

203. ++ is called--------operator. 

 a)Increment b)Decrement 

 c)integer d)float 

204. -  - is called-----operator. 

 a)Increment b)Decrement 

 c)integer d)float 

205. Relational Opeators are used to------values. 

 a)add b)subtract 

 c)compare d)increment 

206. A relational expression is constructed using any-----operands. 

 a)1 b)2 

 c)3 d)4 

207. The result of relational operation is---- 

 a)true b)false 

 c)positive d)either(a) or (b) 

208. The numeric constant zero (0) represents---- 

 a)true b)false 

 c)positive  d)either(a) or (b) 

209. Any non-zero constant represents-------value. 

 a)true b)false 

 c)positive d)either (a) or (b) 

210. = = is ----- 

 a)less than b)greater than 

 c)equal to d)not equal 

211. The logical operator & & represents 

 a)AND b)OR 

 c)NOT d)EQUAL 

212. The logical operator || represents------ 

 a)AND b)OR 

 c) NOT d) EQUAL 

213. The logical operator ! represents---- 

 a)AND b)OR 

 c)NOT d)EQUAL 

214. A ternary operator (?:) is also called as-----operator 

 a)relation b)arithmetic 

 c)conditional  d)logical 

215. ----- is the simple assignemtn operator 

 a)+ b_) = 

 c)* d) / 
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216. ------number of short hand assignment opearators. 

 a)5 b)8 

 c)9 d)10 

217. Punctuators are characters with a specific--------- 

 a)addition b)function 

 c)object d)program 

218. --------punctuator Terminats a C++ statement 

 a)// b), 

 c) ; d) . 

219. ------punctuator treated as comment 

 a)// b), 

 c) ; d) . 

220. ------- are the kind of data that variables hold in a programming language 

 a)function type b)program type 

 c)data type d)a or b 

221. Data type enables one to work with-----objects. 

 a)simple b)complex 

 c)dordinary  d)extraordinary 

222. The data types can be classified into----------categories. 

 a)1 b)2 

 c)3 d)4 

223. Data type are broadly classified into------------- 

 a)User defined type b)Built-in type 

 c)Derived type d)All the above 

224. --------enables a programmer to invent his/her own data type. 

 a)User defined type b)Built-in type 

 c)Derived type d)All the above 

225. -------allow users to define user defined data type identifier. 

 a)User defined type b)Built-in type 

 c)Derived type d)All the above 

226. Enumerated data type is------- 

 a)User defined type b)Buyilt-in type 

 c)Derived type d)All the above 

227. Enumerated data type has symbolic ----constant of the type int. 

 a)alphabet b)character 

 c)numeric d)string 

228. -----class is another qualifier(like long or unsigne(d) that can be aadded to a variable 

declaration) 

 a)User defined type b)Built-in type 

 c)Derived type d)Storage specifier 

229. The storage specifier are calssified into----- 

 a)1 b)2 

 c)3 d)4 

230. The storage specifiers are---- 

 a)auto b)static 

 c)extern d)all the above 

231. Static and Register variables are automatically initized to -----when they are declared 

 a)1 b)2 

 c)3 d)0 

232. ----------data type is also called as fundamental or basic data type. 

 a)User defined b)User compiled 

 c)Built in d)System defined 

233. Auto variables get undefined values known as------------- 

 a)garbage b)function 

 c)integer d)float 

234. Built in types are predefined in the----- 

 a)interpreter  b)compiler  

 c)Software d)hardware 

235. There are------number of built in data types 

 a)1 b)2 

 c)3 d)0 
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236. Built in data type 

 a)Integral b)Float 

 c)void d)All the above 

237. Integral is the -------data type 

 a)character b)integer 

 c)array d)fractional 

238. Integral can not hold-----values 

 a)character  b)integer 

 c)array d)fractional 

239. Char data type that can hold both the character data and the-------data. 

 a)character  b)integer 

 c)array d)fractional 

240. Floating type is further divided into 

 a)float b)double 

 c)both (a) and (b) d)either (a) or  (b) 

241. --------- is to indicate the a function does not return a value. 

 a)character  b)void 

 c)array d)fractional 

242. -------- is to declare a generic pointer. 

 a)character b)integer 

 c)array d)void 

243. The modifiers of the basic data types are 

 a)signed b)unsigned 

 c)long d)all the above 

244. ---------are built form the basic integer and floating type 

 a)User defined type b)Built-in type  

 c)Deived type d)All the above 

245. Unsigned short int occupies ------- bytes. 

 a)1 b)2 

 c)3 d)0 

246. Int range is----------- 

 a)-32767 to 32767 b)-32768 to 32767 

 c)-32768 to 32767 d)-32768 to -32768 

247. -----------is a variable that holds a memory address. 

 a)address  b)pointer 

 c)point d)points 

248. Pointers variable can access the memory locations. 

 a)directly b)indirectly 

 c)occasionally  d)often 

249. Every --------in the computer‘s memory has an address 

 a)bit b)byte 

 c)kilo byte d)mega byte 

250. The memory address starts at-------- 

 a)NULL b)1 

 c)2 d)3 

251. When a program is compiled, memory is allocated to the variables by the----------- 

 a)interpreter b)compiler 

 c)software d)hardware 

252. The amount of memory allocated to each variable depends on the----of the variable 

 a)function type                b)program type  

 c)data type d)either (a) or (b) 

253. -------- is an address operator. 

 a)+ b) * 

 c) & d) $ 

254. -------- is a value operator. 

 a)+ b) * 

 c) & d) $ 

255. ------- is a unary operator. 

 a)+ b) * 

 c) & & d) $ 
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256. ----------is the name assigned to a data field that can assume any of a given set of values 

 a)variable b)constant  

 c)tokens d)key words 

257. Names beginning with an underscore are reserved for---------- system variables., 

 a)external b)internal  

 c)software d)hardware 

258. Varibale name are----- 

 a)non case sensitive b)lower case 

 c)upper case d)case sensitive 

259. Which one of the following is valid variable? 

 a)Ab b) la_b  

 c)Test d)Balance$ 

260. ----variable of the same data type can be declared in a single declaration statement. 

 a)one b)two 

 c)three d)more than one 

261. Variable of the same data type should be separated by------- 

 a)comma b)full stop 

 c)semi colon d)colon 

262. The are ---------words for data types. 

 a) 4 b) 6 

 c) 8  d) 9 

263. Integer values are stored in ----------bit format in binary form 

 a) 4 b) 8 

 c) 16 d) 32 

264.  The --------alters the base data type to yield new data type. 

 a) variable b) constant 

 c) modifier d) float 

265. the base data type should be ----with the modifiers at the time of declaring a variable. 

 a) suffixed b) prefixed 

 c) subscript d) superscript 

266. Prefix the data type with modifiers at the time of -----variables. 

 a) using b) initializing 

 c) declaring d) none 

267.  Any attempt to alter the values of a variable defined with const qualifier will throw an  

error message by the ----------- 

 a) interpreter b) compiler 

 c) software d) hard ware 

268. Variables are initialized to a specific value at the time of ---------- 

 a) using b) initializing 

 c) declaration d) none 

269. If one operand is of type long double, then the other value is also converted to ------- 

 a) int b) float 

 c) double d) long double 

270. Sizeof is an -------------- 

 a) variable b) constant 

 c) operator d) identifier 

271. Pointer variables are -------to the data type they point to. 

 a) case sensitive b) non sensitive 

 c) sensitive d) upper case sensitive 

272. ----------refers to the process of changing the data type of the value stored in a variable. 

 a) type cast b) type case 

 c) cast type d) case type 

273. Modulus operator (%) operates on -------------- data type only. 

 a) character b) integer 

 c) array d) fractional 

274. A variable name must begin with an----------- 

 a)alphabet b)underscore 

 c)Number d)Both(a) and (b) 

275. C++ was developed at--------- 

 a)Oracle b)AT & T Bell 

 c)Sun Micro Systems d)Microsoft 
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276. -------- is the basic types of elements essential for programming coding 

 a)constant b)variables 

 c)token d)statement 

277. --------are the memory locatrions that hold values or constants 

 a)Tokens b)Variables 

 c)Statements d)Keywords 

278. ------have special meaning to the language compiler. 

 a)Tokens b)Variables 

 c)Statements d)Keywords 

279. ------are also called as variables. 

 a)Tokens b)Variables 

 c)Statements d)Identifiers 

280. Non-graphic sequences are represented using------------- 

 a)comments b)escape sequences 

 c)statements d)variables 

281. A----------operator is also called as conditional operator 

 a)Binary b)Ternary  

 c)Arithmetic d)Relational 

282. ---------refers to the process of changing the data type of the value stored in a variable. 

 a)Conversion b)Type cast 

 c)Data conversion d)None of these 

283. --------operators are used to compare numeric values 

 a)Binary b)Ternary  

 c)Arithmetic d)Relational 

284. A-------- is a variable that holds a memory address. 

 a)integer b)string 

 c)pointer d)character 

285. ---------varaibels are sensitive to the data type they point to? 

 a)integer b)string 

 c)pointer d)character 

286. The are -------- specifiers in a storage class 

 a)2 b)3 

 c)4 d)5 

287. ------- is a default storage class 

 a)extern b)auto 

 c)static d)register 

288. The range of integer data type is--------- 

 a) -32678 to 32678 b) -32678 to 32767 

 c)-31768 to 31768 d) -32668 to 32668 

289. The--------data type is also called as fundamental or derived data type 

 a)User defined b)derived 

 c)Built-in d)Type defined 

290. The -------data type is also called as fundamental or derived data type. 

 a)User defined b)derived 

 c)Built-in d)Type defined 

291. Each and every C++statement should be terminated by 

 a). b) ; 

 c) : d) // 

292. How many classifications of operators in C++? 

 a)12 b)13 

 c)14 d)3 

293. The operator uses on a single operand in is known as-------operator 

 a)Unary b)Binary 

 c)Ternary d)Relational 

294. The --------sign is the single assignment operator. 

 a)= b) = = 

 c)+ = d) ! = 

295. --------data type helps in improving the credibility and readability of the program., 

 a)User defined b)derived 

 c)Built-in d)Type defined 
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296. -----is the smallest unit of the program. 

 a)Token b)Variable 

 c)Constant d)None of these 

297. The------operators require one operand 

 a)Unary b)Binary 

 c)Ternary d)Relational 

298. The ------operators require three operands 

            a)Unary b)Binary 

 c)Ternary d)Relational 

299. The----------variables are not initialized with appropriate value based on their data type 

 a)extern b)auto 

 c)static d)register 

300. ----operators combine the results of one or more condition or variables having numerical  

    values. 

 a)Unary b)logical 

 c)Ternary d)Relational 

301. ---------specifies an operation to be performed that yields a value. 

 a)Variable b)Operator 

 c)Constant d)Expression 

302. ------- is restricted only to fundamental or standard data type 

 a)Type cast b)Conversion  

 c)Type def d)None of these 

303. -------alters the basic data types to yield a new data type. 

 a)Type cast b)conversion 

 c)Modifier d)Storage class 

304. There are-------specifiers in a storage class 

 a)2 b)3 

 c)4 d)5 

305. ---------variables are not initialized with appropriate values based on their data type 

 a)extern b)auto 

 c)static d)register 

306. The-------data type is also called symbolic numeric constants of the type int; 

 a)int b)Type def 

 c)Enumerated d)User defined 

307. The values in the---------data item can not be changed. 

 a)variable b)constant 

 c)identifier d)none of these 

308. The escape sequence to represent a new line is--------- 

 a)/n b)\l 

 c)/1 d)\n 

309. -------- is an entity 

 a)variable b) constant 

 c)identifier d)none of these 

310. ------specifies the value of a variable will not change during the run time of a program 

 a)const b)auto 

 c)static d)register 

311. -----variables are not initialized with appropriate values based on their data type 

 a)extern b)auto 

 c)static d)register 

312. How many data bytes the char data type occupies? 

 a)1 b)2 

 c)3 d)4 

313. How many data bytes the int data type occupies?   

 a)1 b)2 

 c)3 d)4 

314. How many data type bytes the float data type occupies? 

 a)1 b)2 

 c)3 d)4 

315. How many data bytes the long int data type occupies? 

 a)1 b)2 

 c)3 d)4 
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316. How many data bytes the short int data type occupies? 

 a)1 b)2 

 c)3 d)4 

317. How many data bytes the unsigned int data type occupies? 

 a)1 b)2 

 c)3 d)4 

318. How many data bytes the unsigned int data type occupies? 

 a) 1 b)8 

 c)3 d)4 

319. How many data bytes the double data type occupies? 

 a)1 b)8 

 c)3 d)4 

320. How many data bytes the long double data type occupies? 

 a)1 b)2 

 c)10 d)4 

321. There are -------fundamental data types in C++.  

 a)1 b)2 

 c)3 d)4 

322. The punctuator used to identify an array is 

 a){ } b)( ) 

 c)[ ] d)< > 

323. ------and------are grouped in a specific logical way for evaluation? 

 a)Operators and operands b)Numbers and characters 

 c)Tokens and keywords d)Opeators and expressions 

324. The ------data type enables the programmer to invent his own and defined values. 

 a)Enumerated  b)user defined 

 c)Derived d)Basic 

325. What will be the value of b if a = 6 and b = a ++ 

 a) 5 b)6 

 c)7 d)8 

326. What will be the value of b if a = 6 and b = ++ b 

 a) 5 b) 6 

 c)7 d) 8 

327. What will be the value of b if a=6 and b  = a—. 

 a)5 b)6 

 c)7 d)8 

328. What will be the value of b if a = 6 and b =- -a 

 a)5 b)6 

 c)7 d)8 

329. ---------are treated as array of characters 

 a)Char b)Strings 

 c)Special characters d)Numbers 

330. The-------and-----operators are used only by the preprocessor 

 a)# and ## b)++ and - - 

 c)= = and + + d)** and ++ 

331. The----specifies an operation to be performed that yields a value. 

 a)Token b)Operator 

 c)Keyword d)Identifier 

332. The escape sequence used to represent the null character is------ 

 a)\o b)\t 

 c)\n d)\a 

333. -----operators are used to perform mathematical operations 

 a)Boolean b)Relational  

 c)Arithmetic d)Bitwise 

334. -----operators are used to perform comparisons. 

 a)Boolean b)Relational  

 c)Arithmetic d)Bitwise 

335. ------operators are used to perform Boolean operations. 

 a)Boolean b)Relational  

 c)Arithmetic d)Bitwise 
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336. The------operator gives the remainder of an integer division. 

 a)* b)/ 

 c)% d)| 

337. The -----operator gives the Quotient of an integer division 

 a)* b)/ 

 c)% d)| 

338. The --------constant consists of whole numbers or decimal numbers. 

 a)Character b)Numeric 

 c)Boolean d)String 

339. The-----can not be used as variable names.  

 a)Expressions b)Operators 

 c)Keywords d)Constant 

340. The------------character marks the end of the string 

 a)\O b)\t 

 c)\n d)\a 

341. The---------constant is a signed real constant 

 a)Char b)Integer 

 c)Floating point d)String 

342. If a=5, b=10 then the value of c = a+b/a=? 

 a)5 b)7 

 c)3 d)17 

343. ----data type is used to declare a generic pointer? 

 a)Int b)Char 

 c)Void d)String 

344. Logical operators are called as-----operators. 

 a)Arithmetic b)Boolean  

 c)Relational d)Bitwise 

345. A=5 and if A+=2 then the value of A is-------- 

 a)7 b)5 

 c)3 d)10 

346. A = 5 and if A*=4 then the value of A is------- 

 a) 1 b) 9 

 c)20 d)10 

347. A=5 and if A/=2 then the value of A is-------- 

 a)7 b)1 

 c)10 d)2 

348. A=5 and if A-=2 then the value of A is-------- 

 a)7 b)5 

 c)3 d)10 

349. A=5 and if A%=2 then the value of A is-------- 

 a)1 b)5 

 c)3 d)10 

350. A = 5 , B = 6 , C =7 and if A + =B*C then the value of A is---------- 

 a) 18 b) 42 

 c) 47 d) 37 

351. A = 5 , B = 6 , C =7 and if C * = A + A / B then the value of B is---------- 

 a) 18 b) 42 

 c) 47 d) 35 

352. A = 5, B = 6, C = 7 and if B + =A%2*C thjen the value of B is --------- 

 a)20 b)42 

 c)47 d)37 

353. The conditional operator is--------- 

 a) + ! b) ? : 

 c) ? d) & 

354. ---------data type are also called as fundamental or Basic data types. 

 a)User defined b)Built in 

 c)Enumerated d)None of these 

355. There are------- fundamental data types in C ++ 

 a)1 b)2 

 c)3 d)4 
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356. The fundamtental data types are predefined in the------ 

 a) Assembler b) Compiler 

 c) Linker d)Debugger 

357. -------defines the variable known to the block in which they are defined 

 a)auto b)static 

 c)extern d)register 

358. -----variables defined within a function or a block cease to exist, the moment the 

   function or the block looses its scope. 

 a)auto b)static 

 c)extern d)register 

359. --------varibales are global variables known to all functions in the current program 

 a)auto b)static 

 c)extern d)register 

360. The modifier -------instructs the compiler to store the variable in the CPU register 

 a)auto b)static 

 c)extern d)register 

361. Relational operators have lower precedence than-------operators 

 a)Boolean b) Relational 

 c)Unary d)Arithmetic 

362. Every action block in swith case statement should be terminated with a-----statement 

 a)continue b) break 

 c) default d) case 

363. -----increases the bytes for a particular data type, thus increases the range of values. 

 a)signed  b)long 

 c)short d)unsigned 

364. The -----alters the base data type to yield new data type. 

 a)operator b)modifier 

 c)variable d)constant 

365. ----------data type is further divided into in and char 

 a)Float b)integral  

 c)void d)String 

366. ----------constant is a signed real number 

 a)Integer  b)Strring 

 c)Floating point d)character 

367. A sequence of digits starting with 0x is treated as-----constant 

 a)Decimal b)Octal 

 c)Binary d)Hexa decimal 

368. Escape sequences are represented using characters prefixed with a-------- 

 a)/ b)\ 

 c)// d)\\ 

369. In the name C++, the term ―++‖ is the C----- operator 

 a)decrement b)increment 

 c)Binary d)Conditional 

370. The punctuator,------terminates a C++ statement 

 a) ; b) . 

 c) : d) , 

371. The punctuator -----treats statements prefixed with this as comments. 

 a) ; b) . 

 c) : d) ,  

372. The blocks enclosed with------are treated as comment. 

 a)/**/ b)\**\ 

 c)//**// d)\\**\\ 

373. ----- is used to group of C++ statements. 

 a)( ) b) [ ] 

 c){  } d) < > 

374. If int x = 7/3 ;,  what is the value of x? 

 a)2 b)1 

 c)1.3333 d)2.3333 

375. If float x=7/3 ; what is the value of x? 

 a)2 b)1 

 c)1.3333 d)2.3333 
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376. -----are user defined named entities of memory locations that can store data 

 a)Operators b)Variables 

 c)Constants d)Operands 

377. ------ is used to display the contents stored at a location (value at the address operator) 

 a)- b) + 

 c)* d) ^ 

378. ----conversion refers to data type changes brought about in expressions by the compiler 

 a)Type cast b)Implicit 

 c)Explicit d)None of these 

379. ------is also a user defined data type.  

 a)String b)Fundamental 

 c)Enumerated d)None of these 

380. Unary operators require------operand(s) 

 a)1 b)2 

 c)3 d)4 

381. Binary operators require-----operand(s) 

 a)1 b)2 

 c)3 d)4 

382. Ternary operators require-----operand(s) 

 a)1 b)2 

 c)3 d)4 

383. The special character ------------ marks the end of a string. 

 a) \a b) \O 

 c) \t d) \n 

384. Tehe basic types are collectively called as --------------- 

 a) variables b) expression 

 c) tokens d) looping 

385. ---------is the smallest individual unit in a program., 

 a) Token b) Character 

 c) Control d) variable 

386. Which one give s special meaning to the language compiler?--------- 

 a) Compiler b) key words 

 c) variable d) constant 

387. Which one of the following is a keyword? ------------------- 

 a) switch b) key 

 c) jump d) size 

388. What is the other name for variable?------------- 

 a) Constant b) Identifier 

 c) Visual d) While 

389. Which one holds the values or constants in memory boxes?------------- 

 a) variable b) while 

 c) switch d) go to 

390. ----are data items whose value cannot be changed.  

 a) variable b) Constants 

 c) Return d) Class 

391. In which type of contant the Decimal numbers, integer and floating points are related? 

 a)Numeric b)String 

 c)Char d)Boolean 

392. The sequence of digits starting with O is treated as ---------constant. 

 a) Octal b) Binary 

 c) Hexadecimal d) Penta 

393. Which constant type does not contain any practical part?-------------- 

 a) Integer b) Red 

 c) Floating d) Octal 

394. What type of integer starts with OX? 

 a)Octal b)Hexadecimal  

 c)Binary d)Decimal 

395. ------------Constant is a signed real number 

 a) Floating point b) Integer 

 c) String d) Char 
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396. Which one is the valid Real constant? 

a) 85.46 b) 85 

 c) 0.85 d) both a and c 

397. Which alphabetic letter is used to represent the floating point constant in exponent 

form—---------------- 

 a) A or a b) E or e  

 c) F or f d) B or b 

398.  What is a constant that contains a single character enclosed with in single quotes? 

 a) floating point b) fixed 

 c) numeric  d) character 

399. The special characters like tab, backspace, line feed, mull, back slash are called -----

character  constant. 

 a) non-graphic b)graphic 

 c) string d) floating 

400. How are the non graphic character constants represented? 

 a) using escape sequence b) using * character 

 c) + sign d) – sign 

401. What is the prefix character used to represent escape sequence? 

 a) / b) * 

 c) + d) – 

402. What is the escape sequence for Bell? 

 a) \a b) \b 

 c) \n d) \t 

403. --------- is the escape sequence for back space 

 a)\ b b) \\ 

 c) \n d) \t 

404.  The escape sequence character used to represent newline/line feed is ----------- 

 a) \n b) \v 

 c) \t d) \o 

405. -------------is used to have a vertical tab., 

 a) \ v  b) \ a 

 c) \\ d) \‘ 

406. How will we represent the octal number in C language? 

 a)  \ o b) \n 

 c)  \ d) \― 

407. To represent Horizontal tab----- is used 

 a)\ b b) \ t 

 c) \ v d) \ o 

408. Which escape sequence character is used to represent null? 

 a)\ o b) \ t 

 c) \ n d) \ a 

409. To represent Hexadecimal number -----is used. 

 a) \x b) \\ 

 c) \t d) \b 

410. --------------is a sequence of characters surrounded by double quotes. 

 a) String literal b) Character 

 c) Numeric d) Constant 

411. Which special character is used to represent the end of string?----- 

 a) ‗\o‘ b) ‗\t‘ 

 c) ‗\n‘ d)‘\a‘ 

412. -----------literals are treated as array of characters. 

 a) Graphic b) Non-graphic 

 c) String d) Character 

413. -------------------is an entity on which an operator acts. 

 a) Operator` b) Operand 

 c) Variable d) Constant 

414. How many operators are classified in C++ ? 

 a) 1 b) 13 

 c) 14 d) 15 

415. How many operators are classified based on operand requirements in C++ ? 

 a) 3 b) 4 

 c) 2 d) 5 
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416. Which operator requires one operand? 

 a) unary b) binary 

 c) ternary d) both (a) and (b) 

417. --------------------operator requires two operands. 

 a) Unary b) Binary 

 c) Ternary d) Logical 

418. Which operator requires three operands? 

 a) Unary b) Binary 

 c) Ternary d) Bitwise 

419. Address of (&), logical not (!), indirection (*) and increment (++)are----operators. 

 a)Binary b)Unary 

 c)Additive d)Relational 

420. Bitwise(~), Decrement(- - ), unary minus( - -) and unary plus(+)are----opeartors. 

 a)Unary b)Ternary 

 c)Assigment d)Equality 

421. Additive, Multiplicative, Shift, Bitwise logical and Assignment operators are ------ 

 a) Unary b) Binary 

 c) Relational d) Conditional 

422. Relational, equality, component selection, class member conditional and comma 

operation are-----operator. 

 a)binary b)unary 

 c)assignment d)shift 

423. Binary Plus (+) and Binary minus (-) are --------operator. 

 a)Additive b) Multiplicative 

 c) Shift d) Bitwise 

424. Multiply (*), Divide (/) and Remainder(Modules) (%) are ---------- operator. 

 a) Additive b) Multiplicative 

 c) Relational d) Equality 

425. What are shift operators? 

 a) << b) >> 

 c) > d) both (a) and (b) 

426. What are bitwise operators? 

 a) & b) ! 

 c) ^ d) all (a, b and c) 

427. Logical AND (&&) and Logical OR (||) are-----operators. 

 a)Logical b)Equality 

 c)Class member d)Comma 

428. Assignment(=), Assign quotient(/ =), Assign sum (+ =), Assign product(* =) 

 and Assign remainder (% =) are -----operator. 

 a)Assignment b)Class member 

 c)Equality d)Shift 

429. Assign Difference ( - =), Assign left shift (<<=) and Assign right shift (>>=) are --------

operator. 

 a) Assignment b) Additive 

 c) Comma d) Bitwise 

430. What are the Assign bitwise Assignment operator? 

 a) &= b) ^= 

 c) 1= d) all (a , b and c) 

431. The operand and the operators are grouped in a specific logical way of evaluation is 

called --------------- 

 a) Class b) Association 

 c) Assignbment d) Arithmetic 

432. Which operator gives the remainder of an integer division? 

 a) / b) \ 

 c) % d) / = 

433. What are the equality operators? 

 a)= = b)1 = 

 c)< = d)both a  and b 

434. What are the component selection operators? 

 a).(Direct) b)  (Indirect) 

 c)=(Equal) d)both a and b 
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435. What are the class member operators? 

 a): : (Scope Access) b).* (Difference operator) 

 c) * (Dereference pointer) d)All (a, b and c) 

436. -------ternary operator is a conditional operator 

 a)?: b)  

 c)! = d) < = 

437. Which operator is used to compare numerical values? 

 a) Relational b) Conditional 

 c) Assignment d) Arithmetic 

438. ----------operators have lower precedence to relational and arithmetic operators. 

 a) Relational b) Logical 

 c) Boolean d) Conditional 

439. --------operators combine the results of one or more condition or variables having 

numerical values. 

 a) Relational b) Logical 

 c) Comma d) Additive 

440. c=6, d=7 choice =‘y‘ b =‘5‘, R=(c= = d) & & (choice ! = b)what will be the value of R? 

 a)True b)False 

 c)No d)Yes 

441. A ternary operator (?  is also known as -------operator 

 a)conditional b)relational 

 c)assignment d)shift 

442.  When a=6 and c=a ++ what is the value of c? 

 a) 6 b) 7 

 c) 8 d) 5 

443. When a=6, c=++ a what will be the value of c? 

 a) 6 b) 7 

 c) 8 d) 9 

444. When a =5, c=a - - what will be the value of c? 

 a) 5 b)6 

 c) 4 d) 7 

445. When a=5, c= - - a what will be the value of c? 

 a) 5 b)6 

 c) 4 d) 8 

446. What will be the value stored in C when a =20, b=20, c=(a<b)? a*a:b%a;---------- 

 a)0 b)400 

 c)40 d)20 

447.  What will be the value of A when A =6 and A + =3? 

 a) 9 b) 6 

 c) 3 d) 10 

448. What will be the value of x when x =5, and x* = 5? 

 a) 5 b) 10 

 c) 20 d) 25 

449. What will be the value of  m when m = 5, m/=2? 

 a)3 b)2 

 c)4 d)5 

450. Which punctuator is used to terminate a C++ statement ? 

 a) ; b) : 

 c) . d) , 

451. ---------punctuator is used to treat statements as comments. 

 a) // b) * 

 c) / d) + 

452. Which punctuator is used to group a set of C++ statements? 

 a) {} b) [ ] 

 c) ( ) d) / 

453. The index value for an element in an array is indicated within -------------brackets. 

 a) {} b) [ ] 

 c) ( ) d) / * 

454. ----------- is used to enclose a single character., 

 a) ‗ ‗ b) ― ― 

 c) ‗ ― d) , 
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455. ----------- is used to enclose a set of character., 

 a) ― ― b) ‗ ‗ 

 c) ; d) : 

456. -------------are the kind of data that variables hold in a programming language. 

 a) Data types b) Variable type 

 c) Constant type d) Conditional type 

457. How many C++ data types are broadly classified? 

 a) 2 b) 3 

 c) 4 d) 5 

458. ----Data types are structrure, union, class and enumeration. 

 a)User derfined b)Built-in 

 c)Derived d)Integer 

459. -----data types are Array, function, pointer, reference 

 a)User defined b)Derived 

 c)Built-in d)Floating 

460. Which data type int, char are related? 

 a) floating b) void 

 c) Integral d) fixed 

461. Which data type int, char are related?--------- 

 a)floating b)void 

 c)Integral d)fixed 

462. Float, and double are related to--------data type 

 a)floating  b)fixed 

 c)integral d)void 

463. ------data type enables to invent his own data type and define values. 

 a)User defined b)Derived 

 c)Floating d)Integral 

464. For example class boy, ---------is a user defined data type of class. 

 a) boy b) user 

 c) type d) class 

465. ----------allows users to define the user defined data type identifier. 

 a) Type definition b) Identifier 

 c) Data d) Class 

466. For example, type def int mark; ------is a user defined data type identifier. 

 a) mark b) int 

 c) type def d) data 

467. For example type def int mark; mark em, ms; the variables em, and ms are related to -----

------ data type. 

 a) int b) char 

 c) string  d) Boolean 

468.  ------------data type helps user in creating a list of identifiers. 

 a) int b) Float 

 c) Char d) Enumerated 

469. In an example enum holidays (Sunday, Saturday); The list of values Sunday, Saturday 

 Are called as------constants. 

 a)enumeration b)string 

 c)char d)float 

470. In an example enum  work_day (Monday =1, Tuesday, Wednesday). The constant 

 Wednesday are assigned---------integer constant 

 a)1 b)0 

 c)2 d)3 

471. ----class is another qualifier that can be added to a variable declaration. 

 a)Storage b)Sub] 

 c)Static d)Register 

472. Auto, static, enter and register are called as ------------- 

 a) Static b) register 

 c) auto d) storage specifier 

473. Static and Register variables are automatically initialized to -------value when they are 

declared. 

 a) 1 b) 2 

 c) 0 d) 3 
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474. Auto variables get undefined values known as ---------------- 

 a) garbage b) auto 

 c) register d) static 

475. Which storage class defines local variable known to the block in which they are defined? 

 a)static  b)auto 

 c)extern d)register 

476. Storage class variables defined with in a function or a block cease to exist, the moment 

the function or the block looses its scope-------------------- 

 a) auto b) static 

 c) extern d) register 

477. ---------modifier allows the variables to exist in the memory of the computer, even if its 

function of block looses its scope. 

 a) Auto b) Static 

 c) Extern d) Register 

478.  ------------storage class global variable known to all functions in the current program. 

 a) Auto b) Static 

 c) Extern d) Register 

479. --------------storage class variables are defined in another program 

 a) Extern b) Auto 

 c) Static d) Register 

480. The modifier------------instructs the compiler to store the variable in the CPU register to 

optimize access. 

 a) auto b) static 

 c) extern d) register 

481. Built in Data type is also called as--------data type 

 a)fundamental b)secondary 

 c)integer d)void 

482. -----is also called as fundamental or Basic data type 

 a)in-built data type b)built in data type 

 c)float d)char 

483. How many fundamental data types are there?---------- 

 a)Two b)Three 

 c)Four d)One 

484. ------type is further divided into int and char 

 a)integral b)int 

 c)chart d)float 

485. -------data type cannot hold Fractional values. 

 a)int b)char 

 c)float d)double 

486. ------data type that can hold bold character data and the integer data 

 a)int b)char 

 c)float d)double 

487. ------data type is further divided into float and double 

 a)int b)char 

 c)float d)double 

488. -----type can store values with fractional part. 

 a)int b)char 

 c)float d)double 

489. -----data type to indicates the function does not return a value 

 a)Main b)Void 

 c)Static d)Public 

490. -----type is used to declare a generic pointer 

 a)float b)void 

 c)static d)int 

491. Signed, unsigned, long and short are some of the------ 

 a)data  b)derived data 

 c)modifiers d)void 

492. In an example int num [5]={2,3,4,5,6}, what is the positional value of the element 4 in an 

 array?........... 

 a)1 b)0 

 c)2 d)3 
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493. What is the range for char data type?......... 

 a)-126 to 127 b)128 to -127 

 c)-128 to 127 d)-127 to 128 

494. int data type has the range of values……….. 

 a)-32767 to 32768 b)-32768 to 32767 

 c)32768 to 32769 d)32767 to 32768 

495. The long int, signed long int has ---------bytes. 

 a)2 b)4 

 c)3 d)8 

496. --------- is a variable that holds a memory address. 

 a)Pointer b)Char 

 c)Float d)Long double 

497. Every byte in the computer‘s memory has an---------- 

 a)data b) 0 or 1 

 c)address d)null 

498. The address number starts at-------- 

 a)1 b)2 

 c)NULL d)3 

499. In an 640 kb memory size, addresses commencing from NULL and goes upto------ 

 a)655359 b)655356 

 c)655357 d)65355 

500. Every variable will be referred by its----------- 

 a)name b)address 

 c)int d)data 

501. Addressing is done using------number system. 

 a)binary b)octal 

 c)hexadecimal d)decimal 

502. The pointer data type address of--------operator is used. 

 a)& b)# 

 c)/ d)* 

503. The---------symbol is used to declare a pointer variable. 

 a)* b)& 

 c)# d)/ 

504. The value at operator (*) is an -----operator. 

 a)unary b)binary 

 c)ternary d)octal 

505. The name assigned to a data field that can assume any of a given set of values is defined 

as the----------- 

 a)constant b)variables 

 c)num d)char 

506. -----are user defined named entities of memory locations that can store data. 

 a)Variables b)Constant 

 c)Data d)Char 

507. Variable names must begin with---------- 

 a)letter b)number 

 c)$ d)# 

508. The names beginning with an underscore are reserved for---------variable. 

 a)internal system b)external system 

 c)local d)globar 

509. -----allocates memory, based on the data type of the variable 

 a)Interpreter b)Compiler 

 c)Link d)Converter 

510. ------must be declared before it is used. 

 a)Constant b)Variable 

 c)Data type d)Float 

511. ------variable of the same data type can be declared in a single declaration statement. 

 a)only one b)more than one 

 c)two d)three 

512. Every variable should be separated by----------separator. 

 a)comma b)semicolon 

 c)colon d)dot 
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513. Integer values are stored in---------bit format in binary form. 

 a)8 b)16 

 c)32 d)64 

514. How many bits are used to store data starting from right extreme? 

 a)15 b)16 

 c)32 d)64 

515. The maximum value stored in an integer variable is--------- 

 a)32768 b)-32768 

 c)32767 d)32780 

516. The minimum value stored in an integer variable is--------- 

 a)-32768 b)32769 

 c)-32767 d)32780 

517. ------- bit is also called as the most significant bit or sign bit. 

 a)15
th

 b)16
th

 

 c)18
th

 d)19
th

 

518. The 16
th
 bit will have a value--------if negative value is stored. 

 a)1 b)0 

 c)-1 d)2 

519. When the modifier unsigned is used the integer data type will store only--------- 

 values, the sign bit is also used to store data. 

 a)negative b)positive 

 c)one d)two 

520. ----alters the base data type to yield new data type. 

 a)Modifier b)Constant 

 c)Arrays d)Data 

521. The base data type should be prefixed with the---------at the time of declaring a variable 

 a)modifiers b)constant 

 c)variable d)dimension 

522. The range to store integer data goes upto------- 

 a)2
15

 b)2
16

 

 c)2
14

 d)2
13

 

523. In an example int*a; which one is the pointer variable? 

 a)int b)* 

 c)a d) ; 

524. The unsigned char, and char data type  has-------bits. 

 a)8 b)16 

 c)32 d)64 

525. The enum, unsigned int, short int and int data types uses------bits. 

 a)32 b)8 

 c)16 d)64 

526. What is the length of double data type?---------- 

 a)32 b)8 

 c)16 d)64 

527. What is the length of long double data type?--------- 

 a)32 b)8 

 c)16 d)80 

528. The declaration statement char *cp, is a ---------type pointer 

 a)integer  b)character 

 c)string d)double 

529. The declaration statement char*const cp.cp is a-------pointer. 

 a)string b)constant 

 c)character d)integer 

530. In implicit conversion if one of the operands is a------the other is converted to a float 

 a)int b)float 

 c)long int d)double 

531. ------- is an operator which returns the memory size requirements in terms of bytes 

 a)size of b)long 

 c)size d)double 

532. In an example long double a; int b; a=6 ; b=4 ; what is the output of size of(a*b)? 

 a)8 b)10 

 c)4 d)2 
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533. In an example, double x;floaty; x=3;y=2 ; what is the output of size of(x*y)?---- 

 a)8 b)10 

 c)4 d)5 

534. --------variables are sensitive to the data type they point to 

 a)pointer b)integer 

 c)float d)char 

535. -----refers to the process of changing the data type of the value stored in a variable. 

 a)Type cast b)Type float 

 c)Type int d)Type char 

536. The modulus operator uses ------ character. 

 a)%` b)/ 

 c)* d)+ 

537. int x; x=7/3   ; what is the value stored in x?------- 

 a)2 b)2.5 

 c)3.6 d)3.0 

538. float a; a=  7/3; what is the value stored in a?------------ 

 a)2.5 b)2 

 c)3 d)2.0 

 

 

 

   

 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

BASIC STATEMENTS 

 

I. Choose the Correct Answers :-      

1. Basic statements in  C++ are constructed using 

 a) tokens b) identifiers 

 c) constants d) variables 

2. In how many ways data can be assigned to a variable in C++? 

 a) 2 b) 3 

 c) 1 d) 4 

3. Which is the predefined object that reads data from the keyboard? 

 a) cin b) cout 

 c) if…else d) switch 

4. cin is available in the header file 

 a) istream.h b) ostream.h 

 c) iostream.h d) stdio.h 

5. Which comprises of the combined properties of istream and ostream? 

 a) istream.h b) ostream.h 

 c) iostream.h d) stdio.h 

6. A preprocessor directive starts with 

 a) # b) <  

 c) << d) >> 

7. Which operator extracts data from the input stream object? 

 a) # b) < 

 c) << d) >> 

8. Which is the predefined object of standard output stream? 

 a) cin b) cout 

 c) if..else d) switch 

9. Which operator is called the insertion operator? 

 a) # b) < 

 c) << d) >> 

10. A C++ program has primarily 

 a) two sections b) three sections 

 c) four sections d) five 

11. Which function is called automatically? 

 a) main b) void 

 c) inline d) online 

12 Which statement introduces a variable‘s name and its type? 

 a) declaration  b) assignment  

 c) control d) loop 

13. Which statement assigns value of the right hand side to the left hand side? 

 a) declaration b) assignment 

 c) control d) loop 

14. Which converts the data type of an expression to the data type of the variable on left? 

 a) C++ compiler b) C++ interpreter 

 c) C++ assembler d) both a and b 

15. In control statements the flow of control is in 

 a) sequence b) branches to another part 

 c) repeat the sequence  d) all 

16. Program statements that cause a jump for one part to another are called as 

 a) declaration b) assignment 

 c) control d) loop 

17. Control structure are categorized in 

 a) 2 ways b) 3 ways 

 c) 4 ways d) 5 ways 

18. The major categories of control structure are 

 a) decision  making statement b) looping statement 

 c) both a and b d) declaration statement 

19. The control structures are implemented in C++ using 

 a) decision making statement b) looping statement 

 c) control statements d) declaration statement 
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20. Which statement chooses the best two alternatives? 

 a) simple if b) if…else statement 

 c) nested if d) switch 

21. Which statement branches for multiple values? 

 a) for b) if..else statement 

 c) nested if d) switch 

22. Which is the simplest of all decision statements? 

 a) simple if b) if…else statement 

 c) nested if d) switch 

23. if statement are implemented in 

 a) two forms b) three forms 

 c) four forms d) five forms 

24. Which is a valid construct of if? 

 a) if (a>b)  b) if a>b 

    cout<<‖ans‖     cout<<‖ans‖ 

 c) if (a>b) d) (a>b) 

    cout>>‖greater‖             cout<<‖ans‖ 

25. if…else containing another if statement is called as 

 a) a simple if  b) if..else statement 

 c) nested if d) switch 

26. Each else matches with the nearest unmatched preceding 

 a) if b) if..else 

 c) for  d) switch 

27. Which is a multiple branching statement based on the condition? 

 a) if b) if..else 

 c) for d) switch 

28. Every action block of switch should be terminated using 

 a) break b) continue 

 c) return d) all 

29. Switch selection expression can be of an 

 a) integer b) float 

 c) double d) void 

30. Which execute a set of instructions repeatedly for a certain number of times? 

 a) if b) if…else 

 c) loop d) switch 

31. How many segments does a looping statement consist of? 

 a) 2 b) 3 

 c) 4 d) 5 

32. Name the segments of the looping block? 

 a) body of the loop, control statement b) entry-check loop, exit-check loop 

 c) for and while loop d) all the above 

33. How many times loops are unconditionally executed (condition at the end)? 

 a) zero times b) atleast once 

 c) more than once d) exactly two 

34. Based on which the loops are classified? 

 a) condition b) position of the condition 

 c) both a & b d) none 

35. What are classifications of loops? 

 a) entry-check loop, exit-check loop b) for and while loop 

 c) for, while, do…while d) all the above 

36. How many kind of loops are there in C++? 

 a) 2 b) 3 

 c) 4 d) only one 

37. Name the kinds of loop? 

 a) for b) while 

 c) do..while d) all 

38. Which is called as the exit-check loop? 

 a) for b) while 

 c) do..while d) all 

39. Which is called as the entry-check loop? 

 a) for b) while 

 c) do..while d) all 
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40. Which is an entry-controlled loop? 

 a) for b) while 

 c) do..while d) all 

41. Which loop is used for a predetermined number of times? 

 a) for b) while 

 c) do..while d) all 

42. The parameters of for are separated by a 

 a) , b) ; 

 c) : d) . 

43. Each instruction of the for loop must be separated by a 

 a) comma b) semi-colon 

 c) colon d) dot 

44. Which statemet forces the next iteration of the loop to take place? 

 a) break b) continue 

 c) else d) loop 

45. Which would exit from the current loop? 

 a) break b) continue 

 c) else d) loop 

46. One loop within another is called as 

 a) nested if b) nested for 

 c) nested loop d) multiples statement 

47. How many times the loop will be executed? 

 It ctr=1; 

 For(; ctr<10;ctr++) 

 {cout <<ctr; 

 } 

 a) 1 time b) 9 time 

 c) 10 time d) 11 times 

48. An outer loop and the inner loop having same control variable leads to 

 a) syntax error b) logical error 

 c) semantic error d) all 

49. Program written in high level language is called as 

 a) source code b) object code 

 c) programs d) machine readable file 

50. The machine readable form of the program is called 

 a) source code b) object code 

 c) programs d) low level file 

51. Which creates object file from the source file? 

 a) compiler b) interpreter  

 c) assembler d) none 

52. The grammar of a language is called as 

 a) syntax                        b) statement      

 c) rule d) instruction 

53. Which is linked with libraries to create a executable file? 

 a) source code                b) object code    

 c) programs d) compiler 

54. What will be the output of the program 

  Int ctr =1; 

 for(;ctr<10; ctr++) 

 {cout<< ctr; 

   ctr=1; 

   } 

 a) 1,2,3,4,5,6,7,8,9 b) 1 and indefinite 

 c) 1,1,1,1,1,1,1,1,1 d) 1,2,3,4,5,6,7,8,9,10 

55. Which is invlaid? 

 a) for( ;; )                    b) do c) while( ) d) for ( ; ; ) 

    {                                 {   {                         { 

 …..                                …. ….  …… 

 continue                  continue; continue; continue; 

 …..                            …. ….  …… 

 }                               } while ( )   }                          } 
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56. Basic Statements in C++ are constructed using ______ 

 a) Variables b) Constants 

 c) Methods d) Tokens 

57. The different basic statements of C++ are ______ 

 a) Input/Output b) Assignment 

 c) Control structures d) All the above 

58. Input statement is used to ____ data. 

 a) read b) process 

 c) display d) control 

59. Output statement is used to ____ data. 

 a) read b) process 

 c) display d) control 

60. There are ____ methods for assigning data to the variables. 

 a) 1 b) 2 

 c) 3 d) 4 

61. Data can be given to variable at _____ time. 

 a) opening b) run 

 c) typing d) writing 

62. Data is read from the key board during runtime by using the object _____ 

 a) Cout b) Inc 

 c) cin d) outC 

63. cin is a predefined object that corresponds to a standard ____ stream. 

 a) input b) output 

 c) program d) C++ 

64. Input stream represents the flow of data from the standard ____ device. 

 a) input b) output 

 c) program d) C++ 

65. ____ is the input device. 

 a) Monitor b)  Printer 

 c) Key board d) Plotter 

66. cin are available in a header file called as _____ 

 a) stdio.h b) stdlib.h 

 c) istream.h d) conio.h 

67. The basic input operations are managed by a set of declarations available in the ____ 

 a) isteam b) ostream 

 c) stdio.h d) stdlib.h 

68. The basic output operations are managed by a set of declarations available in the ____ 

 a) isteam b) ostream 

 c) stdio.h d) stdlib.h 

69. Iostream.h file comprises the combined properties of ______ 

 a) istream b) ostream 

 c) stdio.h d) both (a) and (b) 

70. The >> is the extraction or _____ from operator. 

 a) put b) get 

 c) cut d) net 

71. Snippet is a ____ program. 

 a) small b) big 

 c) full d) segment 

72. The extraction operator (>>) extracts data from the input stream and places the value in 

the ______ 

 a) constant b) variable 

 c) data d) program 

73. ____ values can be read from the input stream. 

 a) one b) two 

 c) three d) multiple 

74. Using more than one extraction operator is called ______ of operator. 

 a) nesting b) putting 

 c) cascading d) usage 

75. cout is a predefined object that corresponds to a standard ____ stream. 

 a) input b) output 

 c) program d) C++ 
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76. Output stream represents the flow of data from the standard _____ devices. 

 a) input b) output 

 c) program d) C++ 

77. Cout is predefined object of standard _____ stream. 

 a) input b) output 

 c) program d) C++ 

78. The standard output stream normally flows to the ______ 

 a) Monitor b) Printer 

 c) Key board d) Plotter 

79. The operator << is called the insertion operator or _____ to operator. 

 a) put b) get 

 c) cut d) net 

80. Cascading of insertion operator facilities sending of __________output in a single 

statement. 

 a) single b) two 

 c) three d) multiple 

81.  A C++program has _____________ 

 a) Include files b) Declaration of variables 

 c) Main function d) All the above 

82. A C++ program has primarily____-sections. 

 a) single b) two 

 c) three d) multiple 

83. When the program is executed the main () function will be executed_________ 

 a) Manually b) automatically 

 c) Not at all d) many times 

84. In C++ the only executed function is ________ 

 a) conio() b) main () 

 c) cout d) cin 

85. Declaration of variables done_______they are used in a program. 

 a) before b) after 

 c) any time d) anywhere 

86. Declaration of a variable introduces a variable‘s name and its associated ______type. 

 a) variable b) constant 

 c) data d) program 

87. *iptr; is a ______________variable. 

 a) float b) character 

 c) pointer d) string 

88. Pointer variable only _____fetched to store data. 

 a) integer b) float 

 c) memory d) character 

89. A variable gets defined when _____________is set aside. 

 a) memory b) float 

 c) integer d) character 

90. Pointer variable get defined only when memory is fetched using ___ memory operator. 

 a) new b) old 

 c) recent d) basic 

91. An assignment statement, assigns value on the ____ hand side of an expression to the 

variable on the left hand side. 

 a) top b) bottom 

 c) left d) right 

92. ____ is the assignment operator. 

 a) + b) / 

 c) = d) * 

93. Converting one data type automatically to another is called _____ conversion. 

 a) implicit b) explicit 

 c) manual d) compiler 

94. Control structures statements in a program are executed in _____ order. 

 a) sequential b) serial 

 c) any order d) random 

95. Based on condition ______ from one part of the program to another. 

 a) variable b) control 

 c) constant d) program 
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96. The major category of control structures are _____ 

 a) Decision making statements  b) Looping Statements 

 c) both (a) and (b) d) none 

97. _____ statement which chooses between two alternatives. 

 a) if….else b) switch 

 c) for d) while 

98. ____ creates branches for multiple alternatives sections of code, depending on the value 

of a single variable. 

 a) if…..else b) switch 

 c) for d) while 

99. If statement implemented in ___forms 

 a) 1 b) 2 

 c) 3 d) 4 

100. Once the true block is executed in an if ..else statement,when the condition is _________ 

 a) true b) false 

 c) positive d) negative 

101. Condition should always be enclosed in a pair of ___________ 

 a) [ ] b) ( ) 

 c) { } d) < > 

102. If with in another if is called __________statement. 

 a) loop b) twisted 

 c) nested d) executable 

103. Each else matches with the nearest unmatched preceding_________ 

 a) else b) if 

 c) switch d) for 

104. Every action block in switch should be terminated with  a _________statement. 

 a) if b) else 

 c) break d) continue 

105. If _____statement is not given all action blocks are executed sequentially from the point 

where the control has been transferred based on the condition. 

 a) if b) else 

 c) break d) continue 

106. _______execute a set of instructions repeatedly for a certain number of times. 

 a) if b) else 

 c) loop d) switch 

107. The variable used in a loop referred to as the __________variable. 

 a) simple b) complex 

 c) compound d) control 

108. The iterations of the block is totally controlled by ___________variable. 

 a) simple b) complex 

 c) compound d) control 

109. A looping block consists of ______segments. 

 a) 1 b) 2 

 c) 3 d) 4 

110. The control statement checks the ___________ 

 a) condition b) calculation 

 c) checking d) execution 

111. There are _______kinds of loops in C++. 

 a) 1 b) 2 

 c) 3 d) 4 

112. The loops available in C++  are ____________- 

 a) for loop b) while loop 

 c) do ..while d) all the above 

113. Do … while <(condition)> is called as ……….loop. 

 a) exit check b) entry check 

 c) middle check d) none 

114. The body of the while loop will be executed only if the test expression results______ 

 a) false b)true 

 c) ok d) zero 

115. The body of the do-while loop will be executed only if the test expression results____ 

 a) false b)true 

 c) ok d) zero 
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116. for (; ;) loop is an _______controlled loop. 

 a) exit b) entry 

 c) middle d) none 

117. For loop is used when an action is to be repeated for a predetermined_______of times 

 a) one b) two 

 c) three d) number 

118. The control variable of for loop is initialized the ___________time when the control 

enters the loop for the first time. 

 a) first b) second 

 c) third d) fourth 

119. The for loop is terminated when the test condition evaluates to _________ 

 a) false b) true 

 c) ok d) zero 

120. The _______statement forces the next iteration of the loop skipping any code. 

 a) if b) else 

 c) break d) continue 

121. To come out of the loop before normal exit is _________ 

 a) if b) else 

 c) break d) continue 

122. In nested loop, an outer loop and inner loop cannot have the same ______variable 

 a) simple b) complex  

 c) compound  d) control. 

123. In nested loop same control variable will lead to __________error. 

 a) Syntax b) logical 

 c) Compiler d) execution 

124. In nested loop the inner loop must be completely ________inside the body of the outer 

loop. 

 a) nested b) fixed 

 c) multiple d) more 

125. Basic statements in C++ are constructed using___ 

 a) tokens b) variables 

 c) constants d) operators 

126. ________is a predefined object that corresponds to a standard input stream. 

 a) printf b) cout 

 c) cin d) scanf 

127. ________file comprises the combined properties of istream and ostream 

 a) stdio.h b) iostream.h 

 c) conio.h d) string.h 

128. A ___ file comprises of all standard declarations and definitions for predefined functions. 

 a) input b) declaration 

 c)header d) output 

129. _________is a predefined object of standard output stream. 

 a) printf b) cout 

 c) cin d) scanf 

130. A C++ program has primarily ___________-sections. 

 a) 1 b) 2 

 c) 3 d) 4 

131. A _________gets defined when memory is set aside. 

 a) operators b) variable 

 c) operand d) token 

132. The _______is the assignment operator. 

 a) + b) ! 

 c) = = d) = 

133. __________variables get defined only when memory is fetched 

 a) control b) loop 

 c) pointer d) none of these 

134. ____is the simplest of all the decision statements. 

 a) simple if b) if..else 

 c) switch case d) none of these 

135. _________statement which chooses between two alternatives. 

 a) simple if b) if..else 

 c) switch case d) none of these 
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136. There are ______________ kinds of loops in c++ 

 a) 1 b) 2 

 c) 3  4d) 4 

137. In for loop, ________is executed only once. 

 a) initialization  b) text condition 

 c) increment d) none of these 

138. In for loop _____segment is executed before the commencement of new iteration. 

 a) initialization  b) text condition 

 c) increment d) none of these 

139. A program written in high level language is called as _______________ 

 a) object code b) source code 

 c) file d) none of these 

140. ______create object   files from source code. 

 a) linkers b) compilers 

 c) debugger d) none of these 

141. The machine readable form of a program is called _____________file. 

 a) source b) linker 

 c) object d) none of these 

142. One can include the _______file in the program by using a preprocessor directive. 

 a) object  b) source  

 c) header d) none of these 

143. A preprocessor directive starts with ______, which instructs the compiler to do the 

required job. 

 a) # b) @ 

 c) * d) ! 

144. The extraction operator _______extracts data from the input stream object and places the 

value in the variable to its right. 

 a) < b) > 

 c) << d) >> 

145. The ______operator is called the insertion operator or put to operator which directs the 

contents of the variable to its right to the object to its left. 

 a) < b) > 

 c) << d) >> 

146. _______of a variable introduces a variable‘s name & its associated data type. 

 a) operation b) declearation 

 c) association d) none of these 

147. _______are unconditionally executed at least once, if the condition is placed at the end of 

the body of the loop. 

 a) loops b) operators 

 c) statements d) none of these 

148. ________statement accomplishes jump from the current loop. 

 a) while b) case 

 c) break d) continue 

149. The ______ and ____ are the major category of control structures. 

 a) decision making and looping statement  b) I / O Statements 

 c) Tokens and Identifiers d) Variables and Constants 

150. _______operator is used to separate a set of instructions in a for loop. 

 a) ; b) = 

 c) : d) . 

151. _____variables get defined only when memory is fetched. 

 a) auto b) pointer 

 c) extern d) register 

152. The _________operations are managed by a set of declarations available in istream.h and 

ostream.h header files. 

 a) Input, Output b) conditional 

 c) loop d) None of these 

153. If statement is implemented in ____forms. 

 a) 2 b) 3 

 c) 4 d) 5 

154. A(n) _____file is created from an error free source code. 

 a) linker b) object 

 c) executable d) source 
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155. An outer loop can not have the same _____variable is it will lead to logical errors. 

 a) register b) control 

 c) pointer d) None of the these 

156.  The _____file is linked with the essential libraries to generate an executable code. 

 a) source b) Input 

 c) Output d) Object 

157. A loop‘s execution is terminated when the test condition evaluates to _________- 

 a)True b) False 

 c) o d) None of these 

158. Nesated if..else statement can be replaced by __________--statement in C++ 

 a) Select case b) Switch case 

 c) For d) do while 

159. For loop statement has _________-sections. 

 a) 2 b) 3 

 c) 4  d) 5 

160. The simplest decision making statement is ____________ 

 a) if ..else b) switch case 

 c) if d) do while 

161. There are ____-segments is a looping block. 

 a) 2 b) 3 

 c) 4  d) 5 

162. Which statement would exit the current loop? 

 a) Cosntinue b) Break 

 c) default d) None of these 

163. ________statements change the execution of statements from the sequential order. 

 a) Input b) Output 

 c) Assignment d) Control 

164. _________is used to include the header file in the program. 

 a) < > b) { } 

 c) [ ] d) ( ) 

165. When a C++ program is executed, first the _____function will be executed automatically. 

 a) void b) main 

 c) recursive d) None of these 

166. There are _____ways to assign data to the variables. 

 a) 2 b) 3 

 c) 4 d) 5 

167. _________-of insertion operator facilitates sending of multiple output in a single 

statement. 

 a) Extraction b) Cascading 

 c) Defining d) None of these 

168. ____-statement are used to define user defined data types, identifiers. 

 a) Input, Output b) Control 

 c) Declaration d) None of these 

169. The extraction operator is __________ 

 a) < b) > 

 c) << d) >> 

170. The insertion operator is ___________ 

 a) < b) > 

 c) << d) >> 

171. How many methods are there for assigning data to the variables in C++ ?______ 

 a) 2 b) 3 

 c) 4` d) 5 

172. Data is read from the keyboard during run time by using the object __________ 

 a) cin b) cni 

 c) nci d) nic 

173. Cin is a predefined object which corresponds to a standard ________stream. 

 a) input b) output 

 c) process d) 10 

174. The declarations for the object cin are available in header file called as __________ 

 a) istream.h b) istream 

 c) stream.h d) stream 
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175. ______file comprises of all standard declarations and definitions for predefined 

functions. 

 a) header b) footer 

 c) istream d) iostream 

176. The header file can be given by using a preprocessor directive starts with _______ 

 a) # b) $ 

 c) / d) % 

177. The operator ____________is the extraction or get from operator. 

 a) >> b) << 

 c) > d) < 

178. The operator _is called the insertion operator or put to operator. 

 a) >> b) << 

 c) > d) < 

179. The extraction operator that extracts data from the input stream object is _____ 

 a) cin b) cout 

 c) cio d) count 

180. ____is the assignment operator. 

 a) = b) < 

 c) > d) = = 

181. Program statements that causes jumps are called as ____ statements or structures. 

 a) control b) assignment 

 c) increment d) decrement 

182. ___ statement which chooses between two alternatives. 

 a) if-else b) if 

 c) for d) while 

183. ____ creates branches for multiple alternatives sections of code, depending on the value 

of a single variable. 

 a) switch b) if 

 c) for  d) while 

184. If the given condition true in if-else statements then ___ followed by block of statements 

are executed. 

 a) if b) else 

 c) then d) for 

185. The multiple branching statements is _____ statement. 

 a) if b) switch 

 c) for d) while 

186. In order to exit from switch statement ____ statement is used. 

 a) break b) continue 

 c) switch d) case 

187. Switch expression should be evaluated to an ____ constant only. 

 a) integer b) string 

 c) variable d) float 

188. ____ executes a set of instructions repeatedly for a certain number of times. 

 a) loop                     b) if                       c) if-then d) switch 

189. How many kinds of loops are there in C++? 

 a) 1                    b) 2                      c) 3                  d) 4 

190. _____  is called as exit-check loop. 

 a) do-while                b) while              c) for                  d) if 

191. ____ <condition> is called as the entry-check loop. 

 a) while                     b) break              c) for                  d) do 

192. ____ is an entry controlled loop and is used when an action is to be repeated for a 

predetermined number of times. 

 a) for                         b) switch             c) if                  d) break 

193. ____ statement forces the next iteration of the loop to take place, skipping any code 

following the continue statement in the loop body. 

 a) Continue b) break 

 c) switch d) Nested-if 

194. ____ statement is used when a loop‘s execution is terminated when the test condition 

evaluates to false. 

 a) continue                     b) break  c) if              d) switch 

195. A loop embedded within another loop is called _____ 

 a) Nested                 b) Loop c) Break d) Continue 
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196. ____ statement forces the next iteration of the loop. 

 a) break                   b) continue c) default d) none of these 

197. In for loop, ____ is executed before the commencement of every iteration. 

 a) initialization b) text condition 

 c) increment d) none of these 

198. ____ is a multiple branching statement where, based on a condition, the control is 

transferred to one of the many possible points. 

 a) if….else                   b) switch c) if…else…..           d) none of these 

199. ____ loop is called as the entry-check loop. 

 a) while                       b) for c) do                d) none of these 

200. ____ loop is called as counter style loop process. 

 a) do                            b) while c) for                d) none of these 

201. _____ statement is used to terminate every action block of switch statement. 

 a) break                         b) continue c) default d) none of these 

202. There are _____ kinds of loops in C++. 

 a) 1                   b) 2                      c) 3                 d) 4 

203. The inner loop should be completely nested ____ the body of the outer loop. 

 a) outside                 b) on c) inside d) none of these 

204. Program statements that cause jumps are called as _____ statements. 

 a) Input, Output b) Control 

 c) Declaration d) None of these 

205. In ____ loop statement the condition  is checked at the end. 

 a) Select case b) Switch case 

 c) For  d) do while 

206. Which one of the following is not a loop statement? 

 a) if-else                     b) for c) while d) do-while 

207. While <(condition)>{….} loop is called as the ____ loop. 

 a) exit check b) entry check 

 c) middle check d) none 

208. On repetition of the for loop, the control variable is _____  before the body of the loop is 

executed. 

 a) decremented b) incremented 

 c) subtracted d) divided 

209. One loop with in another loop is called as _____ 

 a) nested                    b) fixed c) multiple                  d) more 
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FUNCTIONS 

 

I. Choose the Correct Answers :-      

1. Which are the building blocks of C++ programs ? 

 a) Functions     b) instructions 

 c) variables   d) keywords 

2. Which are the executable segments in a program ? 

 a) data types  b) functions 

 c) statements  d) keywords 

3. Which is the starting point for the execution of a program ? 

 a) main() b) iostream.h 

 c) void d) inline 

4. Which reduce the size of the program ? 

 a) instructions  b) variables 

 c) keywords d) functions 

5. Which induce the reusability of the code ? 

 a) Functions b) instructions 

 c) variables d) keywords 

6. Which other programs can share by compiling separately and loading them together ? 

 a) data types b) Functions 

 c) statements d) keywords 

7. Which statement marks the end of the function ? 

 a) return b) } curly braces 

 c) void main () d) { & } 

8. Which transfer control to the statement after call statement ? 

 a) void b) main 

 c) return d) {} 

9. Function should be declared 

 a) at the end of the program b) before they are used in a program 

 c) at the beginning of the program d) after they are called 

10. Declaration of a function is made through a 

 a) function prototype b) function name 

 c) function type d) template 

11. Which are provided to the compiler by the prototype ? 

 a) numbers b) type of arguments 

 c) type of return values d) all of these 

12. Which acts as placeholder in the prototype ? 

 a) Constant b) variable 

 c) statement d) keywords 

13. Which is an optional in an argument ? 

 a) variable b) statement  

 c) constant d) keywords 

14. A function can be invoked or called by its 

 a) Name b) parameters 

 c) reference d) all of these 

15. Function name include a set of 

 a) actual parameters b) dummy parameters 

 c) formal parameters d) all of these 

16. Parameters are separated or delimited by 

 a) commas b) period 

 c) semicolon d) scope resolution operator 

17. Which communicate with the function through arguments or parameter. 

 a) call statement b) name 

 c) datatype d) operators 

18. Which is the channel through which data flows from the call statement to the function 

and vice versa? 

 a) parameter b) name 

 c) reference d) all of these 

19. Function that have arguments can be invoked in 

 a) one way b) two ways 

 c) three ways d) four ways 
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20. Which function creates new variables to store the value of the argument passed to it? 

 a) call by value b) call by reference 

 c) call by function d) call by datatype 

21. Which copies the values of actual parameters into the formal parameters. 

 a) call by value b) call by reference 

 c) call by function d) call bydatatype 

22. In call by value method the flow of data is always from the 

 a) call statement to the function defined b) call statement to the function main 

 c) call statement to the function name d) both a & c 

23. In call by value method any change in the formal parameter is not reflected back to the 

 a) actual parameter b) formal parameter 

 c) dummy parameter d) arguments 

24. In which method formal parameter become alias to the actual parameter. 

 a) call by reference  b) call by value 

 c) call by function d) call by datatype 

25. Which can be passed in the form of constants are variable or expressions to the formal 

parameter ? 

 a) formal parameter b) actual parameter 

 c) dummy parameter d) arguments 

26. The function that return no value is declared as 

 a) void b) main 

 c) inline d) static 

27. The function prototype float m (float, int), return type is 

 a) float b) int  

 c) char d) double 

28. char * success () 

 a) pointer to character b) operator of the two operands 

 c) pointer to a variable d) pointer to a function void 

29. In which feature, the compiler replaces the function can statement by its definition. 

 a) inline function b) procedural function 

 c) main function d) manipulative function 

30. Which function looks like a normal function in the source file ? 

 a) procedural function b) inline function 

 c) main function  manipulative function 

31. Which inserts the function code directly into the calling program ? 

 a) inline function b) procedural function 

 b) main function d) manipulative function 

32. Which execute faster and require more memory space ? 

 a) procedural function b) inline function 

 c) main function d) manipulative function 

33. Which keyword is inserted to make a function inline ? 

 a) Online b) void 

 c) main d) inline 

34. The keyword inline is used in the 

 a) function header b) main function 

 c) sub function d) void function 

35. Which refers to the accessibility of a variable ? 

 a) scope b) function 

 c) identifier d) arguments 

36. How many types of scope are there in C++? 

 a) 2 b) 4 

 c) 5 d) 3 

37. Which is defined within a block ? 

 a) local variable b) constants 

 c) statements d) functions 

38. Which cannot be accessed from outside the block of its declaration ? 

 a) local variable b) file variable 

 c) function variable d) class variable 

39. Which cannot be accessed from outside the block of its declaration ? 

 a) local variable b) file variable 

 c) function variable d) class variable 
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40. Which exist only within the block of code? 

 a) file variable b) local variable 

 c) function variable d) class variable 

41. Blocks of code begin and end with ? 

 a) { } b) [ ] 

 c) ―  ―  d) ( ) 

42. Which is created upon entry into the block and destroyed upon exit ? 

 a) function variable b) class variable 

 c) local variable d) class variable 

43. The scope of variables declared with a function is extended to the block and all sub block 

is called as 

 a) function scope b) local scope 

 c) class scope d) file scope 

44. A variable declared above all blocks and function has the scope of a 

 a) function b) local 

 c) class d) file 

45. Which reveals the hidden scope of a variable ? 

 a) scope operator b) scope type 

 c) scope name d) scope function 

46. Which is the scope resolution operator / 

 a) : : b) ? : 

 c) ; d) & 

47. #include <iostream.h> 

 #include<conio.h> 

 void swap(int &x, int &y) 

 { 

 int t; 

 t=x; x=y; y=t; 

 cout<<x<<y<<t; 

 } 

 is an example of 

 a) call by value b) call by reference 

 c) manipulative d) inline function 

48. Find the output 

 #include <iostream.h> 

 #include <conio.h> 

 void main() 

 { 

 int n1=10, & n2=n1; 

 n2++; 

 cout<<n1; 

 } 

 a) 10 b) 11 

 c) 12 d) 13 

49. ______ are the building blocks of c++ program. 

 a) classes b) functions 

 b) statements d) operations 

50. _____ are the channels through which data flows from statements to the functions and 

vice versa. 

 a) functions b) programs 

 c) parameters d) value 

51. A function can be caused or invoke from another functions by using its _____ 

 a) name  b) parameter 

 c) reference d) value 

52. Functions are advantageous as they reduce the _____ of the programs. 

 a) speed b) size 

 c) use d) length 

53. Functions are advantageous as they induce the _____ of code. 

 a) speed b) size 

 c) use d) reusability 
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54. Call statement communicates with the function through ______ 

 a) arguments b) call by value 

 c) call by reference d) actual parameters 

55. The default value is given in the form of _____ initialisation. 

 a) variable b) call statement 

 c) default argument d) function prototype 

56. The functions that return no value is declared as ______ 

 a) int b) float 

 c) void d) char 

57. ______ executes faster but require more memory space. 

 a) Normal function b) inline function 

 c) Void function d) none of these 

58. _____ refers to the accessibility of a variable. 

 a) Argument b) Range 

 c) Identifier d) Scope 

59. The _____ scope of variable declared within a function is extended to the function blocks 

and all sub-blocks therein. 

 a) local b) function 

 c) global d) class 

60. The scope resolution operator is _____ 

 a) : b) :: 

 c) ! d) none of these 

61. The life time of a ______ variable is the life time of the function block. 

 a) local scope b) function scope 

 c) file scope d) class scope 

62. The scope of a _____ scope variable is the entire program. 

 a) local b) function 

 c) file d) class 

63. A _____ can be shared by other programs by compiling it separately and loading them 

together. 

 a) function b) statement 

 c) parameter d) variable 

64. _____ are also the executable segments in a program. 

 a) functions b) operations 

 c) parameters d) values 

65. A ______ variable is defined within a block. 

 a) local b) file 

 c) function d) class 

66. A ____ variable is created upon entry into its block and destroyed upon exit. 

 a) local b) file 

 c) function d) class 

67. The life time of a ____ scope variable is the life time of a program. 

 a) class b) function  

 c) file d) local 

68. The ____ operator reveals the hidden scope of a variable. 

 a) scope b) class 

 c) function d) file 

69. _____ variable die when its block execution is completed. 

 a) local b) class 

 c) function d) file 

70. In call by reference method, any change made in the formal parameter is reflected back in 

the _____ parameter. 

 a) actual b) formal 

 c) default arguments d) none 

71. The variable in the ______ act as place holders. 

 a) prototype b) parameters 

 c) function d) none 

72. In __ method, the flow of data is always from the call statement to the function definition. 

 a) call by value b) call by reference 

 c) parameters b) none 
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73. The default values can be included in the ______ prototype. 

 a) function b) variable 

 c) default argument d) none 

74. The _____ statement communicates with the function through arguments or parameters. 

 a) if b) cout 

 c) call d) cin 

75. ______ statement marks the end of the function. 

 a) if b) break 

 c) return d) continue 

76. _____ statement transfers the control to the statement after the call statement. 

 a) if b) break 

 c) return d) continue 

77. Declaration of a function is made through a function ______ 

 a) variable b) prototype 

 c) statement d) none of these 

78. In ______ method, any change made in the formal parameter is reflected back to the 

actual parameter. 

 a) void b) call by reference 

 c) call by value d) none of these 

79. In ______ method, any change made in the formal parameter is not reflected back to the 

actual parameter. 

 a) void b) call by reference 

 c) call by value d) none of these 

80. In _____ function, reusability of code leading to saving of memory space and reduction 

in code size. 

 a) void b) inline 

 c) user defined d) recursive 

81. The keyword ______ is used to make the function as inline. 

 a) void b) include 

 c) main d) inline 

82. A _____ variable cannot be accessed from outside the block of its declaration. 

 a) Global b) File 

 c) Class d) Local 

83. The life time of a file scope variable is the life time of a _______ 

 a) function b) block 

 c) program d) class 

84. There are _____ types of scopes in variables declaration in C++. 

 a) 1 b) 2 

 c) 3 d) 4 

85. A block code begins and ends as ______ 

 a) [ ] b) ( ) 

 c) { } d) < > 

86. _______ functions insert the function‘s code directly into the calling program. 

 a) void b) inline 

 c) user defined d) recursive 

87. Functions should be declared ______ they are used. 

 a) after b) before 

 c) at the end d) none of these 

88. Function parameters can also be called as _______ 

 a) arguments b) values 

 c) constants d) identifiers 

89. ______ are the buildings  blocks of C++ programs. 

 a) variables b) constants 

 c) functions d) class 

90. Functions are also the _____ segments in a program. 

 a) readable  b) non readable 

 c) executable d) non executable 

91. The starting point for the execution of a program is ______ 

 a) class b) methods 

 c) main() d) cin 
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92. The advantages of functions are _____ 

 a) can be repeated b) called anywhere 

 c) called any time d) all the above 

93. Functions should be declared _____ they are used in a program. 

 a) after b) before 

 c) at that time d) any time 

94. Declaration of a function is made through the function ______ 

 a) prototype b) object 

 c) method d) class 

95. The main purpose of function prototype is to help the ____ to check the data requirement 

of the function. 

 a) interpreter b) compiler 

 c) template d) C++ 

96. With function prototyping, a ___ is always used when declaring and defining a function. 

 a) interpreter b) compiler 

 c) template d) C++ 

97. In a function declaration, the names of the arguments are ______ variables and therefore 

they are optional. 

 a) actual b) formal 

 c) dummy d) real 

98. The ______ in the prototype act as place holders. 

 a) variables b) constant 

 c) class d) method 

99. The arguments names are required in function definition , as the arguments are referenced 

_____ the function. 

 a) inside b) outside 

 c) first d) last 

100. A function can be called or invoked from another function by using its _____ 

 a) method b) class 

 c) name d) variable 

101. The function name may include a set of _____ parameters. 

 a) formal b) dummy 

 c) actual  d) variable 

102. The actual parameters are enclosed in parentheses are separated by _____ 

 a) comma b) full stop 

 c) semicolon d) colon 

103. The call statement communicates with the function through arguments or ______ 

 a) variable b) constant 

 c) dummy d) parameter 

104. In C++, functions that have arguments can be invoked by _____ 

 a) call by value b) call by reference 

 c) either (a) or (b) d) both (a) and (b) 

105. ____ the called function creates new variables to store the value of the arguments passed 

to it. 

 a) call by value b) call by reference 

 c) either (a) or (b) d) both (a) and (b) 

106. Call by value copies the values of actual parameters into the ______ parameters. 

 a) formal b) dummy 

 c) actual d) variable 

107. Actual and formal parameters have ______ memory locations. 

 a) same b) different 

 c) one d) many 

108. In call by value method, the flow of data is always from the call statement to the ___ 

definition. 

 a) variable b) constant 

 c) function d) class 

109. The changes or modifications that are made to formal parameters are not reflected in the 

_____ parameters. 

 a) formal b) dummy 

 c) actual d) variable 
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110. In call by value method, the called functions arguments – formal parameters become 

____ to the actual parameters in the calling function. 

 a) alias b) different 

 c) same d) formal 

111. In call by reference formal parameters and actual parameters occupies ____ storage area. 

 a) different b) many 

 c) same d) one 

112. The actual parameters can be passed only as ___ to formal parameters of reference type. 

 a) constant b) variable 

 c) formal d) actual 

113. In C++, one can assign default values to the ______ parameters of a function prototype. 

 a) formal b) dummy 

 c) actual d) variable 

114. The default arguments facilitate the function call statement with partial or ___ arguments. 

 a) one b) two 

 c) three d) no 

115. The default values can be included in the function prototype form _____ to ________ 

 a) right, left b) right, top 

 c) left, bottom d) top, bottom 

116. The actual parameters are matched with formal parameters on the basis of ________ 

correspondence. 

 a) many to one b) many to many 

 c) one to one d) one to many 

117. In the absence of actual arguments, the formal parameters takes the ____ arguments. 

 a) actual b) formal 

 c) default d) original 

118. The functions that return no value is declared as ______ 

 a) Null b) void 

 c) int d) dummy 

119. The data type of a function is treated as ______ if no data type is explicitly mentioned. 

 a) float b) int 

 c) char d) string 

120. A functioning returning a reference can appear on the _____ side of an assignment. 

 a) right hand b) left hand 

 c) beginning d) end 

121. When the functions are small (less number of instructions), the compiler replaces the 

function call statement by its definition ______ 

 a) outline b) center line 

 c) inline d) bottom line 

122. To make a function inline, one has to insert the keyword ____ in the function header. 

 a) inline b) center line 

 c) outline d) bottom line 

123. Inline keyword is just a request to the ______ 

 a) interpreter b) compiler  

 c) template d) C++ 

124. _____ refers to the accessibility of a variable. 

 a) Variable b) Constant 

 c) Scope d) Scape 

125. There are ______ types of scopes in C++. 

 a) 1 b) 2 

 c) 3 d) 4 

126. The scopes are _______ 

 a) local scope b) function scope 

 c) file scope d) all the above 

127. The scope of a ______ variable is the block in which it is defined. 

 a) local b) foreign 

 c) global d) module 

128. A local variable cannot be accessed from _____block of its declaration. 

 a) top b) bottom 

 c) inside d) outside 
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129. A local variable is _____ upon entry into its block and _____ upon exit. 

 a) created, destroyed b) opened, closed 

 c) created, closed d) opened, destroyed 

130. The life time of a function scope variable, is the life time of the _____ block. 

 a) variable b) function 

 c) constant d) class 

131. A variable declared above all blocks and functions have ______ scope. 

 a) local b) function 

 c) file d) all the above 

132. The scope of a file scope variable is the ______ program. 

 a) top b) bottom 

 c) first d) entire 

133. The life time of a file scope variable is the life time of a ______ 

 a) module b) variable 

 c) program d) function 

134. The scope operator reveals the hidden scope of a _______ 

 a) module  b) variable  

 c) program d) function 

135. ____ statement marks the end of the function and also transfers control to the statement 

after call statement. 

 a) return b) go to 

 c) continue d) break 

136. The main purpose of function prototype is to help the _____ to check the data 

requirement of the function. 

 a) compiler b) interpreter 

 c) linker d) object 

137. _________ are the channels through which data flows from call statement to function and 

vice versa. 

 a) parameters b) function 

 c) return d) parenthesis 

138. In call by value method, the flow of data is always from the _____ statement to the 

function definition. 

 a) call b) return 

 c) function d) go to 

139. An _____ looks like a normal function in the source file but inserts the function‘s code 

directly into the calling program. 

 a) inline b) online 

 c) mainline d) line 

140. To make a function inline, one has to insert the keyword _____ in the function header. 

 a) inline b) online 

 c) mainline d) line 

141. Inline keyword is just a request to the ______ 

 a) compiler b) interpreter 

 c) linker d) object 

142. In _____ a local variable is defined within a block. 

 a) file scope b) function scope 

 c) local scope d) class scope 

143. _____ of variables declared within a function is extended to the function block and all 

sub-blocks therein. 

 a) function scope b) local scope 

 c) file scope d) class scope 

144. A variable declared above all blocks and functions has the ______ 

 a) scope of a file b) local scope 

 c) function scope d) class scope 

145. The _____ reveals the hidden scope of a variable. 

 a) scope operator b) % 

 c) * d) ++ 

146. The life time of a ________ variable, is the life time of the function block. 

 a) function scope b) file scope 

 c) global scope d) local scope 
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147. The lifetime of a _____ variable is the life time of a program. 

 a) function scope b) file scope 

 c) local scope d) global scope 

148. In ____ method, the called function arguments-formal parameters become alias to the 

actual parameters in the calling function. 

 a) call by value b) call by reference 

 c) return d) call 

149. Which is the actual parameter of the segment ? 

 #include <iostream.h> 

 #include <conio.h> 

 int sum (int x, int y) 

 { 

 return (a+b); 

 } 

 void main() 

 { 

 int a,b; 

 int add = 0; 

 add=sum(a,b); 

 cout<<add; 

 } 

 a) x,y b) a,b 

 c) add, sum d) x,y,a,b 

150. Write the output of the program? 

 #include <iostream.h> 

 #include <conio.h> 

 void swap(int x, int y) 

 { 

 int t; 

 t=x; x=y; y=t; 

 } 

 void main() 

 { 

 int a,b; 

 cin>>a>>b; 

 swap(a,b); 

 } 

 where a=5 & b=7 

 a) 5 7 7  b) 7 5 5 

 c) 7 5 7  d) 5 7 5 
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 STRUCTURED DATA TYPE - ARRAYS 

 

I. Choose the Correct Answers :-      

1. Which is a collection of variables of the same type ? 

 a) array     b) strings 

 c) matrix   d) function 

2. Arrays are referred by a  

 a) common name b) variables 

 c) subscripts d) all of these 

3. How many types of arrays are there in C++? 

 a) 2 b) 3 

 c) 4 d) 5 

4. The size of the array should always be 

 a) an integer b) positive 

 c) in bytes d) all of these 

5. Each element of the array is accessed by the 

 a) array name & positive b) index 

 c) subscript d) all 

6. An integer number requires 

 a) 1 byte b) 2 byte 

 c) 3 byte d) 4 byte 

7. int num[5] requires 

 a) 5 bytes b) 10 bytes 

 c) 1 byte d) 4 byte 

8. The array index always starts with 

 a) zero b) >0 

 c) <0 d) any of these 

9. Strings are called as 

 a) literals b) characters 

 c) constants d) identifiers 

10. String are treated as 

 a) single dimensional array of characters b) 2-D array 

 c) matrix of elements d) 2-D sequence of data 

11. A character array (used as string) should be terminated with a  

 a) ‗\0‘ b) null 

 c) enter key d) carriage return 

12. Which is the terminator for a string inputs in c++? 

 a) white space b) carriage return 

 c) enter key d) all of these 

13. To treat spaces as part of string literal one has to use  

 a) cin b) get 

 c) getline d) cout 

14. Which is defined in stdio.h? 

 a) cin b) gets 

 c) getline d) cout 

15. Which is the member function of the standard input stream ? 

 a) cin b) gets 

 c) getline d) cout 

16. How many methods are there to display the contents of string? 

 a) 2 b) 3 

 c) 4 d) 5 

17. Which is the member function of standard output stream ? 

 a) write b) gets 

 c) getline d) cout 

18. The number of parameters required for the write() is 

 a) 2 b) 3 

 c) 4 d) 5 

19. Which return the number of character stored in an array ? 

 a) strlen b) strcpy 

 c) strcmp d) string 
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20. Which copies source string to target string? 

 a) strlen b) strcpy 

 c) strcmp d) string 

21. Which compares the two given strings ? 

 a) strlen b) strcpy 

 c) strcmp d) string 

22. When two strings are equal strcmp() returns 

 a) =0 b) >0 

 c) <0 d) ‗\0‘ 

23. If string1 is greater than string2, strcmp() returns  

 a) =0 b) >0 

 c) <0 d) ‗\0‘ 

24. If string2 is greater than string1, strcmp() returns 

 a) =0 b) >0 

 c) <0 d) ‗\0‘ 

25. String manipulation are defined under 

 a) stdio.h b) string.h 

 c) ostream.h d) iostream.h 

26. Which is an array in which each element is itself an array? 

 a) 2 dimensional array b) 1 dimensional array 

 c) 3 dimensional array d) matrix 

27. The dimension of an array can be indicated as 

 a) integer or char constant b) ordinal 

 c) char or enum identifiers d) all of these 

28. Which is stored in sequential memory block ? 

 a) 2 D array b) variables 

 c) 1 D array d) constants 

29. The elements of an array are stored in 

 a) row-wise b) column-wise 

 c) both a & b d) sequential 

30. The size of the array int s[2][4] is 

 a) 8 byte b) 16 byte 

 c) 6 byte d) 10 byte 

31. What will be the size of the array float num[4][6] ? 

 a) 10 byte b) 24 byte 

 c) 96 byte d) 28 byte 

32. Determine the number of elements of int a[10][12] ? 

 a) 22 b) 120 

 c) 44 d) 12 

33. int y[][3]={0,1,1,2,2,3} has 

 a) 6 elements & 2 rows b) 3 rows & 6 elements 

 c) 3 elements & 6 columns d) 2 rows & 3 elements 

34. Which is the base address of an array ? 

 a) variable b) identifier 

 c) index d) name 

35. which is an example of a 2D array ? 

 a) matrix b) mark 

 c) both a & b d) name 

36. which can be represented through 2-D ? 

 a) matrix b) marks 

 c) both a & b d) name 

37. Which does the C++ compiler  automatically attach ? 

 a) ‗\0‘ b) NULL 

 c) -1 d) both a & b 

38. Which size of an array can be omitted for the 2-D array ? 

 a) row b) column 

 c) both a & b d) either a or b 

39. Which is optional in array initialization ? 

 a) row b) column 

 c) both a & b d) value 
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40. Arrays can be passed on as arguments to 

 a) main b) function 

 c) statement d) variables 

41. Array parameters by default behave like a 

 a) formal parameter b) actual parameter 

 c) dummy parameter d) reference parameter 

42. Which does the identifier, ignoring dimensions, pass ? 

 a) formal parameter b) actual parameter 

 c) dummy parameter d) reference parameter 

43. Which is a 2-D character array? 

 a) matrix b) marks 

 c) string d) all of these 

44. Which is optional to each string literal ? 

 a) ‗\0‘ b) null 

 c) enter key d) carriage retrun 

45. Even if we omit, the C++ compiler will automatically attach to each string literal. 

 a) ‗\0‘ b) -1 

 c) 1 d) null 

46. A(n) _____ is a derived data type that can hold several values of the same type. 

 a) structure b) variable 

 c) array d) union 

47. A(n) _______ is a collection of variables of the same type that are referenced by a 

common name. 

 a) structure b) variable 

 c) array d) union 

48. There are _____ types arrays in C++. 

 a) 2 b) 3 

 c) 4 d) 5 

49. ______ dimensional array comprising of finite homogenous elements. 

 a) one b) multi 

 c) two d) none of these 

50. The array subscripts are always commences from ____ 

 a) 0 b) 1 

 c) 2 d) 3 

51. The process of arranging the data in a given array is called ______ 

 a) merging b) sorting 

 c) filtering d) none of these 

52. A character array should be terminated with a _____ 

 a) ; b) \0 

 c) /0 d) none of these 

53. ____ is a number of standard output stream. 

 a) read() b) print() 

 c) write() d) none of these 

54. Write function requires _____ parameters. 

 a) 1 b) 2 

 c) 3 d) 4 

55. ____ function returns the number of characters stored in the array. 

 a) strcpy() b) strlen() 

 c) void() d) strcmp() 

56. ____ function copies source string to target string. 

 a) strcpy() b) strlen() 

 c) void() d) strcmp() 

57. _____ function compares the two given strings. 

 a) strcpy() b) strlen() 

 c) void() d) strcmp() 

58. The number of elements in a 2-D array is determined by _______ the number of tw 

 a)adding b)multiplaying  

 c)subtracting d)dividing 

59. A 2-D array is stored  in ________memory blocks 

 a)random b)sequential 

 c)Non-consecutive d)None of these 
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60. The subscript of an array must be _______ 

 a)integer b)float 

 c) character d)double 

61. Array can be passed on as ______to function. 

 a)Values b)Number 

 c)Arguments d)Elements 

62. A___________is set of number arranged in the form of a rectangular array. 

 a)Matrix b)String 

 c)Integer d)None of these 

63. .Matrices can be represented through ________array. 

 a)one dimensional b)2-D 

 c)3-D d)Multidimensional 

64. An array of string is a 2-D ________array. 

 a)Numeric b)Character 

 c)String d)None of these 

65. In an array of string ________index determines the number of strings. 

 a)row b)Column 

 c)Integer d)None of these 

66. In an array of string ________index determines the maximum length of each string 

 a)Row b)Column 

 c)String d)none of these 

67. A character array should be explicitly mentioned. 

 a)Single quotes b)Double quotes 

 c); d)None of these 

68. ________of an array should  be  explicitly mentioned 

 a)Dimension b)Length 

 c)size d)None of these 

69. An index of an array should not be a ________value 

 a)Positive b)numeric 

 c)Negative d)Non of these 

70. The  memberof function of a class should be accessed through a(n)_____of the class   

 a)Object b)member 

 c)Content d)Label 

71. A character array should be terminated with a _________ 

 a) . b)\0 

 c); d): 

72. _______are otherwise called as literals 

 a)Number b)String 

 c)Arrays d)None of these 

73. The size of an array should always be _______ 

 a)Negative b)0 

 c)Positive d)Nonr of these 

74. Stremp( ) funtion compares the given string and returns _____if they are equal 

 a)0 b)1 

 c)2 d)3 

75. A 2 –d array has _______subscripts. 

 a)0 b)1 

 c)2 d)3 

76. The first index of the 2-D array refers to _________ 

 a)Row b)Coloumn 

 c)Length d)Size 

77. _________can be manipulated element by element like a character array 

 a)Integer b)Strings 

 c)values d)None of these 

78. The second index of the 2 – D array refers to ______ 

 a)Row b)Coloumn 

 c)Length d)Size 

79. String manipulation are defined in ________ 

 a)Stdio.h b)String.h 

 c)conio.h d)Math.h 
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80. The instance _______treats white  spaces or carriage returns as terminator for string 

 a)cin b)gets 

 c)\0 d)None of these 

81. The treat space as part of string literal then one has to use _______defined in stdio.h 

 a)Cin b)gets 

 c)getline d)None of these 

82. To treat as part of string literal than one has to use _______a member function of 

standard   inputstream 

 a)getchar( ) b)gets( ) 

 c)getline( ) d)write( ) 

83. __________is a member of function of standard outputstream 

 a)write( ) b)getline( ) 

 c)size of( ) d)None of these 

84. ____________is a member of function of standard inputstream 

 a)Write( ) b)getline( ) 

 c)size of( 0 none of these 

85. An ____ in C++ is derived data type that can hold several values of the same type. 

 a) inline function b) variable 

 c) array d) constant 

86. ____ can be used if processing each item may be very cumbersome and awkward. 

 a) function b) variable 

 c) array d) constant 

87. An array is a collection of ____ of the same type that are referenced by a common name.  

 a) constant b) variable 

 c) data d) values 

88. Arrays are of ____ types. 

 a) 1 b) 2 

 c) 3 d) 4 

89. _____ dimensional comprising of finite homogenous elements. 

 a) single b) two 

 c) three d) four 

90. ___ dimensional comprising of elements, each of which is itself a one dimensional array. 

 a) one b) two 

 c) three d) four 

91. The size of the array should always ______ 

 a) zero b) one 

 c) two d) positive 

92. int num_array[5]; can store ______ elements. 

 a) 1 b) 2 

 c) 3 d) 5 

93. Array elements can be accessed by array ___ and the position of the element in the array. 

 a) constant b) position 

 c) name d) class 

94. One integer in an array requires _____ bytes of memory. 

 a) 1 b) 2 

 c) 3 d) 4 

95. Array can be of ______ data types. 

 a) integer b) float 

 c) char d) any of these 

96. The array subscripts always commences from _____ 

 a) zero b) one 

 c) two d) positive 

97. Array subscript is enclosed between ______ 

 a) { } b) [ ] 

 c) ( ) d) < > 

98. cin >> number [4] reads ______ element. 

 a) 1 b) 2 

 c) 3 d) 5 

99. The process of rearranging the data in ascending or descending order is called _____ 

 a) Merging b) Sorting 

 c) Splitting d) Arranging 
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100. Strings are otherwise called as _____ 

 a) Literals b) Variables 

 c) Constants d) Arrays 

101. Strings are otherwise called as _____ 

 a) Literals b) Variables 

 c) Constants d) Arrays 

102. Strings are treated as _____ dimension of characters. 

 a) multi b) two 

 c) three d) single 

103. The declaration of strings is same as ______ array. 

 a) non-numeric b) numeric 

 c) string d) constant 

104. A character array (string) should be terminated with a _____ 

 a) zero b) number 

 c) string d) null 

105. To treat spaces as part of string literal, then one has to use ______ 

 a) puts b) cin 

 c) cout d) gets 

106. gets ( ) defined in _____ header file. 

 a) stdio.h b) stdlib.h 

 c) Conio.h d) istream.h 

107. getline ( ) – a member function of _____ 

 a) stdio.h b) stdlib.h 

 c) conio.h d) istream.h 

108. There are ____ methods to display the contents of character array. 

 a) 1 b) 2 

 c) 3 d) 5 

109. Write ( ) is a member function of _____ 

 a) stdio.h b) stdlib.h 

 c) ostream.h d) istream.h 

110. All member functions of a class, should be accessed through an ____ of the class. 

 a) object b) instance 

 c) either (a) or (b)  d) none 

111. A __________ dimensional array is an array in which each element is itself an array. 

 a) single b) two 

 c) three d) four 

112.    The number of elements in a2-dimensional array is determined by _________ the number 

of rows with number of columns. 

 a) adding b) dividing 

 c) multiplying d) subtracting 

113. In two dimensional array the first subscript is always refers to _________ 

 a) column b) row 

 c) both row and column d) size 

114.  A 2-D array is stored in _________ memory blocks. 

 a) random b) binary 

 c) sequential d) serial 

115. The element are stored either _________ 

 a) row-wise b) column-wise 

 c) both d) horizontal 

116. Row wise manner is called ________ major order. 

 a) column b) Row 

 c) Horizontal d) Vertical 

117. What is the size of 2-D array int a[2][4] _________ in bytes? 

 a) 8 b) 16 

 c) 24 d) 32 

118. What is the size of 2-D array float num[4][6] __________ in bytes? 

 a) 8 b) 24 

 c) 32 d) 96 

119. _________ can be passed on as arguments to functions. 

 a) constant b) method 

 c) Array d) Values 
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120. The _________ parameter is passed only by the identifier, ignoring dimensions. 

 a) formal b) actual 

 c) one d) many 

121. Array parameters by default behave like __________ parameter. 

 a) formal b) actual 

 c) value d) reference 

122. Array identifier unlike other identifiers, represents the base _______ of the array. 

 a) value b) constant 

 c) variable d) address 

123. Array results in sending an address to the ________ parameter. 

 a) formal b) actual 

 c) value d) reference 

124. A matrix is a set of numbers arranged in the form of a _________ array. 

 a) circle b) oval 

 c) rectangle d) triangle 

125. Matrices can be represented through _________ dimensional arrays. 

 a) 1 b) 2 

 c) 3 d) 5 

126. An array of strings is a two-dimensional _______ array. 

 a)  integer b) float 

 c) character d) string 

127. The size of first index(column) 2D string array determines the number of _______ 

 a)  integer b) float 

 c) character d) string 

128. The size of second index(column) 2D string array determines maximum _____ of each 

string. 

 a)  integer b) float 

 c) length d) breadth 

129. If null characters are not included, then the results will be __________ 

 a) displayed b) not displayed 

 c) null d) none 

130. An ____________ is a collection of variables of the same type that are referenced by a 

common name. 

 a) variable b) constant 

 c) array d) program 

131. Arrays are of _________ types. 

 a) 3 b) 4 

 c) 2 d) 1 

132. _________ dimensional array comprising of finite homogenous elements. 

 a) one b) two 

 c) multi d) three 

133. ________ dimensional array comprising of elements each of which is itself a one-

dimensional array. 

 a) single b) two 

 c) three d) multi 

134.  int num_array[5]; in this array how many integer values can be stored? 

 a) 4 b) 5 

 c) 6 d) 1 

135.  Each element of the array is accessed by the _________ name and position of the element 

in the array. 

 a) array b) variable 

 c) dimensional d) subscript 

136.  The size of the array should always be ___________ 

 a) positive b) negative 

 c) whole number d) real number 

137. int days [ ] ={1,2,3,4,5,6,7}; in this statement what is the size of the array?______ 

 a)6 b)5 

 c)4 d)7 

138. Cin >>number [4];In this array processing which reads the ______element 

 a)Fourth b)fifth 

 c)First d)Third 
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139. Number [3]++;in this array processing which increments the value stored as 

______element by 1 

 a)Fourth b)Fifth 

 c)Third d)Second 

140. Rearraning the data either in ascending or desending order is called _______ 

 a)Merging b)Sorting 

 c)Ascend d)Descend 

141. _________are otherwise called as literals 

 a)Strings b)Constant 

 c)variables d)Data 

142. A character array schould be terminated with a ________character 

 a)‘0‘ b)‘\0‘ 

 c)‘0/‘ d)\0, 

143. ________is a member function of standard is istream 

 a)getline b)get( ) 

 c)getsline( ) d)line( ) 

144. ________is  a member  function of standard output stream i.e ostream 

 a)write( ) b)Print( ) 

 c)Writes( ) d)Reads( ) 

145. All member function of a class should be accessed through an ____-of class 

 a)Object b)Instance 

 c)a and b d)function 

146. _______ parameters are required for write function 

 a)Two b)three 

 c)Four d)Five 

147. String manipulaters are number of character stored in the array 

 a)String.h b)String 

 c)St.h d)Std.h 

148. _________ function returns the number of character stored in the array 

 a)strlen b)str( ) 

 c)Stlen( ) d)Strlength( ) 

149. ________function copies source string to target string 

 a)Strepy( 0 b)Str( ) 

 c)Scpy( ) d)Step( ) 

150. _______function compares the two given strings 

 a)Stremp( ) b)Strep( ) 

 c)Step( ) d)Stemp( ) 

151. _________dimensional array is an array in which each element is itself an array 

 a)Two b)Three 

 c)Four d)One 

152. The number of element in a 2-dimensional array is determined by multipling the number 

of _______with number of ________ 

 a)rows,column b)columns,columns 

 c)row,row b)row,coln. 

153. The subscript always commences from ________ 

 a)One b)Two 

 c)Three d)Zero 

154. If the element are stored in rowwise manner it is called as ________order 

 a)row-major b)column –major 

 c)row d)column 

155. When elements are stored columnwise manner it is called as ______order 

 a)column-major b) row-major 

 c) row d) column 

156. A __________ is a set mn numbers arranged in the form of a rectangular array of m rows 

and n columns. 

 a) matrix b) Determinant 

 c) array d) row 
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CLASS AND OBJECTS 

 

I. Choose the Correct Answers :-      

1. Which is the most important features of c++? 

 a) Encapsulation b) inheritance 

 c) Class d) Polymorphism 

2. Which is a new way of creating and implementing a user defineed data type? 

 a) Encapsulation b) class 

 c) inheritance  d) Polymorphism 

3. Which provide a method for packing together data of different type? 

 a) Encapsulation b) inheritance 

 c) Classes d) Polymorphism 

4. The associated function of the class data type is called as_____ 

 a) method b) both a&c 

 c) member function d) Constructor function 

5. Which is a way to bind the data and its associated function together? 

 a) Encapsulation b) class 

 c) inheritance  d) Polymorphism 

6. How many parts does a class specification has 

 a) two b) three 

 c) four d) five 

7. The class body contains the  

 a) Declaration of variables b) class function definition 

 c) Both a &c d) member 

8.  The body of the class enclosed within ____________ 

 a) {} b) ( ) 

 c) ― ― d) [ ] 

9.  The class is terminality a 

 a) : b) ; 

 c) ?: d) , 

10. How many access specifies is there? 

 a) two b) three 

 c) four d) five 

11. Which is the default access specifies? 

 a) private b) public 

 c) protected d) static 

12. OOPs is the acronym of 

 a) objected oriented languages 

 b) objected oriented programming languages 

 c) object oriented programming 

 d) object oriented languages 

13. Which is optional 

 a) private b) public 

 c) protected d) static 

14. The members that has been declared as private can be accessed 

 a) Only from within the class 

 b) from outside the class 

 c) from within the class & the member of the inherited class 

 d) all of the above 

15. The members that has been declared as protected can be accessed 

 a) Only from within the class 

 b) from outside the class 

 c) from within the class & the member of the inherited class 

 d) all of the above 

16. The members that has been declared as public can be accessed 

 a) Only from within the class 

 b) from outside the class 

 c) from within the class & the member of the inherited class 

 d) all of the above 
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17. The binding of data and function together into a single entity is referred to as 

 a) data hiding b) encapsulation 

 c) abstraction d) destruction 

18. Which is the key features of OOPS? 

 a) data hiding b) encapsulation 

 c) abstraction d) destruction 

19. The members and function declared under private are not accessible by members outside  

 the class? 

 a) encapsulation b) data hiding  

 c) abstraction d) destruction 

20. Instruments allowing only selected access of components to objects and the members of  

 other classes is called as 

 a) data hiding b) encapsulation 

 c) abstraction d) destruction 

21. Which is achieved through data hiding ? 

 a) encapsulation b) data hiding 

 c) abstraction d) destraction 

22. Private access its own member and certain special function is called as 

 a) inline function b) friend function 

 c) member function d) constructor function 

23. Class comprises of 

 a) classes b) members 

 c) constructors d) variables 

24. How many classification of members are their 

 a) two b) three 

 c) four d) five 

25. Which are the data variables that represent the feature of properties of a class? 

 a) data member b) member function 

 c) class d) method 

26. Which are the functions that perform specific task in a class? 

 a) inline function b) friend function 

 c) member function d) constructor function 

27. Member functions are called as 

 a) class b) constructors 

 c) method d) destructors 

28. Data members are called as 

 a) attributes  b) classes 

 c) variables d) identifiers 

29. Which include special member function called as constructions and destructions? 

 a) instance b) classes 

 c) object d) both a & c 

30. In C++ the class variables are known as 

 a) instance b) class 

 c) object d) polymorpism 

31. Which placing their names immediately after the closing braces of the class declaration 

can create ? 

 a) instance b) class 

 c) object d) both a & c 

32. The member of a class are accessed using the 

 a) dot operator b) scope resolution operator 

 c) logical operator d) assignment operator 

33. The member function defined within the class behave like 

 a) inline function b) friend function 

 c) member function d) constructor function 

34. When several different classes uses the same function name, which will resolve their 

scope? 

 a) member function b) membership label 

 c) inline function d) data members 

35. A member function calling another member function directly without using the dot 

operator is called as 

 a) Looping of the member function b) Nesting of member function 

 c) Repeating member function d) All of the above 
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36. Member function can be of 

 a) Static type b) private 

 c) public d) protected 

37. A data member of a class is qualified as static type if the static member variable is 

 a) initialized zero  

 b) only one copy of the member variable is created 

 c) The scope is within the class d) all of the above 

38. class name 

 { 

 private: 

      char n[10]; int m1, m2; 

 

 protected: 

       void accept (); 

       void display(); 

 

 public: 

       name(); 

       void execute(); 

 } 

 which is the class tag? 

 a) name b) n, m1, m2 

 c) accept & display d) execute 

39. class name 

 { 

 private: 

      char n[10]; int m1, m2; 

 

 protected: 

       void accept (); 

       void display(); 

 

 public: 

       name(); 

       void execute(); 

 } 

 which are the data members? 

 a) name b) n, m1, m2 

 c) accept & display d) name & execute 

40. class name 

 { 

 private: 

      char n[10]; int m1, m2; 

 protected: 

       void accept (); 

       void display(); 

 public: 

       name(); 

       void execute(); 

 } 

 which is the member or member function? 

 a) accept b) display 

 c) execute d) all of the above 
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41. class x 

 { 

 private : 

         .................... 

 

 protected : 

                    .................... 

  

 public : 

         .................... 

 }; 

 void main() 

 { 

 x, x1,x2[15]; 

 } 

 The x1, x2 are called as 

 a) class b) objects 

 c) instances d) both b or c 

42. Which are created and placed in the memory space only when they are defined as a part 

of the class function 

 a) inline function b) friend function 

 c) member function d) constructor function 

43. Member function defined outside the class has the prototype as 

 a) void add:display () b) int add: display() 

 c) float display()::add d) void add::display() 

44. Initially C++ was called as ‗C with Classes‘ by ______ 

 a) Ken Thompson b) Charles Babbage 

 c) Bjarne Strousstrup d) Pascal 

45. A _____ is a new way of creating and implementing a user defined data type. 

 a) class b) object 

 c) function d) variable 

46. Classes provide a ____ for packing together data of different types. 

 a) class b) object 

 c) function d) method 

47. The data _____ define the properties. 

 a) constant b) variable 

 c) method d) function 

48. The class data type can be further extended by defining its associated functions is called _ 

 a) constant b) variable 

 c) methods d) function 

49. Accepting and manipulating data can be performed by _______ 

 a) constant b) variable 

 c) methods d) function 

50. A class specification has _____ parts. 

 a) Class declaration b) Class Function Definitions 

 c) methods d) both (a) and (b) 

51. The keyword class specifies user defined data type _____ name. 

 a) method b) class 

 c) variable d) constant 

52. The body of a class is enclosed within _____ 

 a) [ ] b) { } 

 c) ( ) d) all of these 

53. The body of a class is terminated by a _____ 

 a) : b) , 

 c) . d) ; 

54. The class body contains the declaration of ____ and ______ 

 a) variable, function b) variable, contant 

 c) function, contant d) none 

55. The access specifiers of the class body are _____ 

 a) private  b) public 

 c) protected d) all the above 
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56. By default the members will be treated as _____ visibility. 

 a) private b) public 

 c) protected d) all the above 

57. The members that have been declared as ____ can be accessed only from within the class. 

 a) private b) public 

 c) protected d) all the above 

58. The members that have been declared as ____ can be accessed from within the class, and 

the members of the inherited classes. 

 a) private b) public 

 c) protected d) all the above 

59. The members that have been declared as ___ can be accessed from outside the class also. 

 a) private b) public 

 c) protected d) all the above 

60. The binding of data and functions together into a single entity is referred to as ____ 

 a) inheritance b) encapsulation 

 c) polymorphism d) class 

61. The members and functions declared under private are not accessible by members outside 

the class, this is referred to as ______ 

 a) data hiding b) encapsulation 

 c) polymorphism d) class 

62. Allowing only selected access of components to objects and to members of other classes 

is called _____ 

 a) method abstraction b) function abstraction 

 c) data abstraction d) inheritance 

63. Data abstraction is achieved through _____ 

 a) data hiding b) encapsulation 

 c) polymorphism d) class 

64. ____ is the key feature of object oriented programming. 

 a) data hiding b) encapsulation 

 c) polymorphism d) class 

65. OOPS stands for _____ 

 a) Object oriented process system b) Objected oriented programming language 

 c) Object oriented programming system d) Outside object programming system 

66. Class members are further classified as _____ 

 a) data members  b) member functions 

 c) both (a) and (b) d) either (a) or (b) 

67. Member functions are the functions that perform ____ tasks in a class. 

 a) same b) different 

 c) specific d) some 

68. Member functions are called as _____ 

 a) class b) object 

 c) function d) method 

69. Data members are also called as ______ 

 a) class b) object 

 c) attributes d) method 

70. Classes include special member functions called as _____ 

 a) constructors b) destructors 

 c) both (a) and (b) d) none 

71. In  c ++ the class variables are known as _________- 

 a)Class b)Object 

 c)Attributes d)method 

72. The member of a class are accessed using the _______operator 

 a)Plus b)Comma 

 c)dot d)semicolon 

73. The _________data of a class can be accessed only through the member function of its 

own class 

 a)private b)public 

 c)protected d)all the above 

74. The member function defined under __________can be accessed by the object of that 

class 

 a)private b)public 

 c)protected d)all the above 
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75. Member function defined outside the class has the _________ 

 a)name b)declaration 

 c)prototype d)definition 

76. A member function can call another member function directly without using the ______ 

 a)Plus b)comma 

 c)Dot d)semicolon 

77. Member function can be of ________type 

 a)void b)valid 

 c)Volatile d)Static 

78. Separate memory allocation for the object are essential because the member variables 

will hold ______data values for different objects 

 a)same b)different 

 c)one d)more 

79. The static member variables are initialized to ________only when the first object of its 

class is created 

 a)one b)zero 

 c)Three d)any number 

80. In static variable ________-copy of the member variable is created 

 a)one b)zero 

 c)Three d)any number 

81. Static variables are ________by all the other object of its class type 

 a)used  b)Shared 

 c)Not shared d)assigned 

82. The static variable count is initialized to zero only ________- 

 a)5 times b)4 times  

 c)3 times d)once 

83. The intial value to a static member variable is done_________the class 

 a)outside b)inside 

 c)same d)different 

84. Which of the following is a way to bind the data and its associated function together? 

 a)Class b)Data 

 c)Function d)methods 

85. In c++function are also called ________ 

 a)Definition b)Comcepts 

 c)Organisers d)Methods 

86. Which one of the following language features classes? 

 a)BASIC c)C 

 c)C++ d)None 

87. Declaration and function definition are two specification of which of the following___ 

 a)data type b)class 

 c)Comments d)none of the given 

88. Declaration of class member are declared_______ 

 a)Withclass b)outside the class 

 c)inside or outside the class d)separately in another class 

89. The class body has ______access specifiers 

 a)1 b)2 

 c)3 d)4 

90. class access specifiers are also known as ________ 

 a)Specification b)Class depth 

 c)visibility d)Class visibility specification 

91. Which of the following is not a class specifier?________ 

 a)private b)public 

 c)Protected d)unprotected 

92. Data hiding refers to ________ 

 a)member and function of a class are not accessible by member of outside class 

 b)declaring members as public  

 c)not specifying member and function of a class 

 d)not giving names to data 

93. Instruments allowing only selected access of object and to member of other classes is 

called_________ 

 a)Data hiding b)data abstraction 

 c)Data by default d)none of the above 
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94. _______of a class are data variables that represent the features or properties of a class 

 a)Data member b)member function  

 c)Access specifiers d)visibility labels 

95. ____________ are the function that perform specific task in a class 

 a)data member b)Member function  

 c)concrete function d)data function 

96. Members of a class are classified as ________ 

 a)Data members and member function b)Data hiding and data hiding 

 c)Data hiding and data abstraction d)Data function and member function 

97. In a class data member are also called as__________ 

 a)Abstracts b)Properties 

 c)attributes d)dimensions               

98. The body of the class starts and ends with _____ 

 a) Semi colon (;) b) begin and end 

 c) start and stop d) braces { } 

99. By default class members are treated as _____ 

 a) public b) private 

 c) protected  d) unprotected 

100. The binding of data and functions together into a single entity is known as _____ 

 a) Inheritance b) Polymorphism 

 c) overloading d) Encapsulation 
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POLYMORPHISM 

 

I. Choose the Correct Answers :-      

1. The word polymorphism means many   

 a) shapes b) forms 

 c) many d) all 
2. Poly means_______ 

 a) shapes b) forms 

 c) many d) all 

3. Morph means _______ 
 a) shapes b) forms 

 c) many d) all 

4. In c++ polymorphism is achieved through______ 
 a) over loading b) over riding 

 c) data hiding d) Abstraction 

5. the term overloading means a name having  
 a) one meaning b) two or more distinct meaning 

 c) many shapes d) many forms 

6. which refers to a function have more than one distinct meaning 

 a) Compiler b) overloaded operator 
 c) Over loaded funtion d) Both b & c 

7. which is one of the facets of c++ that support object oriented programming? 

 a) function overloading b) operator overloading 
 c) hiding d) abstraction 

8. The ability of the function to process the message in more than one form is called as 

 a) function overloading b) operator overloading 

 c) hiding d) abstraction 
9. Which adopts best match strategy to invoke function overloading? 

 a) Compiler b) overloaded operator 

 c) Over loaded funtion d) Both b & c 

10. Which data type can be converted to integer /float/double in integral data promotion? 

 a) integer type b) char data type 

 c) double type d) float type 

11. Which data type can be converted to char /float/double in integral data promotion? 

 a) integer type b) char data type 

 c) double type d) float type 

12. Which data type can be converted to integer /float in integral data promotion? 

 a) integer type b) char data type 

 c) double type d) float type 

13. Which data type can be converted to integer /char/double in integral data promotion? 

 a) integer type b) char data type 

 c) double type d) float type 

14. OOP is the acronym of  

 a) objected oriented language b) objected oriented programming language 

 c) objected oriented programming d) objected oriented languages 

15. Each over loaded function must differ either by the number of its  

 a) formal parameter or there data type b) actual parameter or there data type 

 c) dummy parameter or there data type d) reference parameter or there data type 

16. Which of overloaded function does the c++ compiler as part of the parameter list not 

consider 

 a) formal parameter b) default parameter 

 c) actual parameter d) dummy 

17. Which refers to giving addition functionality to the normal c++ operation like +, ++, -, 

_,+= etc 

 a) function overloading b) operator overloading 

 c) constructor overloading d) destructor 

18. Which operator cannot be used to concatenate strings directly? 

 a) & b) + 

 c) :: d) ?: 

19. To concatenate string use the function  

 a) Stropy( ) b) strlen( ) 

 c) stromp( ) d) all the these 
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20. The functionality of ‗+‘operator can be extended to strings through 

 function overloading b) operator overloading 

 c) constructor overloading d) destructor 

21. Which operator cannot be overloaded? 

 a) membership operator 

 b) scope resolution operator 

 c) size of the operator and conditional operator 

 d) all of the above 

22. Which must be either a member or friend function? 

 a) function overloading b) operator function 

 c) constructor overloading d) destructor 

23. In operator overloading compiler applies user defined based on the styles of? 

 a) call statement b) function 

 c) encapsulation d) hiding 

24. The mechanism of giving special meaning to an operation is called as  

 a) function overloading b) operator function 

 c) constructor overloading d) destructor 

25. The overloaded operater must have at least one operand of_______ 

 a) in –built type b) user defined type 

 c) static type d) class 

26. In which operator the left hand object must be an object of the revalent class 

 a) arithmetic operator b) binary operator 

 c) scope operator d) logical operator 

27. Binary operator  over loaded through a member function take 

 a) one explicit argument b) one implicit argument 

 c) many explicit argument d) many implicit argument 

28. The word ________means many forms 

 a) Inheritance b) polymorphism 

 c) overloading d) encapsulation 

29. In c++,polymorphism is achieved by ______ 

 a) Inheritance b) polymorphism 

 c) overloading d) encapsulation 

30. There are ________types of overloading 

 a) 2 b) 3 

 c) 4 d) 5 

31. The term _____-means a name having two or more distinct meanings 

 a) Inheritance b) polymorphism 

 c) overloading d) encapsulation 

32. An ________function refers to function having  more than  distinct meanings 

 a) instance b) overloaded 

 c) inline d) none of these 

33. __________over loading is one of the facets of c++that support object oriented 

programming 

 a) data b) function 

 c) variable d) operator 

34. The ability of the function to process the message or data in more than one form is called 

as_________ 

 a) data overloading b) function overloading 

 c) variable overloading d) constant overloading 

35. Each over loaded function must differ either by the number of its formal parameters or 

either ______ 

 a) data type b) function types 

 c) variables type d) constant type 

36. The term _______refers to givings additions functionality to the normal c++operator 

 a) data overloading b) function overloading 

 c) variable overloading d) constant overloading 

37. The functionality of c++ can be extended to strings through __________ 

 a) data overloading b) function overloading 

 c) variable overloading d) constant overloading 

38. The ________function definitions are permitted are user defined data type     

 a) instance b) overloaded 

 c) inline d) none of these 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

39. _______function must be either member function or friend function  

 a) instance b) overloaded 

 c) inline d) none of these 

40. The operator function operator ( ) should be declared in the ______-part of the class 

 a) public b) private 

 c) protected d) none of these 

41. The overloaded operator must have at least _______operand of user defined type 

 a) 1 b) 2 

 c) 3 d) 4 

42. _______operators overloaded through a member function take one explict argument 

 a) Unary b) Binary 

 c) ternary d) None of these 

43. __________operators behave in the same way as basic operators in terms of their 

operands 

 a) instance b) overloaded 

 c) inline d) none of these 

44. The mechanism of giving special meaning to an operater is called as 

________overloading  

 a) data b) function 

 c) variable d) operator 

45. Which one of the following operater can be overloaded? 

 a) new  b) size of  

 c) unary d) none of these 

46. _______is used to declare the operator function 

 a) operator( ) b) void( ) 

 c) function( ) d) method( ) 

47. The functionality of ____ operator can be extended to string through operator 

overloading 

 a) + b) - 

 c) & d) ,  

48. _____strategy is adapted by the complier when function invoked in function overloading 

 a) right match b) right 

 c) best match d) best 

49. which  one of the following is a scope resolution operator  

 a) . b) :: 

 c) & d) ! 

50. which  one of the following is a membership  operator  

 a) . b) :: 

 c) & d) ! 

51. The _______function is used to concatenated two strins 

 a) streomp( ) b) streat( ) 

 c) strepy( ) d) none of these 

52. The _______function defiitions are permitted for user defined data type 

 a) input  b) output 

 c) overloaded d) none of these 

53. Each function prototype differ by their number of ______ 

 a) argument b) function 

 c) method d) object 

54.  Argument for each prototype can be of different _______ 

 a) method b) constant 

 c) data type d) variables 

55. The numbers of arguments for each function prototype should________ 

 a) same b) different 

 c) both a & b d) none 

56. The complier adopts BEST MATCH strategy .As per this straregy the complier will ____ 

 a) look for the exact match of a function prototype with that of a funtion call statement  

 b) In case an exact match is not available  

 c) both a&b d) either a or b 

57. Large integral promotions are _______ 

 a) char data type can be converted to integer /float/double 

 b) int data type can be converted to char/double/float 

 c) float data type to integer /double/char d) all the above 
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58. The return type of over loaded function may or may not be the ________data type 

 a) different b) same 

 c) may be different d) none 

59. Do not use the same function name for two _______-function  

 a) related b) unrelated 

 c) same d) different 

60. Improper declarations leading to _________ in a function call statement. 

 a) clarity b) confusion 

 c) conflict d) none 

61. Operator overloading, refer to giving additional functionality to the normal c++ _____ 

 a) variable b) constant 

 c) operator d) function 

62. + operator can be used for ______ 

 a) addition b) concatenation 

 c) both a and b d) increment 

63. Which one of the following operator cannot be overloaded? 

 a) membership operator b) scope resolution operator 

 c) size of operator d) all the above 

64. The overloaded function definitions are permitted for _______ data type. 

 a) simple b) user defined 

 c) standard d) primitive 

65. Operator functions must be either member functions or _______ functions. 

 a) enemy b) same 

 c) different d) friend 

66. - operator used as 

 a) negation b) subtraction 

 c) both a and b d) either (a) or (b) 

67. Only __________ operators can be overloaded. 

 a) old b) new 

 c) existing d) non existing 

68. The overloaded operator must have at least one operand of ________ type. 

 a) simple b) user defined 

 c) standard d) primitive 

69. When __________ operators are overloaded, the left hand object must be an object of the 

relevant class. 

 a) unary b) binary 

 c) tertiary d) any 

70. Binary operators overloaded through a member function take one __________ argument. 

 a) Implicit b) More 

 c) Explicit d) Same 

71. Each overloading function must differ ____________ 

 a) by number of argument b) by type of arguments 

 c) either by number of arguments or by data types of arguments 

 d) none of the given. 

72. While invoking functions, if the c++ compiler does not find the exact match of the 

function call statement then _______ 

 a) it will ignore the function call b) generates an error 

 c) deletes the function d) looks for the next nearest match. 

73. During integral promotion, a char data type can be converted to _______ 

 a) integer b) float 

 c) double d) all the above. 

74. During integral promotion, a float data type can be converted to __________ 

 a) integer b) double 

 c) char d) all the above. 

75. During integral promotion, a double data type can be converted to _____ 

 a) float b) integer 

 c) float or integer d) neither float nor integer 

76. The return type of overloaded functions __________ 

 a) must be same b) must be different 

 c) may or may not be same d) none of the given 

 

 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

77. Streat( 0 function is used for ---------- 

 a) string concatenation b) string comparison 

 c) string calculation d) substring 

78. The functionality of operator  like ‗+‘can be extended using _______ 

 a) operator precedence b) operator overloading 

 c) operator definition d) none of the given 

79. Which of the following operators cannot be overloaded? 

 a) + b) ++ 

 c) -- d) :: 

80. Which of the following operator can be overloaded? 

 a) sizeof() b) ::  

 c) membership operator(.) d) plus(+) 

81. Operator overloading............ 

 a) does not overrule the original definition of the operator 

 b) overrules original definition 

 c) changes original definition 

 d) none of the given 

82. The operator function must be __________ 

 a) a member function b) a friend function 

 c) either member or friend function d) none of the given 

83. When overloading operators, the overloaded operator must have _________ 

 a) all the operands of user defined type 

 b) at least one operand of user defined type 

 c) all the operands of c++ data type. 

 d) none of the given 

84. When binary operators are overloaded, ______________ 

 a) the left hand object must be an object of the relevant class. 

 b) the right hand object must be an object of the relevant class. 

 c) Both the right and left objects must be an object of the relevant class. 

 d) none of the given. 
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CONSTRUCTORS AND DESTRUCTORS 

 

I. Choose the Correct Answers :-      

1. When an instance of a class comes to scope ______ gets executed. 

 a) Constructor  b)Destructor 

 c)Overloading d) None of these 

2. When a class object goes out of scope ___________ 

 a) Constructor  b)Destructor 

 c)Overloading d) None of these 

3. Constructor has the same name as the ___________ tag. 

 a) Object b) html 

 c) class d) instance 

4. Destructor has the same name as the _________ tag. 

 a) Object b) html 

 c) class d) instance 

5. Constructors and destructors return __________ 

 a) 0 b) 1 

 c) 2 d) Nothing 

6. Constructors and destructors are not associated with any _________ 

 a) function b) data type 

 c) object d) None of these 

7. The _____ function initializes the class object. 

 a) constructor b) destructor 

 c) overloading d) None of these 

8.  The memory space is allocated to an object using ________ 

 a) constructor b) destructor 

 c) overloading d) None of these 

9. __________ overloading can be applied for constructors. 

 a) Operator b) Function 

 c) Data d) None of these 

10. The constructor without any parameter is called as _________ constructor. 

 a) initial b) instance 

 c) default d) None of these 

11. The default constructors are referred to ________ generated constructors. 

 a) System b) complier 

 c) linker d) assembler 

12. Constructors are defined by the _______ in the absence of user defined constructors. 

 a) System b) complier 

 c) linker d) assembler 

13. A ______ constructor is executed when an object without parameters is declared. 

 a) initial b) instance 

 c) default d) non-parameterized 

14. The __________ cannot have arguments. 

 a) constructor b) destructor 

 c) overloading d) None of these 

15. _________ cannot be overloaded. 

 a) constructor b) destructor 

 c) operator d) none of these 

16. The _________ function can be overloaded. 

 a) constructor b) destructor 

 c) data d) none of these 

17. The ________ is executed automatically when the control reaches the end of class scope. 

 a) constructor b) destructor 

 c) overloading d) none of these 

18. The destructor is prefixed by the _________ character. 

 a)# b)& 

 c)% d)~ 

19. The ________ can have parameter list. 

 a) constructor b) destructor 

 c) overloading d) None of these 
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20. __________ has no return type. 

 a) constructor b) destructor 

 c) overloading d) None of these 

21. ________ is a special function is excited when an instance of a class comes into scope 

 a)destructor b)constructor 

 c)class d)object 

22. the constructor function _____the object 

 a)initializes b)assigns 

 c)executes d)calls 

23. When a class object goes out of scope a special function called the _______get executed 

 a)destructor b)constructor 

 c)class d)object 

24. The constructor function name and the destructor have the same as the ______-tag 

 a)objerct b)variable  

 c)function d)class 

25. Constructor returs________ 

 a)Integer b)boolean 

 c)character d)nothing 

26. Constructor and destructor are associated with ______data type 

 a)Integer b)boolean 

 c)character d)nothing 

27. Constructor is executed _________object is created 

 a)manually b)automatically 

 c)main d)none 

28. (Tilde) symbol is used for _______ 

 a)destructor b)constructor 

 c)class d)object 

29. ________is called at the of programming termination 

 a) class b) constructor 

 c) destructor d)object 

30. The constructor function allocates ______space to an object 

 a)variable b)memory 

 c)function d)object 

31. Function _______ can be applied for constructors. 

 a) overloading b) inheritance  

 c) object d) encapsulation 

32. Constructors are special _________ of classes. 

 a) variable b) objects 

 c) functions d) none 

33. The constructor without parameters is called as _________ constructor. 

 a) automatic b) default 

 c) user defined d) special 

34. More traditionally default constructors are referred to _____ generated constructors. 

 a) interpreter  b) software 

 c) complier d) hardware 

35. Complier generated constructors defined by the computers in the absence of constructor. 

 a) system generated b) hardware generated 

 c) user defined d) both a and b 

36. A non-parameterized constructor is executed when an object without ___ is declared. 

 a) constant b) object 

 c) function d) parameter 

37. The constructor dd (int s1, int s2) is called as _____ constructor. 

 a) parameterized  b) object 

 c) class d) function 

38. Char, float double parameters can be matched with int data type due to _______ type  

 conversions. 

 a) explicit  b) auto 

 c) implicit d) both a and b 

39. The constructor add (add &a) is called as ________ constructor. 

 a) copy  b) parameterized  

 c) default d) object 
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40. A copy constructor is executed ____________ 

 a) When an object is passed as a parameter to any of the member functions. 

 b) When a member function returns an object 

 c) When an object is passed by reference to constructor 

 d) all the above 

41. Rules for constructor definition and usage are _________ 

 a) The name of the constructor must be same as that of the class 

 b) A construct can have parameter list 

 c) The constructor is executed automatically 

 d) all the above. 

42. _________ is a function that removes the memory of an object 

 a) Destructor b) Constructor 

 c) class d) object 

43. Rules for destructor definition and usage ___________ 

 a) The destructor has the same name as that of the class prefixed by the tilde character  

 b) The destructor cannot have arguments 

 c) It has no return type 

 d) all the above 

44. When an instance of a class comes into scope, the function that executed is _____ 

 a) destructor b) constructor 

 c) inline d) friend 

45. When a class object goes out of scope, the function that gets executed is _____ 

 a) destructor b) constructor 

 c) inline d) friend 

46. The name of constructor must be ____ 

 a) same as class name b) same as one of the member function 

 c) same as object name d) none of the given 

47. The name of the destructor ______ 

 a) must be same as object name b) must be same as member function name 

 c) must be same as class name d) can be any name 

48. Which of the following is false ? 

 a) constructor and destructor have same name  

 b) class and constructor have same name c) class and destructor have same name

 d) constructor and member function have same name 

49. Which of the following do not return any value ? 

 a) member functions b) inline functions? 

 c) friend functions d) constructor and destructor 

50. Which one of the following is automatically executed when an object is created ? 

 a) constructor  b) destructor 

 c) member function d) none of the given 

51. Which one of the following initializes a class object an allocates memory space? 

 a) destructor b) constructor 

 c) member function d) none of the given 

52. Which of the following is true ? 

 a) destructors can be overloaded b) constructors can be overloaded 

 c) constructors cannot be overloaded as they are special functions 

 d) both constructors and destructors cannot be overloaded. 

53. Which of the following is true? 

 a) compiler generates a constructor in absence of user defined constructor 

 b) compiler does not generate a constructor at all 

 c) compiler generated constructor, overrides user defined constructor 

 d) compiler generates more than one constructor for a class. 

54. Which of the following prototype can be  a copy constructor of class myclass/ 

 a) myclass (int myclass); b) int copy (myclass mc); 

 c) myclass copy (myclass a); d) myclass (myclass & x); 

55. A copy constructor is invoked when ______ 

 a) an object is passed as a parameter to any of the member function 

 b) a member function returns an object  

 c) an object is passed by reference to constructor     d) all the above 
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56. Which of the following is not true ? 

a) copy constructor is invoked when an object is passed as a parameter to a member 

function 

 b) copy constructor is invoked whenever an object is created 

 c) copy constructor is invoked when a member function returns an object 

 d) copy constructor is invoked when an object is passed by reference to constructor  

57. Which of the following is true ? 

 a) A constructor can have parameter list b) the constructor cannot have parameter list 

 c) the constructor function can be overloaded d) all the given are true 

58. Which of the following is a function that removes the allocated memory of an object ? 

 a) constructor b) destructor 

 c) member function d) copy constructor 

59. A destructor name must be _____ 

 a) same as class name b) same as any other member function name 

 c) same as class name prefixed by tilde(~) character 

 d) none of the given 

60. Which of the following is true ? 

 a) a destructor cannot have arguments b) a destructor can have arguments 

 c) a destructor must have same arguments that of constructor 

 d) none of the given is true 

61. How many destructors a class can have ? 

 a) 1 b) 2 

 c) 3 d) 4 

62. Which of the following has no return type and cannot be overloaded ? 

 a) constructor b) member function 

 c) destructor d) inline function 

63. Which of the following is automatically executed when the control  reaches the end of 

class scope ? 

 a) constructor b) destructor 

 c) member function d) inline function 
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INHERITANCE  

 

I. Choose the Correct Answers :-      

1. Which is the most powerful feature of an OOP ? 

 a) class  b) encapsulation 

 c) polymorphism d) Inheritance 

2. The process of creating new classes from the existing class is called as 

 a) base class b) derived class 

 c) multiple inheritance d) abstract class 

3. The existing class is called as 

 a) base class b) derived class 

 c) multiple inheritance d) abstract class 

4. Which inherits all the properties of the base class 

 a) base class b) derived class 

 c) multiple inheritance d) abstract class 

5. What is the power packed class ? 

 a) base class b) derived class 

 c) multiple inheritance d) abstract class 

6. Which is the advantage of inheritance? 

 a) reusability of code b) code sharing 

 c) consistency of interface d) all the above 

7. Which saves lot of development time? 

 a) reusability of code b) code sharing 

 c) consistency of interface d) all the above 

8. Which keyword defines a derived class ? 

 a) class b) inherits 

 c) base d) derived 

9. Which has to be given after the keyword class ? 

 a) variable b) name 

 c) label d) address 

10. The access specifiers to be terminated with 

 a) ; b) : 

 c) , d) :: 

11. Knowing when a member of a base class can be used by the object is called as 

 a) visibility mode b) accessibility 

 c) both a & b d) base address 

12. Access specifier is also referred to as 

 a) visibility mode b) accessibility 

 c) both a & b d) derived class 

13. The default visibility mode is 

 a) static b) private 

 c) public d) protected 

14. When a base class in inheritance with private visibility mode the public and protected 

member of the base class become 

 a) private member of the derived class b) protected member of the derived class 

 c) public member of the derived class d) both a & c 

15. When a base class in inheritance with protected visibility mode the public and protected 

member of the base class become 

 a) private member of the derived class b) protected member of the derived class 

 c) public member of the derived class d) both b & c 

16. Which are not inherited but are executed first when an instance of the derived class is 

created ? 

 a) private member of the derived class b) protected member of the derived class 

 c) public member of the derived class d) both b & c 

17. Which are not inherited but are executed first when an instance of the derived class is 

created? 

 a) destructor  b) constructor 

 c) inherited d) encapsulated 

18. How many types of inheritance are there ? 

 a) 2 b) 3 

 c) many d) 5 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

19. When a derived class inherits only from one base class it is known as 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) hybrid inheritance 

20. When a derived class inherits from many base class it is known as 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) hybrid inheritance 

21. When a class is derived from a class which is a derived class itself-it is referred as 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) hybrid inheritance 

22. The constructor are executed in the order of 

 a) derived class b) inherited class 

 c) reverse class d) base class 

23. The destructor are inherited in the 

 a) derived class b) inherited class 

 c) reverse class d) base class 

24. Classes used only for deriving other classes are called 

 a) base class b) derived class 

 c) multiple inheritance d) abstract class 

25. The transitive nature of inheritance is reflected by the form of inheritance in 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) hybrid inheritance 

26. The class from which the new classes are derived is known as ____ class. 

 a) base b) derived 

 c) child d) sub 

27. The classes which are derived from an existing class is known as _____ 

 a) base  b) super 

 c) derived d) parent 

28. The base class is called as ______ class. 

 a) child b) derived 

 c) parent d) sub 

29. A _____ class can inherit the members of the base class. 

 a) base  b) super 

 c) derived d) parent 

30. The are _____ class access specifiers. 

 a) 2 b) 3 

 c) 4 d) 5 

31. The access specifiers are also called as _______ 

 a) methods  b) visibility modes 

 c) scope d) none of these 

32. The are ______ types of inheritance. 

 a) 2 b) 3 

 c) 4 d) 5 

33. The constructors are executed in the order of _______ class. 

 a) public b) private 

 c) protected d) inherited 

34. Classes used only for deriving other classes are called as _____ class. 

 a) public b) abstract 

 c) protected d) inherited 

35. _____ keyword is used to define the name of the derived class. 

 a) public b) private 

 c) protected d) class 

36. __________ must be used between derived and base class. 

 a) & b) : 

 c) :: d) # 

37. ________ are executed first when an instance of the derived class is created. 

 a) constructor b) destructor 

 c) overloading d) none of these 

 

38.   ____________ form of inheritance is reflected by the transitive nature of inheritance. 

 a) Multilevel b) Multiple 

 c) Single d) None of these 
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39.  ____________ inheritance referred when a class is derived from a class which is a 

derived class itself. 

 a) Multilevel b) Multiple 

 c) Single d) None of these 

40. When a derived class inherits only one from one base class, it is known as _______ 

inheritance. 

 a) Multilevel b) Multiple 

 c) Single d) None of these 

41. When a derived class inherits from multiple base classes it is known as _________ 

inheritance. 

 a) Multilevel b) Multiple 

 c) Single d) None of these 

42. _________ are executed in reverse order. 

 a) constructor b) destructor 

 c) overloading d) None of these 

43. ______ are executed in the order of inherited class. 

 a) constructor b) destructor 

 c) overloading d) None of these 

44. It is a process of creating new classes is called _______ 

 a) base class b) new class 

 d) derived class d) old class 

45. It is a process of creating new classes from existing or _______________ 

 a) base class b) new class 

 c) derived class d) old class 

46. The ________ inherits all the properties of the base class. 

 a) base class b) new class 

 d) derived class d) old class 

47. Code developed for one application can be used in another application is called ____ 

 a) Reusability of code b) code sharing 

 c) consistency of interface d) all the above 

48. The inherited attributes and methods provide a similar interface to the calling methods 

 a) Reusability of code b) code sharing 

 c) consistency of interface d) all the above 

49. ________ is a class from which other classes are derived. 

 a) Base class b) New class 

 c) Derived class d) Old class 

50. The name of the derived class is to be given _______ the keyword class. 

 a) before b) after 

 c) anywhere d) beginning 

51. The type of derivation of the derived class can have _________ 

 a) Private b) public 

 c) protected d) all the above 

52. When a member of a base class can be used by the objects or the members of the derived 

class is known as _____________ 

 a) visibility b) accessibility 

 c) derived d) base class 

53. The access specifiers are/is 

 a) private b) public 

 c) protected d) all the above 

54. When a base class is inherited with public visibility mode, the protected members of the 

base class will be inherited as ________ members of the derived class. 

 a) private b) public 

 c) protected d) all the above 

55. When a base class is inherited with public visibility mode, the public members of the 

base class will be inherited as _______ members of the derived class. 

 a) private b) public 

 c) protected d) all the above 

56. The constructors of the base class are not inherited, but are executed _____ when an 

instance of the derived class is created. 

 a) Not executed b) first 

 c) last d) middle 

 

www.Padasalai.Net                                               www.TrbTnpsc.com

http://www.trbtnpsc.com/2013/07/latest-12th-study-materials-2013.html

www.Padasalai.Net



R.Ramesh – Computer science Department – Trinity Academy 
 
 

57. The different types of inheritance are __________ 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) all the above 

58. When a sub class inherits only from one base class, it is known as ________ 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) all the above 

59. When a sub class inherits from multiple base classes it is known as _________ 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) all the above 

60. When a class is derived from a class which is a derived class itself __________ then this 

is referred to as  __________ 

 a) single inheritance b) multiple inheritance 

 c) multilevel inheritance d) all the above 

61. Which of the following is a process of creating new classes called derived classes from 

existing or base classes? 

 a) Encapsulation b) Polymorphism  

 c) Inheritance d) None of the given 

62. The class created from an existing base class is called ________ 

 a) second class b) new class 

 c) rich class d) derived class 

63. The class from which derived class is created is called ____ 

 a) Base class b) Power class 

 c) superior class d) family class 

64. In real life, children acquire the features of their parents in addition to their own unique 

features.  Which of the following terms refers this? 

 a) Encapsulation b) Polymorphism  

 c) Overloading  d) Inheritance 

65. Reusability of code, code sharing, consistency of interface are all advantages of ______ 

 a) Inheritance b) Polymorphism 

 c) Overloading d) Encapsulation 

66. which of the following is true? 

 a) base class inherits properties from derived class 

 b) derived class inherits properties from base class. 

 c) derived class does not inherit any properties from base class. 

 d) Both a and b are true. 

67. Which of the following derives a new class ―sub_class‖ from the base class 

―main_class‖? 

 a) class main_class: private sub_class 

 b) class sub_class:public main_class 

 c) class main_class:class sub_class 

 d) class sub_class:public main_class 

68. Which is wrong with the following statement that derives a B_class from A_class? 

 a) semicolon(;) must be replace by colon(:) 

 b) semicolon(;) must appear at the end of the statement 

 c) The word public must be replaced by private 

 d) The word public must be replaced by protected 

69. Class xclass:public yclass 

 from the above statement which of the following is true? 

 a) xclass is the base class b) yclass is the base class 

 c) yclass is derived from xclass d) yclass is the derived class 

70. private, public and protected are all ___________ 

 a) c++ variables b) control structures of c++ 

 c) access specifies d) derived class members 

71. The default visibility mode while inheriting members of a base class is _______ 

 a) private b) protected 

 c) public d) extended public 
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72. Which of the following is true with respect to inheritance? 

 a) private members of base class are inherited to the derived class with private 

accessibility. 

 b) private members of base class are not inherited to the derived class with private  

accessibility. 

 c) public members of base class are inherited but not visible to the derived class. 

 d) None of the above. 

73. In inheritance, protected members of base class are inherited as __________ when 

private access specifier is used. 

 a) private members b) protected members 

 c)  public members d) not inherited at all 

74. When a class is derived by private access specifier, the public members of base class are 

inherited as _____ of derived class. 

 a) private members b) protected members 

 c) public members d) none 

75. When a class is derived by protected access specifier, the public and protected members 

of base class are inherited as _____ of derived class. 

 a) private members b) public members 

 c) protected members d) none 

76. When a class is derived by access specifier protected , the public members of base class 

are inherited as _____ of derived class. 

 a) private members b) protected members 

 c) public members d) none of the given 

77. When a class is derived by access specifier public, the protected members of base class 

are derived as _____ of derived class. 

 a) private members b) protected members 

 c) public members d) none of the given 

78. When a class is inherited by public visibility mode the public members of base class are 

derived as _______ of derived class. 

 a) private members b) protected members 

 c) public members d) none of the given 

79. Single, multiple, multilevel, hybrid and hierarchical are all types of ______ 

 a) Polymorphism b) Inheritance 

 c) Encapsulation d) Overloading 

80. When a sub class inherits only from base class, it is known as _____ inheritance. 

 a) Single b) multiple 

 c) hybrid d) hierarchical 

81. When a class is derived from a class which is a derived class itself, then is referred to as 

____ inheritance. 

 a) Hybrid b) Hierarchical 

 c) Multilevel d) None 

82. Classes used only for deriving other classes are called ______ 

 a) public classes b) abstract classes 

 c) derived classes d) objects 

83. Which of the following is true with respect to inheritance of classes ? 

 a) The constructors are executed in the order of inherited class 

 b) The constructors are executed in the reverse order of inherited class 

 c) The constructors of base class are not executed 

 d) The constructors are executed randomly. 

84. Which of the following is true with respect to inheritance of classes? 

 a) The destructors are executed in the order of inherited class 

 b) The destructors are executed in the reverse order of inherited class 

 c) The destructors are not executed 

 d) None of the given is true. 
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IMPACT OF COMPUTERS ON SOCIETY 

 

I. Choose the Correct Answers :-      

1. To reach out the benefits of it to the common man we need 

 a) two technical element b) three technical element 

 c) two technology d) three technology 

2. Expand IT ? 

 a) Internet technology b) information technology 

 c) internet services d) internet time 

3. 85% of the system usage is 

 a) database b) word processing 

 c) spreadsheet d) all of these 

4. Which have increased the efficiency at work ? 

 a) database b) word processing 

 c) spreadsheet d) all of these 

5. Which add value to the work done ? 

 a) desktop publishing & other impressive graphic packages 

 b) browsing, email & chat c) shopping, banking etc 

 d) all of these 

6. Which have changed our life style ? 

 a) desktop publishing & other impressive graphic packages 

 b) browsing, email & chat c) shopping, banking etc 

 d) all of these 

7. Which enables data storage and management at home ? 

 a) archive unit b) memo frame 

 c) personal creativity tool d) all 

8. Which is an easy interaction through touch screen ? 

 a) archive unit b) memo frame 

 c) personal creativity tool d) all 

9. To draw, capture and work with multimedia elements use  

 a) archive unit b) memo frame 

 c) personal creativity tool d) all 

10. Which permit us to draw money comfortably of the home by using internet facility ? 

 a) e-mail b) e-banking 

 c) e-learning d) e-governing 

11. Which enables online education programs leading to degree and certification ? 

 a) e-mail b) e-banking 

 c) e-learning d) e-governing 

12. Expand CBT ? 

 a) Computer based techniques b) Computer based tutorial 

 c) Computer based terminology d) Computer based training 

13. ―India lives in her seven hundred thousand villages‖ Who said this ? 

 a) Nehru b) Abdul Kalam 

 c) Gandhi d) Rajaji 

14. The technical elements need for IT to reach the common man are ______ 

 a) Connectivity b) Affordable computers 

 c) Software d) all the above 

15. ―Word Processing‖ is used by _____ %. 

 a) 60 b) 75 

 c) 85 d) 90 

16. ____ packages increased the efficiency at work. 

 a) Word Processing b) Spreadsheets 

 c) Multimedia Presentation d) all the above 

17. Desktop publishing is used for adding _____ 

 a) audio b) video 

 c) graphics d) none 

18. ____ are mounted on the Wall to provide better effect and save floor space. 

 a) LCD Screen b) Camera 

 c) Speakers d) All the above 
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19. ____ are key component in the national economy. 

 a) Computers b) Software 

 c) Banks d) Companies 

20. Introduction of IT in banks reduced the _______ 

 a) Time b) Queue 

 c) Both (a) and (b)  d) Money 

21. ATM stands for ______ 

 a) Automated Teller Machine b) Any Time Money 

 c) Anywhere Money d) None 

22. _____ permits banking from the comfort of the home by using internet facilities. 

 a) Banking b) e-Shopping 

 c) e-Banking d) e-Learning 

23. We can purchase any product, any brand, any quantity from anywhere through ____ 

 a) Banking b) e-Shopping 

 c) e-Banking d) e-Learning 

24. _____ that enables online educational programs leading to degrees and certifications. 

 a) Banking b) e-Shopping 

 c) e-Banking d) e-Learning 

25. Farming and agriculture might seem like ____ technology enterprises. 

 a) Low b) High 

 c) Medium d) Super 

26. We can reserve or book air and train tickets through _______ 

 a) Computer b) Agents 

 c) Internet d) None 

27. To reach out the benefits of IT to the common man need at least ____ technical elements. 

 a) 1 b) 2 

 c) 3 d) 4 

28. ____ enables the online educational programs leading to degrees and certifications. 

 a) e-Education b) e-University 

 c) e-Governing d) e-Commerce 

29. ____ will be the 85% usage of computer. 

 a) Database b) Word Processing 

 c) Spreadsheet d) Power point 

30. _____ permits banking from the comfort of the home by using internet facility. 

 a) e-Banking b) e-Market 

 c) e-Commerce d) e-Shopping 

31. ___ of the following will enable the common man to put computers to better use. 

 a) Employment b) Education 

 c) Entertainment d) Economics 

32. Computers contribute to ______ to update knowledge in fine arts like painting, music, 

dance, yoga, games, science, nature, latest news and events. 

 a) Employment b) Education 

 c) Entertainment d) Economics 

33. _____ banking needed the user to go to the bank to perform related activities. 

 a) Internet b) e 

 c) Traditional d) Network 

34. Which of the following has changed our life style?......... 

 a) browsing b) e-mail 

 c) chat d) all the three 

35. Which of the following enables data storage and management? 

 a) LCD screen b) Picture phone 

 c) Archive unit d) speakers 

36. The purpose of personal archives is--------- 

 a) to store personal treasures b) to store personal details 

 c) to print personal data d) to print others data 

37. In a computerized homes, which of the following rooms have LCD screen, archive unit  

 Personal archieves, emotional containers etc?-------- 

 a) Living room b) Kids room 

 c) Home office d) Bed room 
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38. -----are the small compartments with a screen, speaker, and a scent to derive emotional  

 comfort. 

 a) Archive unit b) Picture phone 

 c) Emotion container d) Book shelf 

39. -------is a picture based personal telephone directory 

 a) Picture phone and pad b) Personal archives 

 c) Emotion container d) Archive unit 

40. -------feature allows to sing along with audio coming from the original source. 

 a) Kara-oke b) Memo frame 

 c) Projection TV d) Interactive table cloth 

41. ----------can function as electronic pets. 

 a) Archive units b) Memo pads 

 c) Ceramic audio d) Robots 

42. Kara-oke, electronic pets, games over net are all part of which of the following rooms 

 in a computerized home--------- 

 a) Living room b) Kids room 

 c) Dining room d) Bed room 

43. Animated stories package, Memo frame, Bookshelf, Personal creativity tool are all  

 Located in which of the following places of a computerized home---------- 

 a) Kids Room b) Bed Room 

 c) Home Office` d) Dining Room 

44. -------means easy interaction with other people through touch screen,scanner and 

 Microphone facilities. 

 a) Memo frame b) Bookshelf 

 c) Archive units d) Kara-oke 

45. In a computerized home,………has touch and voice control for various appliances, 

 Projection TV, Alarm clock, moving Telephone etc. 

 a) kids room b) bed room 

 c) home office d) dining room 

46. In which of the following rooms Mirrors, Medical box and Special Speakers are  

 Located of a computerized home?.......... 

 a) Kitchen b) Bed room 

 c) Bath room d) Kids room 

47. Speakers, Intelligent Aprons, Food Analyzer, Health Monitor are found in--------of 

 A computerized home. 

 a) Kitchen b) Bed room 

 c) Bath room d) Kids room 

48. Interactive table cloth keeps the food------------ 

 a) hot b) cool 

 c) sufficiently warm d) packed 

49. Interactive table cloth and Ceramic audio player are found in---------of a computerized 

 home. 

 a) Kitchen b) Bed room 

 c) Bath room d) Dining room 

50. ----------facilitates remote diagnostics. 

 a) ATM b) e-learning 

 c) Internet d) None of the given 
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11.IT ENABLED SERVICES 

 

I. Choose the Correct Answers :-      

1. IT that helps in improving the quality of services. 

 a) ITES b) IT 

 c) BFSI d) BPO 

2. Which increase the employment opportunities? 

 a) ITES b) IT 

 c) BFSI d) BPO 

3. Expand ITES ? 

 a) Internet technology enabled services b) Information technology enabled services 

 c) Internet information enabled services d) Information terminology enabled services 

4. The facility that allows the user to speak into a special device called 

 a) telephone b) cell phone 

 c) Dictaphone d) all of these 

5. Expand BPO ? 

 a) Business Process outsourcing b) Business Processing outsourcing 

 c) Business Process outsource d) Business Process outsource 

6. E-governance website are in 

 a) Tamil & Hindi b) Tamil & English 

 c) Hindi & English d) Tamil, Hindi & English 

7. A call center work for 

 a) 12 x 365 b) 24 x 365 

 c) 12 x 364 d) 8 x 365 

8. Which is the key for effective and profitable area of IT in an organization ? 

 a) Data Management b) Data entry 

 c) Database management d) all 

9. Which are high growth areas for ITES ? 

 a) Services & BFSI b) IT 

 c) Call centers d) BPO 

10. BFSI stands for 

 a) banking, financial services and intruder b) banking, financial services and insurance 

 c) banking, funding services and intruder d) banking, financial system and intruder 

11. Which are the two important aspect of ITES provider 

 a) data management & services b) data security and customer privacy 

 c) data management and security d) data management & customer privacy 

12. Which refers to the conversion of non-digital material to digital form ? 

 a) data security b) data digitization 

 c) database digitization d) both b & c 

13. Which is critical for the success of ITES ? 

 a) Computer time b) Computer ethics 

 c) Computer virus d) Computer crime 

14. Improved customer satisfaction, better look and feel and an improved database are some  

 a) direct benefits b) indirect benefits 

 c) both  d) none 

15. _____ not a key IT enabled services. 

 a) e-Governance b) Call centers 

 c) Engineering d) Web Based Services 

16. The various websites provided by the government give the details about the departments 

is ______ 

 a) g-governance b) c-Governance 

 c) e-Governance d) b-Governance 

17. _____ is a telephone based shared service center for specific customer activities. 

 a) Shopping center b) Customer  center 

 c) Call center d) both (b) and (c) 

18. Pertaining to collection, digitization and processing of data is called _____ 

 a) database b) base management 

 c) data management d) management 

19. Multimedia includes _____ 

 a) images b) sounds 

 c) video d) all the above 
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20. ____ is the key for effective and profitable use of IT in organizations. 

 a) Database b) Base management 

 c) Data management d) Management 

21. ____ is not a range of ITES. 

 a) Byte code b) Character Recognition & Processing 

 c) Custom reports d) Data entry 

22. Reader Response can be captured and processed from any hard copy or faxed document 

 by--------- 

 a) Handwritten b) Machine print 

 c) Mark sense d) Bar coding 

23. Organization that is not potentially benefit for ITES is----- 

 a) Banking b) Schools 

 c) Government agencies d) Hospital 

24. ------ is a permanent, legal document for a medical investigation 

 a) Medical Transcription b) Tele-medicine 

 c) both d) none 

25. In Medical Transcription the digitized data is converted back to----- 

 a) Video b) Data 

 c) Sound d) Picture 

26. ------refers to the conversion of non-digital material to digital form. 

 a) Data b) Document 

 c) Tele-Medicine d) Digitization 

27. -------are some of the application areas of the digital technology 

 a) Annual reports and price list b) Books 

 c) Database archiving d) All the above 

28. ------ is not a key benefit of digitization 

 a) Short term preservation of the documents 

 b) Storage of important documents at one place 

 c) East to use and access to the information 

 d) Quick and focused search of relevant information in terms of images and text 

29. The benefits of web based services such are---- 

 a) Career guidance b) Employment online 

 c) Results of various Examinations d) All the above 

30. Which of the following is an IT enabled service? 

 a) e-Governance b) Word processor 

 c) Spreadsheet d) Database 

31. Which of the following is not an IT enabled service? 

 a) Call centres b) e-Governance 

 c) Data digitization d) Word Processor 

32. The facility that allows the user to speak into special device called-----and then 

 Convert the speech into a letter. 

 a) Microphone b) Gramaphone 

 c) Dictaphone d) Autophone 

33. Which of the following is sometimes defined as a telephone based shared service? 

 a) Data digitization b) Call centre 

 c) Data management d) Bar code recognition 

34. Collection, digitization and processing of data is basic function of 

 a) Call centre b) Data management 

 c) e-Governance d) Data collection 

35. Which of the following is not an ITES of data management category? 

 a) Data Entry b) Custom reports 

 c) Character Recognition and processing d) Transcription 

36. Which of the following organization can potentially benefit from ITES? 

 a) Banking b) Insurance 

 c) Legal d) All the above 

37. ----- is a permanent, legal document that formally states the result of a medical 

 Investigation. 

 a) Medical Transcription b) Medical Prescription 

 c) Medical Document d) Medical Anatomy 

38. ----refers to conversation of non-digital material to digital form 

 a) Transcription b) Data transfer 

 c) Digitization  d) none of the given 
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39. Long term preservation, storage of important documents, easy to use and access of 

 information are all benefits of 

 a) medical transcription b) call centre 

 c) data digitization d) web based services, 

40. Career guidance, Employment online, Examination results online are all 

 a) Web based services b) Data processing services 

 c) Call centre services d) Transcription services 

41. A facility that allows the user to speak into a special device called------and then convert 

the speech into a letter is an ITES 

 a) Digitization b) Dictaphone 

 c) Call center d) None of these 

42.  --------of the following helps us in accessing web based services. 

 a) Computers b) New papers 

 c) TV d) Radio 

43. ------ is sometimes defined as a telephone based shared service center for specific 

customer activities. 

 a) Digitization b) Dictaphone 

 c) Call center d) None of these 

44. --------of the following is a permanent legal document that formally states the result of a  

 Medical investigation 

 a) Call center b) Data management 

 c) Medical Transcription d) Digitization 

45. ------ is developing all over the globe 

 a) TV b) IT 

 c) Newspaper d) Application 

46. There are ---------steps involved in Medical Transcription 

 a) 1 b) 2 

 c) 3 d) 4 

47. ---------services comprise punching data from manually filled forms, images. 

 a) Data processing b) Digitization 

 c) Call center d) e-Governance 

48. ----facilities communication and supports the insurance claims. 

 a) Callcentres b) Data management 

 c) Medical Transcription d) Digitization 

49. The sound is digitized and send to the ------provider in Medical Transcription 

 a) Internet b) ITES 

 c) Hub d) None of these 

50. --------can improve the quality of the service either directly or indirectly 

 a) Internet b) ITES 

 c) Hub d) None of these 

51. In-------a variety of materials as diverse as maps, manuscripts, moving images and 

 Sound may be digitized 

 a) Call centres b) Data Management 

 c) Medical Transcription d) Digitization 

52. Call centre operates to provide round the clock and year round service i.e-----service 

 a) 12x365 b) 24x365  

 c) 12x366 d) 24x366 

53. Word processors, Spreadsheets and Database have ensured that many----services are 

 IT enabled 

 a) traditional  b) novel 

 c) unique  d) none of these 

54. Data security and Customer Privacy are two important aspects that must be ensured by 

the ----provider. 

 a) Internet service b) ITES 

 c) Telephone d) Consumer service 

55. A-----operates to provide round the clock and year round service i.e 24x365 service 

 a) Call center b) Data management 

 c) Medical Transcription d) Digitization 

56. BPO stands for 

 a) Business Process Outsourcing b) Bank Process Outsourcing 

 c) Business Presentation Outsourcing d) Bank Presentation Outsourcing 
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57. Providing services through government  websites is known as 

 a) E-Governance b) Data Management 

 c) Medical Transcription d) Digitization 

58. The ------benefits the long time preservation of the documents. 

 a) E-Governance b) Data Management 

 c) Medical Transcription d) Digitization 

59. Customer needs are used as the basis for defining the objectives of--- 

 a) E-Governance b) Data Management 

 c) Medical Transcription d) Digitization 

60. ----collected for one purpose may be useful for some other purpose also 

 a) Data b) Messages 

 c) Net d) None of these 
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12.COMPUTER ETHICS 

 

I. Choose the Correct Answers :-      

1. Which has its roots in the work of norkert wierer during World War II ? 

 a) Computer time b) Computer ethics 

 c) Computer Virus d) Computer crime 

2. The period in which donn began to examine un ethical and illegal uses of computer? 

 a) 1990‘s b) 1980‘s 

 c) 1970‘s d) 1960‘s 

3. Data is protected in 

 a) two ways b) three ways 

 c) four ways d) five ways 

4. Which refers to the protection of hardware ? 

 a) data security b) physical security 

 c) personal security d) personnel security 

5. Which refers to software setting and permit only authorized access to the system 

 a) data security b) physical security 

 c) personal security d) personnel security 

6. Which refers to protecting data and computer system against dishonesty or negligence of 

employees? 

 a) data security b) physical security 

 c) personal security d) personnel security 

7. Which is illegal activity using computer software, data or access as the object ? 

 a) computer time b) computer ethics 

 c) computer virus d) computer crime 

8. How many % of computer crime happen within the company? 

 a) 60 b) 70 

 c) 80 d) 90 

9. How many % of computer crime happen outside the company ? 

 a) 60 b) 70 

 c) 80 d) 90 

10. Making and using duplicate hardware and software is called 

 a) ethics b) piracy 

 c) crime d) virus 

11. Which is a sel-replicating program that damages the data ? 

 a) C++ b) functions 

 c) Computer virus d) conditional statement 

12. How many virus programs are in existence 

 a) 57000 b) 6 

 c) 10 d) 5700 

13. How many viruses are found each day ? 

 a) 57000 b) 6 

 c) 10 d) 5700 

14. When other software runs on an idle computer without the knowledge of the organization 

is called as 

 a) theft of computer time b) theft of computer ethics 

 c) computer virus d) computer crime 

15. How many commandments of computer ethics were written ? 

 a) ten b) multiples of ten 

 c) twenty d) thirty 

16. Ten commandments of computer ethics are written by  

 a) computer ethics institute b) norkert wiener 

 c) donn parker d) SRI international 

17. Which require special law to be formed by the government ? 

 a) computer time b) computer ethics 

 c) computer virus d) computer crime 

18. Which country has cyber law to prevent computer crimes ? 

 a) America b) Japan 

 c) India d) Russia 
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19. Illegal access to the network is called 

 a) cracking  b) accessibility 

 c) management  d) security 

20. The key reason for cracking is 

 a) security b) special resources 

 c) data management d) protection 

21. What is the need for password to log into a computer system ? 

 a) data security b) physical security 

 c) personal security d) personnel security 

22. Computer ethics has its roots in the work of Norbert Wienner during _____ 

 a) World War I b) World War II 

 c) both (a) and (b)  d) none 

23. Wiener‘s book not included ______ 

 a) An account of the purpose of a human life  

 b) Five principles of justice 

 c) A powerful method for doing applied ethics  

 d) Discussions of the fundamental questions of computer ethics 

24. Donn Parker began to examine unethical and illegal uses of computers by computer 

professionals in _____ 

 a) mid 70‘s b) mid 75‘s 

 c) mid 60‘s d) none 

25. A number of social and ethical consequences of information technology were becoming 

public issues in America and Europe ______ 

 a) in 70‘s b) in 60‘s 

 c) in 90‘s d) in 80‘s 

26. Threat‘s to computers are _____ 

 a) issues like computer-enabled crime b) disasters caused by computer failures 

 c) invasions of privacy via computer databases  d) all the above 

27. In the _____ year many universities introduced formal course in computer ethics. 

 a) in 70‘s b) in 60‘s 

 c) in 90‘s d) in 80‘s 

28. ____ is the set of rules for determining moral standards. 

 a) Ethics b) basics 

 c) privacy d) information 

29. General guidelines on computer ethics are needed for _____ 

 a) Protection of personal data b) Computer crime 

 c) Cracking d) All the above 

30. ____ security refers to the protection of hardware, facilities, magnetic disks. 

 a) Physical b) Personal 

 c) Personnel d) None 

31. ____ security refers to software setups that permit only authorized access to the system. 

 a) Physical b) Personal 

 c) Personnel d) None 

32. ____ and _____ are common tools for personal security. 

 a) User Ids b) Passwords 

 c) both (a) and (b)  d) none 

33. ____ security refers to protecting data and computer system against dishonesty or 

negligence of employees. 

 a) Physical b) Personal 

 c) Personnel d) none 

34. A computer _____ is any illegal activity using computer software, data or access. 

 a) crime b) software 

 c) data d) security 

35. Which one of the following is not a common crime ? 

 a) Crimes related to money transfer on the internet 

 b) Making long distance calls illegally using computers 

 c) Illegal access to confidential files d) Breaking computer 

36. Which one of the following destroys data ? 

 a) Hardware and software piracy b) Virus 

 c) Cracking d) Theft of computer time 
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37. It is observed that ____ of all computer crimes happen from within the company. 

 a) 60% b) 70% 

 c) 80% d) 90% 

38. Over ____ of all crimes go unreported. 

 a) 60% b) 70% 

 c) 80% d) 90% 

39. Making and using duplicate hardware and software is called _____  

 a) legal b) piracy 

 c) privacy d) freeware 

40. People are tend to pirate because _____ 

 a) We like free things b) Huge payments 

 c) Our thinking and actions are self-serving d) All the above 

41. A ____ is a self-replicating program that can cause damage to data and files. 

 a) worm b) bacteria 

 c) virus d) spam 

42. People can take their work anywhere with them and do it any time by using ___ 

 a) Pc b) Laptop 

 c) Mainframe d) Super Computer 

43. In which year universities introduced formal course in Computer ethics ? 

 a) 1980 b) 1990 

 c) 2000 d) 2005 

44. A ___ crime is any illegal activity using computer software, data or access as the object. 

 a) Virus  b) Computer 

 c) Cyber d) None of these 

45. ___ refers to protecting data and computer system against dishonesty. 

 a) Physical b) Personal 

 c) Personnel d) None of these 

46. ____ percentage of crimes happen within the company. 

 a) 40% b) 60% 

 c) 80% d) None of these 

47. Over ___ of all computer crimes go unreported. 

 a) 40% b) 60% 

 c) 80% d) None of these 

48. ____ is the illegal access to the network or computer system. 

 a) piracy b) cracking 

 c) breaking d) none of these 

49.  ____ computers and telecommuting have created the condition where people can wony 

where. 

 a) Main frame b) Micro 

 c) Portable d) Super 

50. Running other software on an idle computer without the knowledge of the organization is 

called theft of _____ 

 a) Computer time b) Use 

 c) Computer d) Software 
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